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1
Introduction

Pageflex Persona Cross Media Suite provides database-driven variable 
data and cross-media functionality in a desktop application. You can 
use the tools in the suite to produce database-driven business 
documents and marketing collateral—in both print and e-mail—that 
are customized with business data or personalized for the end recipient. 
Database-driven variable data publishing enables you to streamline 
production workflows, communicate one-on-one with your customers, 
and increase response rates. The suite includes Pageflex Studio, 
Packager, Librarian, and output drivers for standard formats, including 
EPS, PDF, PostScript, and HTML.
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Pageflex Persona Cross Media Suite
Welcome to Pageflex Persona Cross Media Suite! This variable data software 
provides easy-to-use tools for producing coordinated database-driven print and 
e-mail campaigns. Your project might personalize a postcard or produce a multi-
page brochure with 100% custom content for each recipient. You can vary text, 
images, pages, and languages (choose among more than 60 languages, including 
Japanese and Chinese). Your documents can have flexible page layouts and 
produce a variable number of pages for each record in your database. You can 
generate customized e-mails using the same tools you use to produce variable 
print documents. In other words, your ability to communicate information in 
print and email is now much more robust.

This guide will introduce you to each of the components of the suite:

 Pageflex Studio. This is the primary tool you use when working on projects. 
Studio is a template design and production tool that combines standard 
graphic design features with powerful variable-data capabilities. Studio 
automates tasks typically performed by a wide variety of professionals in the 
publishing industry.

 Pageflex Packager. A utility that collects and archives Persona projects for 
backup, storage, or relocation. Packager zips all project files, including fonts, 
templates, and images, into one file that is compressed to maximize storage 
space.

 Pageflex Librarian. A simple application for storing, classifying, and 
applying metadata to images, formatted text, and templates.

 Conversion plug-ins and extensions. A template conversion plug-in for 
Adobe InDesign and a conversion extension for QuarkXPress enable you to 
repurpose existing static documents for variable data.

 Output drivers for standard formats. Encapsulated PostScript (EPS), 
Portable Document Format (PDF), PostScript, and HyperText Markup 
Language (HTML) drivers are included in the suite. Additional optimized 
drivers are available as optional add-ons.
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The Variable Data Workflow
The basic variable data workflow is simple, but the powerful features of Persona 
Cross Media Suite enable you to develop complex projects when needed. Most 
projects involve the following steps:

1 Plan. The first step of the process is also the most important. Before you 
begin working with the application, you should plan out your project. What 
type of document you will create (print and/or email), what your data source 
or sources will be, what content you will use, and how the data will trigger 
individual pieces of custom content to be added to the document for each 
data record.

2 Design. Next you design the document layout (called a template) with static 
(non-changing) and placeholders for variable (changing) elements on each 
page. These elements may be text boxes, image boxes, or even entire 
document pages. You can format type, apply colors to objects, designate 
styles for lines and borders, and apply other graphic design elements to the 
pages.

3 Add flex and copyfit. You define how elements on the page will react when 
variable content is added. Page elements may flex, changing size and position 
on the page. And copyfit settings on individual text boxes can cause text to 
resize and paragraph formatting to modify to accommodate longer pieces of 
variable text.

4 Develop variable content. You also prep your data and develop multiple 
versions of text and image content to customize the document. Most of this 
work is done outside of the Persona Cross Media Suite toolset.

5 Add a data source. You then associate a database source with the project.

6 Create variables and rules. Next you create variables (designations of items 
that will change) and variable rules (if/then/else statements or scripts) that 
define how the system will know which content to place in the variable 
locations in the template. Variable content can range from using a name 
stored in a database to the complex selection of stories, variable pages, and 
images based on a set of rules you set up for a project.
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7 Define job output. Next you define how you want the project output by 
defining one or more jobs. For instance, you can have three separate jobs to 
produce a PostScript file, a PDF, and an HTML email all from the same 
project. You also can set up a post process as part of the job (e.g. to trigger 
each document to be stapled after output or to move the output file to a 
specified directory).

8 Generate output. Finally you run the job to generate output. Pageflex Studio 
ingests the data, customizes the content, and outputs a unique document for 
each record in your database. You can also generate output using other tools 
such as Pageflex Server or Pageflex Storefront. In this way, Persona can be 
used as a template or job creation tool for these other technologies.
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How Projects Work 
Variable data projects require additional planning than most traditional graphic 
design projects. In order to effectively plan projects, you should first become 
familiar with several core concepts inherent in Persona Cross Media Suite: the 
power of flex, the difference between profile versus content personalization, and 
how data ingestion works.

Separating Form and Content
A Pageflex Cross Media Suite project is based on the principle of separating the 
form of the document from the content in the document. Content refers to the 
raw information — text, images, graphics. Form refers to the design of the 
document — page layout, fonts, and image sizes. Pageflex Studio allows you to 
use the visual user interface to encode form into a smart template; the 
application captures in XML format the look and feel of the design you create.

A template consists of containers that hold the content, both static and variable. 
The template’s “intelligence” comes from its ability to flex containers, a unique 
Pageflex patented capability. The flex properties of a container allow it to expand, 
contract, and reposition itself and adjacent containers to accommodate the 
variable contents of each different document.

Two Kinds of Customization
Pageflex Studio combines form and content through two kinds of 
personalization: profile personalization and content personalization. You decide 
the level of personalization you want in your documents. Choose from the simple 
inclusion of words in a database to the complex selection of stories, images, and 
variable pages based on a set of rules you set up for a project.

Through profile personalization, you can add specific information for each 
individual, much like using a mail merge function in a word processor. This 
content is retrieved from a profile data source. The profile data source contains 
the information that makes each document unique for each intended reader. For 
example, the profile data source can contain customer information such as name, 
address, and product interests.

Through content personalization, you can use the information in the profile 
data source to establish rules and conditions for selecting additional content 
from the content data source. The content data source can be a collection of 
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files stored in an organized hierarchy in your file system, or it can be an asset 
management database. The recipient’s profile information within that data 
source drives the selection of additional custom content. For example, a 
customer’s profile lists an interest in refrigerators. Through content 
personalization, Pageflex Studio selects content related to refrigerators, but not 
dishwashers.

Understanding Data Ingest
Pageflex Studio adds variable content to each document through a process called 
data ingestion. Through data ingestion, Studio gathers each piece of variable 
content from the profile and content data sources and applies the composition 
rules defined by the project template.

In the example above, Studio uses the profile data source, the content data 
source, and the template to create each final document. The template includes 
placeholders for the variables. 

Studio ingests the variables First, Last, and Sport directly from the profile data 
source. The format for each text variable comes from style information in the 
template. For the image variable, Studio selects the image using a rule that 
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defines the variable. The rule tells Studio which image to use based on the Sport 
variable in the profile data source.

Studio can also ingest document variables that govern placement of multi-page 
templates and PDFs and the use of filler pages.
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How to Read this Guide
To begin learning how to use Persona Cross Media Suite, you should first 
familiarize yourself with the Studio design application and study the samples 
included with your software package.

This guide provides detailed instructions for using each of the components that 
are included with Persona Cross Media Suite. The majority of this guide focuses 
on Pageflex Studio since this is the primary tool you will use. You can use this 
guide as a daily reference as you work with the various components. While you 
can skip over chapters that are not relevant to your particular projects, you may 
want to use those chapters as inspiration for new ideas of how you can apply 
variable data capabilities to your publishing projects.

 Chapters 2 - 4. The basics of template creation and design.

 Chapter 5. An overview of configuring templates to be used with the online 
interactive editing capabilities of Pageflex™ .EDIT™ and the Free Edit 
module in Pageflex Storefront™.

 Chapter 6. An explanation of how to work with text including formatting, 
Asian characters, creating formatted content, and configuring copy fit rules. 
It also describes how you can use area templates to save sections (text boxes, 
images, shapes, and lines) of one template for reuse in other templates or for 
use as variable content.

 Chapter 7. The concept of flex and how to configure page elements to flex.

 Chapters 8 - 10. These chapters are particularly important if you are 
producing long or variable-length documents. They cover master pages, 
dynamic page numbering, automatic pages for text overflow, variable pages, 
filler pages, and Table of Content generation.

 Chapter 11. The basics of project creation and identifying your data source.

 Chapter 12. An explanation of how to work with variables.

 Chapters 13 - 15. These chapters cover generating output for print and 
e-mail, including creating jobs, previewing, managing logs, and dedicated 
features for creating HTML projects.

 Chapter 16. An explanation of how to use the plug-in for Adobe InDesign 
and the QuarkXPress XTension to convert existing static documents to 
variable data templates.

 Chapter 17. The basics of how to use Pageflex Librarian to store and classify 
content.

 Chapter 18. A description of how to use the Packager utility to collect and 
archive Persona projects for backup, storage, or relocation.
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2
Working in the Studio 
Environment

Pageflex Studio is an integrated application for Pageflex project 
development. It includes capabilities for template, variable, and job 
creation.

Studio features a Project panel that displays the variables, jobs, and 
files in the project folder. There also is a document area where template 
and editing tools are displayed. Users can open a project file and edit it 
separately from a template, or open a project file and its associated 
template to preview variable jobs.

This chapter goes over the application interface.
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Templates and Projects
Pageflex Studio enables you to work with the project file and project templates. A 
template is a document form containing the variables, text, images, shapes, and 
styles that determine the outcome of your variable publishing project. It’s called 
a template because it provides the essential instructions for creating each final 
document. You work on the templates in the document area.

You can work on individual documents with Studio, just like you would if you 
were using a static desktop publishing application. However, the power of Studio 
is that it enables you to create a template with all the instructions to create the 
final documents. In other words, you create the document template that is used 
to create document instances.

A project file contains all the resources for your variable job. It references the 
definitions and data sources for your variables (if any), specifies the template you 
are using for output, and contains your output preferences. You can also use 
Studio to create transactional jobs, which use a Web page or another application 
to collect profile data, to be processed by Pageflex Server or Pageflex Storefront.

You create a document template…

…to tell the output driver how to 
create each document instance.
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Getting to Know the Studio Workspace
Pageflex Studio can be used for a variety of project tasks. A user can open a 
project to add a data source, variables, or jobs, or create a new template for 
variable jobs. Studio also can be used to create formatted text and area templates 
for use with variable jobs. 

In Studio you can open a project and a template simultaneously. This dual display 
makes job previewing easier and enables users to better conceptualize variable 
data productions.

Below is a screenshot of the Studio workspace with an open project and template.

When you first open Pageflex Studio, it displays the application menu bar and 
the standard toolbar. Create a new project or template or open an existing 
project or template using the File menu options. View online help topics or 
Pageflex Web pages from the Help menu. In addition to the menu options, you 
also can use the icons in the toolbar to create a new template or project or open 
an existing template or project.

Menu Bar Standard Toolbar

Project
Panel

Structure
Panel

Properties
Panel

Pasteboard

Page Selection Tools

Toolbox
Working in the Studio Environment  21



Pageflex Persona Cross Media Suite User Guide
Project Panel
When you create or open a project, you see the Project 
panel. The Project panel is comprised of the Variables, 
Jobs, and Files tabs. Click a tab to view, add, or edit 
project properties on the selected tab. Drag the right 
hand resizing bar to change the width of the Project 
panel. 

Press the Open/Shut tab  at the bottom-left 
corner of the Project panel to see only the project tabs. 
Click a tab to see the contents of that tab.

Variables 

The icons in the Variables toolbar let you add a data source, add 
a variable, apply the highlighted variable to the selected element in the document 
area, or remove the variable from a selected element in the document area. The 
window below the Variables toolbar lists the variables in the project. Click a 
variable to highlight it, or double-click a variable to edit it.

Jobs 

The icons in the Jobs toolbar allow you to add a job, preview a 
job, preview a job with the current template, or submit a job. The window below 
the Jobs toolbar lists the jobs in the project. Click a job to highlight it, or double-
click a job to edit it.

Files

The icon in the Files toolbar allows you to refresh the file list. 
The window below the Files toolbar lists the files in the project. Click a file to 
highlight it, or double-click a file to edit it.

Note: The main application menus as well as the right-click context menus 
offer these and other capabilities.

Main Document Window
The Main Document window is where you create elements and text boxes and 
preview variable jobs. This window takes up most of the space on the Studio user 
interface. At the bottom of the main document window are the Page Selection 
tools.

Tabs

Toolbar
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Page Selection Tools
The Page Selection tools are a quick and easy way of seeing which page you are 
on and getting to the next page, previous page, or a page from the page list.

Standard Toolbar
The standard toolbar contains icons for basic operations such as opening and 
saving a project, and changing the view percent.

Structure Panel
The structure panel contains two tabs, the Layout tab which displays the layout 
structure of your document, and the Pages tab, which displays the page structure 
of your document.

Layout Tab

The Layout tab allows you to view the structure of a template so that you can see 
what elements are on each page of the template. Selecting an element in the 
Layout tab selects it in the Document window. The Layout tab has two columns, 

First

Previous

Page

Next

Last
Page

Page

List

Page

Page

New

Open

Save

Save

Save

View
Project

New
Template Project

Template

All

Paste

Copy

Cut percent
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Element and Variable, which display a structural tree of the elements in the 
document, and associated variables if applicable.

 To view the Layout tab, choose View >Structure and click the Layout tab in 
the Structure panel.

Element Column

This column lists all the elements in a template. An icon in front of the element 
indicates its type.

The Layout tab displays the parent-child relationship between elements. The 
highest element in the structure is the Page element, and all other elements are 
children to the Page element. If an element is a parent to any other elements, the 
Layout tab displays a plus sign (+) next to that element.

 Click the plus sign (+) to view the child elements.

 Click the minus sign (–) to collapse the view.

For example, in the graphic above, the paragraph “Normal” is a child element to 
the “Text Box” parent element.

Variable Column

This column displays the names of variables assigned to adjacent elements in the 
Element column.

Element column

Child
Parent

Variable column

Element 
Element
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Pages Tab

The Pages tab shows you the Master Page list and the Document Page list.

 To view the Pages tab, choose View >Structure and click the Pages tab in 
the Structure panel.

When you first create your template, you can choose between single-page or 
left/right master pages. If you select single-page masters, pages appear in the 
single-page format, as shown above on the left. If you select left/right master 
pages, pages appear as shown above on the right, with facing pages attached to 
one another.

The Master Page list displays representations of the master pages in your 
document template. The Document Page list displays the individual pages of 
your document template, as well as dynamic pages such as automatic pages, filler 
pages, and variable pages. The master page assigned to document pages is 
specified by the letter associated with the master. 

You can rearrange the page order in the Pages tab by using drag and drop or 
menus. When you use menus to rearrange the page order, you do not need to 
have the Pages tab open.

Master 

Document 

Page List

Page List
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Properties Panel

From the Properties panel, you can edit the 
properties of any selected element or text range in the 
displayed document. The Properties panel displays 
the properties or attributes of the current selection. 
The available properties change according to the type 
of element selected.

If you select more than one element, the Properties 
panel displays the common properties for the selected 
elements.

The properties panel has four tabs:

 Form tab. This tab displays the properties related 
to the appearance and behavior of the selected 
element. 

 Flex tab. This tab displays the specific properties 
for the flexible behavior of an element.

 .EDIT tab. This tab displays the properties used 
with Online Design and Editing Sessions and the 
Free Edit step in Pageflex Storefront.

 Info tab. This tab displays static information about elements. 

The Name property displays the name of a Studio element.

The Kind property displays the kind of object the element is. 

The Autochain property shows whether an element is a chained text box or 
not.

The TOC Override Text can be used to override the text of an entry in the 
Table of Contents, if you want to provide alternative text from that found 
directly in the document text.

Master Element shows whether an element is part of the master page or 
not, and Master Page, displayed when a page is selected, denotes which 
master page the page uses.

 To navigate the Properties panel using the keyboard

 To move sequentially through the list of properties, press the TAB key. 

 Press SHIFT + TAB to move to the previous property. 

 Press ENTER to return to the Document window.
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Toolbox
Click a tool in the toolbox to select it. Some tools have additional options to offer 
more shapes or functions. Click and hold a tool to view additional options. The 
tools are listed and explained below in the order in which they appear on the 
toolbox.

  Selection Tool

With the Selection tool, you can manipulate elements in the Document window. 
When you select an element, eight handles appear at the edges of the element, 
and the Properties panel displays the properties of the element.

 To switch from the Selection tool to the Text tool, double-click a text 
container.

Text Tool

The Text tool has two options.

Use the Text tool to manipulate text inside text containers. Within a text 
container, the tool functions like the cursor in a word processing program.

Use the Text Path tool to add text on paths, such as lines or around shapes or 
area templates.

 To switch from the Text Tool to the Selection Tool, hold down the CTRL key 
and click any container or fixed shape.

Pen Tool

The Pen tool has five options.

Use the Pen tool to draw lines and Bézier curves, the freehand pen tool to draw 
freehand curves, the Add and Remove Point tools to add and remove points to 

Text Text Path

Pen
Freehand Pen

Add Point

Remove Point
Point Conversion
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shapes and lines, and the point conversion tool to convert points to Bézier points. 
See “Creating and Editing Elements” on page 54 for details.

Shape Tool

Fixed shapes do not contain any other elements. Use them as design elements for 
a page. There are three tools for adding various shapes.

  Line Tool

Use the line tool to add straight lines. Drag to create the line. Hold down the 
SHIFT key to constrain the line at 90° increments.

Text Container Tool

Text in Studio appears inside a text container. There are four tools for adding 
various text container shapes. 

 Image Tool

Image containers contain images. Image containers are displayed as rectangles.

Area Template Tool

Use area template containers to hold a collection of elements inside a single 
container. The area template container crops any element that extends past the 
border of the container. There are four tools for adding area template shapes.

rectangle
polygonoval

text Béziertext box
text polygontext oval

area template Bézierarea template box
area template polygonarea template oval
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  Chain Tool

Use the Chain tool to create linked text containers or to link together existing 
text containers.

 Rotation Tool 

Use the Rotation tool to rotate elements. Click any element with the tool. Drag 
one of the four corner handles to rotate the element. Release the mouse button 
when you are finished.

 Hand Tool

The Hand tool allows you to pan the page.

  Zoom Tool

Use the Zoom tool to reduce or enlarge the magnification factor for viewing the 
template from 1% to 1200%. With the Zoom tool, you can enlarge a particular 
area to make more precise edits, or you can reduce the magnification for a 
complete view of a large document.

The Zoom tool has four tool options.

You can switch between  and  by pressing and holding the CTRL key.

Reduces view 
where you 
click 

Changes to fit in 
window view

Enlarges view  
where you click 

Changes to 
100% view
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Toolbox Shortcuts
You can use the keyboard shortcuts to access tools, as shown in the table below.

These shortcuts can appear inactive when the focus is not on the page view and 
when editing text in a text container. When in a text container, press ESC or click 
another tool to exit. To select the page view, click the page.

Using Rulers and Guides
Rulers and guides help position elements with precision. Rulers appear on the 
edges of the Document window. The measurement system you select in the 
Preferences dialog box (on the Edit menu) determines the unit of measure for 
the rulers. 

Guides are properties of each template page. You can add or adjust them 
manually or through the Properties panel.

 To display rulers

 Choose View > Rulers or CTRL-R.

Tool Key

Selection A

Text T (Press ESC to exit text entry)

Pen P

Shape M

Line \

Text Container O

Image I

Area Template X

Chain C

Rotation R

Hand H

Zoom Z
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 To change the ruler origin

The ruler origin is the zero(0) point on both the horizontal and vertical rulers. 
When you move the ruler origin, Studio recalculates all position measurements 
relative to the new origin. Objects in the template do not move. However, the 
values for their position properties may change relative to the new ruler origin. 

 To move the origin, click the upper left corner of the Document window 
where the two rulers intersect. Drag the crosshairs to a new location. 

 To reset the origin, double-click the upper left corner of the Document 
windows where the rulers intersect.   

 To display guides

 Choose View > Guides.

 To position guides manually

 Click anywhere on the rulers, and drag a guide into the Document window. 

 To reposition the guide, use the Selection tool,  and drag the guide to its 
new location.

Note: If you have selected Guides in Back on the View menu, the guides 
may be obscured by elements on the page. To reposition a guide, choose 
Guides in Front, and then reposition the guide. 

 To position guides with the Properties panel

A guide measurement is its location along either the horizontal or vertical rulers. 

1 Select the page. This brings up the page properties in the Properties panel.

2 On the Properties panel, click Add Guide under either Horizontal or 
Vertical Guides.

3 Enter a measurement in the box next to Add Guide.

To change an existing guide, change its Measurement property.
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Note: Changing the ruler origin does not change the location of the guide. 

 To create column guides

Column guides apply to each page individually. You must create the column 
guides for each page.

 Choose Page > Column Guides.

 Enter the number of columns and the gutter size, the space between the 
columns.

-or-

Click an empty area on the page to select the page in the Properties panel. On 
the Properties panel under Columns, enter the number of columns in the 
Number property, and the space between the columns in the Gutter box.
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Setting Preferences
You can change the ruler units, variables highlight color, color matching, and 
zoom scope from the Edit > Preferences menu.

 To change the preferences

1 Choose Edit > Preferences. Pageflex Studio displays the Preferences dialog 
box.

2 Choose options for each of the following boxes.

Box Name Description

Ruler Units Select the units for measuring the size of 
elements and for viewing the rulers in the 
Document window. 

Variables Color Select a non-printing highlight color for 
indicating variables on template and preview 
pages. The color is visible when you select the 
Variables option on the View menu. 

Color Matching Select the Generic CMYK check box to change 
the color matching preference. When checked, 
Studio displays CMYK colors using a generic 
color profile for the screen. The result is color 
previews that more closely match the CMYK 
printed output.
Working in the Studio Environment  33



Pageflex Persona Cross Media Suite User Guide
3 Click OK to set the Preferences.

Customizing Shortcuts
Studio comes preconfigured with a number of shortcut keys:

 CTRL 0 — View Fit page

 CTRL 1 — View 100%

 CTRL - (minus) — Reduce view

 CTRL + (plus) — Magnify view

You can view the assigned shortcut keys or add your own from the 
Edit > Shortcut Keys menu.

 To view or add shortcut keys to menu options:

1 Click Edit > Shortcut Keys.

2 Choose a menu item from the macro list.

3 Click Create Shortcut.

4 Press a combination of keys for the new shortcut. Your key combination 
appears in the text box.

Zoom Scope When you change the View percent (the Zoom 
factor), this option determines how many 
pages it affects. 
 Page. This option uses the View percent you 
select only on the current page. The other 
pages are not affected.
 Document. This option changes the View 
percent for all the pages in the document when 
you change it for one page. 

Smart Quotes Check the Smart Quotes box and choose the 
style of quotation marks to use if you want to 
use curved quotation marks in your 
documents. Otherwise, your quotation marks 
will be straight.

Box Name Description
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5 Click OK

 To remove a shortcut

1 Select the menu item from the macro list.

2 Highlight the shortcut in the Assigned Shortcuts list.

3 Click Remove.

Click Reset All to reset all shortcuts to the default settings.

Click OK when you have completed adding your shortcuts, or Cancel to cancel 
your changes.

Setting View Options
On the View menu, you can choose to hide or display the non-printing guides 
and invisible characters you use to help create the project template. You can 
change the View options at any time. 

 Zoom. Choose a Zoom option to change the magnification factor of the 
Document window. 

 Toolbars. Choose from the following options:

 Standard Toolbar. Displays the Standard toolbar.

 Record Selection. Displays the Record Selection toolbar. This option is 
only available while previewing a job.

 Project. Displays the Project panel. Click the Variables, Jobs, or Files tab to 
display the project items for that tab.

 Toolbox. Displays the Toolbox.

 Structure. Displays the Structure panel.

 Properties. Displays the Properties panel.

 Rulers. Displays the rulers along the sides of the Document window.

 Guides. Displays the non-printing column guides, floating guides, and page 
margins.

 Snap to Guides. If this option is selected, any item you drag near any of the 
guides automatically aligns to the guide. If you drag a guide, it snaps to 
nearby objects.

 Guides in Front. Displays the guides in front of all elements.

 Guides in Back. Displays the guides behind all elements. Elements on a 
page may obscure the guides.
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 Hidden Characters. Displays the non-printing formatting characters such as 
the End-of-Paragraph symbol (¶).

 Variable Highlights. Displays variables with a highlight color. You can 
choose the highlight color in the Preferences dialog box.

 Invisible Borders. Displays a visible, but non-printing, border around any 
containers that have the Border Color property set to None.

 Hide Overlays. Hides guides and the formatting characters listed above. 
This is useful for displaying a proof of all printed elements in your document. 
When this is checked, the views for the other formatting characters become 
disabled. When unchecked, they revert to their previous settings.
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Creating Templates

The template forms the basis of a Pageflex variable publishing project. 
This chapter explains how to work with template files, how to set them 
up, and how to modify page properties.
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Working with Template Files
For every template you create, Pageflex Studio creates two files:

 The template file, or XML Document Template (.xdt) file.

 The style sheet, or Template Style Language (.tsl) file.

The template stores the template content, variables, and structure. The style 
sheet stores the instructions for formatting the contents of the template. Every 
template must have a matching style sheet.

Templates cannot share a style sheet. However, you can import an existing style 
sheet when you create a new template. When you import a style sheet, Studio 
makes a copy of the original file and names it to match the new template file.

Note: It is important to keep these two files stored in the same directory with 
the same name so Studio can associate them with one another.

Viewing Template Info
Select Template Info from the File menu to view information about your 
template. The Template Info dialog box displays the following information:

 Fonts. The names of fonts used in the template.

 Styles. The names of styles used in the template.

 Colors. The names of the colors used in the template and whether the 
template is formatted as RGB or CMYK.

 Images. The file names of static images used in the template.

 Variables. The names of variables used in the template.

 .EDIT Names. The names of any elements, as entered on the Info tab on the 
Properties panel.

Click the Copy icon to copy this information onto your clipboard. Click the Save 
icon to save this information into a text file. Click Close to exit.
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Building New Templates
When you create a new template, you set up the page dimensions and margins 
for all the pages of the template. Follow the steps below to create a template.

 To create a new template

1 Choose File  New Template

-or-

click the new template icon  in the standard toolbar

-or-

hold down the CTRL key and press N.

Studio displays a dialog box for setting up a new template.

2 On the General tab in the Pages section, select a page size or enter the page 
dimensions.

 For a standard page size: In the Pages list, select a standard size. Studio 
enters the page dimensions in the Width and Height boxes.

 For a custom page size: Enter the page dimensions in the Width and 
Height boxes. Studio automatically selects Custom in the Pages box.
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3 For Orientation, select Portrait or Landscape. Studio switches the values 
for Width and Height based on your selection.

4 Click the Masters Left/Right selection box if you want to use separate 
master pages for the left and right pages of your template. Otherwise, leave 
this box unchecked to use single page master pages. 

Note: Once you choose left/right or single master pages, you cannot switch 
your template between these formats. See Chapter 8: Working with Master 
Pages for more information.

5 In the Margins section, enter the four page margins. All pages in a template 
have the same initial page margins. You can also change the margins for 
individual pages in the Form menu of the Properties panel.

6 In the Overprint section, select the default values for each black element you 
want to overprint. For color overprinting, make changes when editing the 
template. See “Overprint Border/Fill/Black Line” on page 100 or “Character 
Properties” on page 124 for details.

7 Click the Advanced tab.

8 In the Default Language box, choose a default language to use for the 
spelling and hyphenation dictionaries. Choose the language you plan to use 
predominantly. You can set individual words or paragraphs to different 
languages later using Character and Paragraph properties.
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9 The Substitute Font box lists the font Studio uses for display if the original 
font is not installed and you have not specified a substitution. See “Missing 
Fonts” on page 43.

10 The Vertical Placement of Text Lines section lets you adjust how Studio 
handles composition features such as leading. Improvements to Pageflex 
composition applications have changed some of the ways the applications 
compose text. If you are working with a template created in a older version of 
a Pageflex product, you have the option to preserve the composition rules 
from the older applications.

 Apply latest composition rules. Choose this option to use the current 
composition rules. This option is recommended for all new templates. If 
you are modifying an older template or a Persona 1.x template, this 
option may cause text to reflow differently than before. 

 Use baselines for fixed leading. Select this check box to change how 
Studio calculates leading. If you are importing templates created through 
such tools as the Pageflex DesignOut plug-in for Adobe InDesign, you 
may want to select this option so that the leading matches the source 
document more closely.

Studio usually measures leading from ascender to ascender. Increasing 
leading adds space below each line. With this check box selected, Studio 
measures leading from baseline to baseline. Increasing leading adds 
space above each line; however, you cannot add space before the first line 
of a text container. 

 Apply Mpower 2.x/Persona 1.x composition rules. Choose this 
option if you are opening a template created in an older version of a 
Pageflex composition application, and you do not want the text to reflow 
using the latest composition rules.

11 Leave the Import Styles box empty unless you want to import an existing 
style sheet. Enter the path name or click the button next to the box to browse 
for the file. Importing the style sheet creates a copy of the file in the directory 
where you saved the template. Each template must have its own copy of the 
style sheet.

Ascenders Baselines
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Note: This is your only opportunity to import an existing style sheet. You 
can not import a style sheet after the template has been created.

12 Click OK to create the template.
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Opening Existing Templates
You can open an existing template at any time, and you can open more than one 
template simultaneously.

 To open a template

There are several ways to open a template:

 On the File menu, select Open, then choose a template file from the file 
menu.

 Click the file icon  in the standard toolbar and choose a template file.

 If the template was one of the last six templates you opened, you can select it 
from the Recent Templates submenu on the File menu.

 Hold down the CTRL key and press O.

Missing Fonts
If you open a template, and the fonts for the template are not available, Studio 
can replace the fonts with a temporary or permanent replacement. 

 Temporary. Studio uses a temporary substitute font for display purposes 
only. The Font property continues to list the original font name in brackets to 
let you know the real name of the font. You can set the Substitute Font on 
the Advanced tab of the Template Setup dialog box, which is accessible 
from the File menu.

 Permanent. Permanent replacements completely replace the original font 
throughout the template. Studio does not keep track of the original font 
used.
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 To open a template with missing fonts

1 If you open a template that uses unavailable fonts, Studio displays the 
Missing Fonts dialog box. 

2 For each missing font, you can choose a temporary or permanent 
replacement. 

 For a temporary replacement, choose [Temporary default].

 For a permanent replacement, choose a new font from the list.

Note: A replacement affects all occurrences of the font throughout the 
template, but it does not affect font occurrences used in formatted content 
variables.

Missing Images
If you open a template that uses images Studio cannot find, you see a warning 
message.  You can continue to open the template with missing image 
placeholders and work with other elements, or you can navigate to the image file 
and relocate it.
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 To open a template with missing images

1 If you open a template that uses unavailable images, you see the Missing 
Image Files dialog box:

2 Select an image name and click Locate to find and load the corresponding 
image or OK to display the template with a placeholder only.
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Saving Templates
Pageflex Studio automatically saves both the template and the style sheet 
associated with it each time you save your work.

 To save a template

There are several ways to save a template or templates:

 Choose File  Save Template.

 Choose File  Save Template As...

 Choose File  Close Template and select Yes to save the template.

 Choose File  Save As to save the existing template with a new name.

 Click the save icon  in the standard toolbar.

 Click the save all  icon in the standard toolbar to save all the open 
templates and your project file.

 Hold down the CTRL key and press S.

Reverting to a Saved Template
Reverting the template discards all the changes you have made to a template 
since the last time you used the Save command.

 To revert to a saved template

 Choose File  Revert to Saved.
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Changing Template Setup
When you create a new template, you set the initial size and margins for the 
template. You can change these settings at any time. Changing the template 
setup changes all pages in the template. Changes made to the page margins on 
individual pages are reset to the new dimensions.

Change template setup with the template setup window.

Note: You cannot import a style sheet into an existing template or change the 
master page format of an existing template. These options are only available 
when you create a new template.

 To change template setup

 Choose File  Template Setup. Studio displays the Template Setup dialog 
box.

 See “Building New Templates” on page 39 for steps describing the template 
options you can change.
Creating Templates  47



Pageflex Persona Cross Media Suite User Guide
Arranging Pages
You can arrange the pages in your document using the menus or the Pages 
window on the Structure panel. You can insert, delete, move, or duplicate pages. 
These options are available from the Pages menu or by right-clicking on a page in 
the Pages window on the Structure panel.

Inserting or Deleting Pages
You can insert or delete pages at any time.

 To insert pages

1 Choose Page  Insert Pages... Pageflex Studio displays the Insert Pages 
dialog box.

2 Enter the number of pages to insert, and then choose a location to insert 
them. You can insert pages before or after the current page, or you can insert 
them as the first or last pages of the template.

3 Choose a master page format to use for the inserted page. See Chapter 8: 
Working with Master Pages for more information.

 To delete pages

Deleting pages is permanent and cannot be undone. Deleting a page also deletes 
any elements on that page.
 48 Creating Templates



Chapter 3
1 Choose Page  Delete Pages... Studio displays the Delete Pages dialog 
box.

2 Enter the range of pages to remove. To remove a single page, enter the same 
page number in both boxes. Click OK.

3 Before removing the pages, Studio displays a message to confirm that the 
pages are to be deleted. Click Yes to permanently delete the pages and all 
their contents. 

Moving Pages
You can move pages using the Move Pages dialog box or by rearranging the 
pages in the Pages window on the Structure panel.

 To move pages using the Move Pages dialog box

1 Choose Page  Move Pages... Studio displays the Move Pages dialog box.

2 Select the range of pages to move. If moving a single page, enter the same 
page number in both boxes.

3 Select the location to move the pages. Click OK. Pages are moved 
immediately.
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 To move pages using the Pages window

You can move only one page at a time using the Pages window on the Structure 
panel.

1 Click the page you would like to move so that it is highlighted.

2 With the left mouse button clicked, drag the mouse to where you want to 
move the page. A black bar appears, denoting where the page can be placed.

3 Release the mouse button to drop the page in place.

Duplicating Pages
Duplicate pages using the Duplicate Page menu option. Studio inserts your 
duplicate page after the original in your document.

 To duplicate pages

 Choose Page  Duplicate Page from the page you want to duplicate.

- or -

 Right-click on the page you want to duplication in the Pages window of the 
Structure panel and choose Duplicate Page.

black bar
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Understanding Page Properties
Each page of a template can have its own properties to control page margins,  
guides, and borders. To see the page properties, click in an empty area on the 
page. The Properties panel displays the page properties when no other elements 
are selected. 

Margins
 Left, Right, Top, Bottom. These properties control the position of the 

guides used for the page margins. The template setup determines the initial 
values for the page margins, but you can change them independently for any 
page.

Border
A page can have its own border. Set the page borders separately for each page in a 
template.

 Border Color. This property applies color to the page border.

 Border Tint. This property sets the tint for the color of the page border.

 Border Thickness. This property sets the thickness of the page border. 
Borders are always measured in points. 

 Border Style. More options for the border are available through the border 
style. See “Borders and Lines” on page 69 for a description of border style 
options.

Columns
Each page can have its own set of column guides. You can set the column guides 
using the Column properties in the Properties panel, or you can use the Column 
Guides command. See “Using Rulers and Guides” on page 30.

 Number and Gutter Size. Sets the number of equal columns on a page, and 
the amount of space between the columns
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Horizontal and Vertical Guides
Guides help you position items on the page. 

 To add guides

 Click (add guide) in the Horizontal or Vertical Guides properties section and 
enter the number of inches from the top left corner that you want the guides 
to appear.

- or -

 Click in the horizontal or vertical ruler in the Document window and drag a 
guide into the Document window.

 To remove guides

 Drag guides to the edges of the Document window.
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4
Working with Elements

This chapter explains how to create and edit elements. Learn how to:

 Create text and image containers, shapes, area templates, borders, lines, 
and curves

 Create text on a path

 Change element properties

 Define colors

 Layer, align, and lock elements

 Rotate, resize, and group elements

 Create text runarounds
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Creating and Editing Elements
Elements are the building blocks of a template. For example, text containers, 
image containers, area templates, and shapes are all elements. Paragraphs and 
characters are also considered elements. Each element has properties to specify 
characteristics such as size, position, borders, and other attributes. Use the tools 
on the toolbox to create elements. Edit element properties by modifying the field 
values on the Properties panel. This section describes how to create the following 
elements:

 Shapes

 Text containers and paths

 Image containers

 Area Template containers

 Borders and Lines

 Curves

See Chapter 6, “Working with Text,” on page 123 for a details about paragraph 
and character elements.

Text Containers
Text can appear inside containers, on text paths, or around shapes. Text 
containers can be rectangles, ovals, regular polygons, or freeform polygons. You 
can create text containers using the text container tools, or by selecting a shape 
with the text tool. Once you change a shape into a text container, it is listed as a 
text container in the Layout panel, regardless of its original shape.

Text containers and paths can contain static text, variable text, or a combination 
of both. If the text does not fit inside the container or along the path, Studio 
indicates the text is overflowing the container by displaying a red box in the 
bottom handle of the text container, or at the end of a path.

The red box indicates the text 
overflows the container
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 To create a text box using the Text Tool

1 Click the Text Tool  in the Toolbox.

2 Drag to create the text box.

 To create a text container using the Text Container or the Text Oval tool

 Click the Text Container Tool  or the Text Oval Tool  in the Toolbox 
and drag to create the container.

 To create a text container using the Text Polygon tool

The polygon tool creates a container with a specified number of equal sides.

1 Click the Text Polygon tool  in the Toolbox and drag to create a six-sided 
polygon.

-or-

Click once to open the Polygon dialog box.

2 In the Polygon dialog, enter the Radius in inches and the number of Sides. 
The radius is the distance from the center of the polygon to the endpoints of 
each side. The radius must be at least .25 inches.

3 Click OK to confirm your changes and create the text polygon. Click Cancel 
to exit.

 To create a text container using the Text Container Bézier tool

1 Click the Container Bézier tool  in the Toolbox.

2 Click to set the first endpoint.

3 Click to set the next endpoint. Click to create angled corner points, or drag to 
move the control point and create a curve.
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4 Set additional points, as desired.

5 Position the pointer over the first point and click to close the container.

 To insert text within an existing container

This procedure inserts static text, not variable content. You can insert plain text, 
formatted text, or formatted paragraphs. See “Formatted Content” on page 155 
for more information.

1 Click the Text tool  in the Toolbox.

2 Position the cursor inside a text container where you want to insert the text.

3 On the File menu, click Insert Content. 

4 Studio displays the Open Content File dialog box. In the Files of Type box, 
choose the format of the text file you want to insert:

 Text files (.txt);

 Formatted Text (.xft);

 Formatted Paragraphs (.xfp).

5 Select a file.

6 Click OK to insert the text.

Text Paths
Text paths can be set along lines, curves, or around the borders of shapes. Text 
paths cannot be set around the borders of text containers. See below for details 
on how to create text paths. See “Creating and Modifying Angles and Curves” on 
page 72 for details on how to reshape text paths.

 To create a text path

1 Click the Text Path Tool  in the Toolbox.

2 Drag to create a line.
 56 Working with Elements



Chapter 4
 To create a text path on an existing line, curve, or around a shape

1 Click the Text Path Tool  in the Toolbox.

2 Move the cursor over an existing line or the border of a shape. The cursor 
changes to show a down arrow. 

3 Click to create a text path.

Note: You cannot create a text path on the border of a text container.

4 You will see a blinking cursor, indicating that you can start typing text on the 
path.

Adding Columns
You can add columns to text boxes. You can also balance the text in the columns 
to make all columns the same height. See the steps below for details.

 To add columns to a text box

1 Click the Selection tool  in the Toolbox.

2 Select a text box.

3 In the Properties panel, under Columns, enter the Number of columns.

4 Enter a value in the Gutter Size property to add a specified space between 
the columns.

GutterTwo-column text box
Working with Elements  57



Pageflex Persona Cross Media Suite User Guide
Note: If a text container has more than one column, you cannot set the 
Flex Width property to minimize. 

 To balance the text columns

1 Click the Selection Tool  in the Toolbox.

2 Select a multi-column text container.

3 In the Properties panel, under Flex Height on the Flex tab, choose the  
Column Balance Behavior.

Studio balances the text into columns of equal length. The text box 
maintains the same width, and the height adjusts to fit the text.

 To force a column break

Column breaks force text to flow into the next column or chained container.

 On the Text menu, click Insert and click Column Break.

-or-

 CTRL + SHIFT + ENTER

Chaining Text Containers and Paths
You can link text containers together using the Chain tool . You can chain 
together any type of text containers even if the containers are different shapes. 
You can also chain text paths to text containers. Studio shows that text 
containers are linked by using a down arrow for the output point in the bottom 
handle of the first container, and an up arrow for the input point in the top 
handle of the next container. 

Column balancing off Column balancing 
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 To identify and select the text containers in a chain

 Hold down the CTRL key, and click the arrow at the top or bottom of a 
chained text container to select the next or previous container in the chain.

 To link text containers or paths using the Chain tool

1 Click the Chain tool  in the Toolbox.

2 Click the first text container or path.

3 When the pointer displays a number 2, click the second text container or 
path.

Note: Text containers and paths must be empty when added to a chain.

 To create text boxes using the Chain tool

1 Click the Chain tool  in the Toolbox and drag to create the first text box.

2 When you finish drawing the first text box, the pointer number changes from 
a ‘1’ to a ‘2’. Drag to create the second text box.

3 To continue chaining text boxes, click the Chain tool  again, and click the 
last container you created.

4 When the pointer changes to a number 2, drag to create the third text 
container. Repeat these last two steps to include additional text containers in 
the chain.

 To unchain text containers

1 Click the Selection tool  in the Toolbox.

2 Click at least one text container or path in the chain to select it.

The arrows indicate 
each text box is part 
of a chain
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3 On the Element menu, click Unchain. Studio removes the link between the 
text containers. The text reflows using only the first text container.

Shapes
Shapes are graphical elements that can appear anywhere in a template. Shapes 
can have color fills and borders, but they cannot contain other content. Shapes 
can be separate elements, or they can be pasted inline within a block of text. 
Shapes can also be converted into text containers.

 To create rectangles, ovals, and hexagons

1 Click the Rectangle tool , Oval tool , or Polygon tool  in the 
Toolbox and drag to create the shape (the Polygon Tool creates a six-sided 
polygon).

2 Use the Properties panel to edit the container properties.

Note: To create a square or a circle, enter the same dimension for Width 
and Height in the Properties panel.

 To create a regular polygon

1 Click the Polygon tool  in the Toolbox.

2 Click once to open the Polygon dialog box.

Enter the radius and the number of sides. The radius is the distance from the 
center of the polygon to the endpoints of each side. Click OK to create the 
polygon.
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 To create a freeform polygon or Bézier shape

1 Click the Pen Tool  in the Toolbox.

2 Click to set the first endpoint.

3 Click to set the next endpoint. Click to create angled corner points, or drag to 
move the control point and create a curve.

4 Set additional points, as desired.

5 Position the pointer over the first point and click to close the polygon.

 To create a freehand Bézier shape

1 Click the Freehand Pen Tool  in the Toolbox.

2 Drag to create a line or curve. Studio intermittently creates end points within 
the line.

3 Position the cursor close to the beginning point to close off the shape.

 To insert an inline shape

An inline shape appears within a paragraph inside a text container. The inline 
shape behaves as part of the paragraph. If you edit the text in the paragraph, the 
shape moves within the text to accommodate the changes.

1 Using one of the shape tools, create a shape.

2 Select the shape, and on the Edit menu, click Cut.

3 With the Text tool , position the text cursor in the paragraph where you 
want the shape to appear.

4 On the Edit menu, click Paste.

Studio inserts the image into the paragraph. Because the image is now part of 
the paragraph, its position in the paragraph is controlled by the paragraph 
and character properties, not the Left and Top properties for the image 
container. If you move the text container, the inline image moves with it.
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To adjust the position of the image within the paragraph, select the image 
container with the Text tool , and adjust the character or paragraph 
properties.

To adjust image container properties, select the image using the Selection 
tool . In the Properties panel, edit the values.

Image Containers
Pageflex Studio supports the following image formats:

 EPS (Encapsulated PostScript). This format uses the file extension .eps. To 
preview an EPS image in Studio, you must save it with a TIFF preview for a 
Windows-based computer. EPS images without previews appear as gray 
boxes on screen; however, EPS images with and without previews print the 
same. 

 TIFF (Tag Image File Format). This format uses the file extension .tif. You 
can save TIFF images with LZW (Lempel-Ziv-Welch) compression if your 
output device supports it.

 JPEG (Joint Photographic Experts Group). This format uses the file 
extension .jpg.

 GIF (Graphics Interchange Format). This format uses the extension .gif.

 PDF (Portable Document Format). This format uses the extension .pdf. You 
can import PDF documents created with Adobe® Acrobat®. For multi-page 
documents, you pick which page you would like to import.

Images can be static or variable. Text can run around the outside of the image 
container or, if it includes a clipping path, around the edges of the clipping path. 
You can specify clipping paths in your images using some high-end applications 
such as Adobe Photoshop.

You can insert images as inline graphics into a paragraph. Inline images behave as 
part of the paragraph. If you edit the text in the paragraph, the inline shape 
moves within the text as you make changes.

 To use the Image tool

1 Click the Image Tool  in the Toolbox and drag to create an image 
container.

2 Select an image source for the container.

The image source can be static or variable.
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 To select a static source for the image, in the Properties panel under 
Source, choose New. Studio displays the Insert Image File dialog box.

Select an image, and click Open. Studio inserts the image.

 To select a variable source, drag a variable from the Variables panel into 
the image container. For more information on using variables, see 
“Adding or Editing Variables” on page 261.

 To insert an inline image

1 Using the Text tool , position the text pointer where you want to insert 
the image within the text container. 

2 Choose File  Insert Content.  

0

3 In the Files of type box, select the Image files option. Only image files for 
supported formats appear in the list. 

4 Select the image file to insert.

5 Click Open.

Studio inserts the image into the paragraph. To adjust image container 
properties, select the image using the Selection tool  and edit the values 
in the Properties panel. See “Understanding Element Properties” on page 90 
for more information.
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 To crop an image

Image containers always display an entire image. You can use an area template 
container to crop an image.

1 Select the image you want to crop, using the Selection tool .

2 Choose Element  Group in Area template. Studio groups the image in an 
area template box.

3 Drag the image within the area template to position it. Select the area 
template to change the size or shape of it to crop the image inside it.

Importing Images from the Mac OS
The Mac OS operating system software does not require a file extension to 
identify the file type. Since the Windows platform requires a file extension, you 
must add the appropriate three-letter file extension to each image file you plan to 
use with Pageflex Studio.

EPS images created on the Mac OS operating system by default have a PICT 
preview instead of a TIFF preview, although an EPS image with a TIFF preview 
displays and prints properly on the Mac OS operating system. The Windows 
operating system does not support the PICT format. These images preview as 
gray boxes in Studio. 

To preview EPS images created in an image editing application on the Mac OS 
operating system, you must do one of the following:

 Open your image editing application on the Mac OS operating system, and 
save each image choosing the TIFF preview option when you choose the EPS 
format. This option may be called “Windows” or “PC” format in some 
applications. For best results, choose 8-bit TIFF preview if possible.

 Open your image editing application on the Windows operating system, and 
save each image. For best results, choose the 8-bit TIFF preview.

PDF documents, TIFF images, and JPEG images created on the Mac OS operating 
system display and print properly in Studio.
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Scaling Images
Pageflex Studio can scale both static and variable images. The value under the 
Image Fit property for the image container and the size of the image container 
determine how the image is scaled. The Image Fit property has the following 
choices:

 Fit Image. The image container adjusts to fit the image at the Horizontal 
and Vertical Scale percentages specified in the Properties panel.

Note: If you intend on using this template in Online Design and Editing 
Sessions or the Free Edit step in Pageflex Storefront, be aware that if you 
replace the image using these technologies, they will place the new image at 
a 100% Horizontal and Vertical scale percentage.

 Fit Width. Studio scales the image to the width of the container. The height 
of the container adjusts accordingly. The image maintains its original 
proportion.

Image Container Image scales to 100%

Horizontal and 
Vertical Scale set 
to 100%

Image Container Image scales to container width
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 Fit Height. Studio scales the image to the height of the image container. The 
width of the container adjusts accordingly. The image maintains its original 
proportion.

 Stretch to Fit. Studio scales the image to fit the container. The width and 
height of the container remain constant. The image may appear distorted.

 Scale to Fit. Studio scales the image to be as large as possible while staying 
within the specified maximum width and height. The image maintains its 
original image proportion.

 Scale to Fit (Page Relative). Studio scales the image to be as large as 
possible while staying within the maximum width and height, specified as a 
percentage of page size.

For example, in creating a print ad for a number of publications, you may 
need to resize certain ads depending on the specifications of each 
publication. You can use flex properties to change the properties of shapes 
and text, but if you need to change the size of images, you would use the 
Scale to Fit (Page Relative) property.

Image Container Image scales to container height

Image Container Image scales to match container size

Image Container Image scales to fix maximum 
container width or height
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Inserting PDF Pages
With Studio, you can insert specific pages or multi-page PDFs as images into 
your variable-length documents.

 To insert a PDF as an image

1 Create an image using the image tool.

2 On the Form tab of the Properties panel, under Image, choose the Source of 
the image by choosing New in the list box.

3 In the Insert Image File dialog box, choose the PDF file you would like to 
import and click Open.

4 If the PDF file has more than one page, Studio displays the Insert PDF dialog 
box.

Select a page number from the drop-down list and click OK. Studio imports 
the page you specified into the image container.

 To change the source page

1 Select the image container for the PDF containing the page you would like to 
show.

2 On the Form tab of the Properties panel, under Image, click the Source Page 
box.

3 Click the Page Selection button  to display the Insert PDF dialog box.

4 Select a page number from the drop-down list and click OK. Studio imports 
the page you specified into the image container.
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Area Template Containers
Area Template containers can hold any other type of element. An area template 
groups elements together and maintains their relative positions to each other. 
You can use area templates to create sections of content on a template page. You 
can also use an area template container to crop images, since the area template 
container can crop any part of its contents that extends past the boundaries of 
the container.

 To create an area template box or oval

 Click the Area Template Box  or Area Template Oval Tool  in the 
Toolbox and drag to create a container.

 Draw the area template container on top of any other elements to select 
those elements and include them inside the area template container. Studio 
displays a dialog to confirm that you want to include these elements.

 Select an element or group of elements and on the Element menu, click 
Group in Area template. Studio groups the elements in an area template 
box.

 To add a new element to the area container

 To add a new element, draw the element inside the borders of the area 
template container.

 To add an existing element to the area container

1 Select the element and on the Edit menu, click Cut.

2 Select the area container, and on the Edit menu, click Paste. Studio pastes 
the element inside the area container. 

 To create an area template polygon

 Click the Area Template Polygon Tool  in the Toolbox and drag to create a 
six-sided area template polygon.

-or-
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 To specify the size and number of sides, using the Area Template Polygon 
Tool, click once to open the Polygon dialog box.

Enter the radius and the number of sides. The radius is the distance from the 
center of the polygon to the endpoints of each side. Click OK to create the 
polygon.

 To create an area template Bézier shape

1 Click the Area Template Bézier Tool  on the Toolbox.

2 Click to set the first endpoint.

3 Click to set the next endpoint. Click to create angled corner points, or drag to 
move the control point and create a curve.

4 Set additional points, as desired.

5 Position the pointer over the first point and click to close the container.

Borders and Lines
Pageflex Studio has many options for creating unique borders and lines. All text 
containers, image containers, area templates, and shapes can have a border. 
Vertical and horizontal group containers can also have borders. The border style 
can also apply to lines.

Lines can appear anywhere in a template as graphical elements. Lines can have 
color, but they cannot contain other content. To add lines above or below a 
paragraph, see “Paragraph Rules” on page 142.
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 To create a line

 Click the Line tool  in the Toolbox and drag to draw a line.

 To draw straight lines at 90° increments, hold down the SHIFT key while you 
draw the line.

 To create freehand lines

1 Click the Freehand Pen Tool  in the Toolbox.

2 Click to set the first endpoint and drag to create a line or curve. Studio 
intermittently creates end points within the line.

 To define a border or line style

1 Click the Selection tool  on the Toolbox.

2 Select a container or shape.

3 On the Element menu, click Border Style. Studio opens the Border Style 
dialog box.

4 Click Show Border to make the border visible.
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5 Choose options for defining the appearance of the border. The Preview area 
shows a sample of the border using the options you select.

Note:  The on-screen preview may not match the printed border, especially 
for dashed and dotted borders. 

Box Name Description

Style Choose Solid, Dashed, or Dotted. 

Color Choose a color from the list, or click New to define a 
new color.

Tint Choose or type a percentage to create a tint of the 
selected color. 

Weight Enter the thickness of the border in points.

Corner Radius Note:  Text boxes, area template boxes and 
rectangles only. 
To create rounded or concave corners, enter a value 
for the radius. Positive numbers create rounded 
corners, and negative numbers create concave 
corners.

Note: If you set the corner radius on a text box, also 
adjust the Margins property to prevent the text from 
appearing outside the box at the corners.

Placement Choose Inside to have the border form on the inside 
edge of the container.
Choose Centered to have the border form centered 
on the edge of the container. 

The effect of this setting is most noticeable with 
thick borders.

Positive numbers Negative numbers

Inside Centered
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6 If you select Dashed or Dotted for the Style, the options under Dash/Dot 
Style become available.

7 Click OK to apply the border style to the container.

Creating and Modifying Angles and Curves
You can create Bézier curves in Studio for use in text containers, area template 
containers, shapes, or as lines and text paths. A Bézier curve is a curve defined by 
two end points, which each have two control points that create a line controlling 
the direction of the curve.

Box Name Description

Dash Size Note: For Dashed borders only. 
Enter the width of each dash in points.

Gap Enter the amount of space in points between the 
dashes or dots. 

Align To Choose how the dashes or dots align along each side 
of the border.
 Corner. The dashes or dots on each side of the 

container meet in the corners. 

 None. The dashes or dots form with no particular 
alignment.

 Page. The dashes and dots align to a universal 
page grid. The dashes and dots on all borders on 
the page align to each other. 

Dash Size

Gap

End points

Control points
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You can convert rectangles, text containers, area templates, and ovals into Bézier 
shapes using the Point Conversion Tool. You can convert angles on text 
containers, shapes, lines, and area templates to Bézier control points by following 
the steps below.

 To convert an angle to a Bézier control point

1 Click the Selection tool  in the Toolbox and select a text container, shape, 
line, or area template that has angle points.

2 Click the Point Conversion Tool  in the Toolbox.

3 Drag an angle point to give it curvature.

 To adjust a curve

1 Click the Selection tool  in the Toolbox and select a text container, shape, 
line, or area template that has end points.

2 Click the Point Conversion Tool  in the Toolbox.

3 Drag an angle point to adjust the curve, or just click to convert a Bézier point 
to an angle point.

Note: This will also convert an angle point to a Bézier point.

 To move a point

 Click the Selection tool  in the Toolbox and select a text container, shape, 
line, or area template that has angle or Bézier points and drag to move a 
point.

 To create a line with angles or Bézier curves

1 Click the Pen Tool  in the Toolbox.

2 Click to set an angle point.

- OR -

Drag to set a Bézier point and move the control point to set the direction of 
the curve.

3 Set additional points, as desired.
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4 Press ESC or click another tool to complete the line.

 To add a point

1 Click the Selection tool  in the Toolbox and select a line or curve.

2 Click the Pen Tool  or the Add Point Tool  in the Toolbox.

3 Move the tool over the line or curve.

4 Click to add a point.

 To remove a point

1 Click the Selection tool  in the Toolbox and select a line or curve.

2 Click the Pen Tool  or the Remove Point Tool  in the Toolbox.

3 Move the tool over the line or curve.

4 Click to remove the point.

Converting Elements into Bézier Shapes
You can convert rectangles, circles, text containers, and area templates into 
different element types using the Convert to menu options in the Element 
menu. On the Element menu, click:

 Convert to Bézier shape—to convert any element, except an Image 
element, into a Bézier shape with points that can be moved or adjusted. For 
example, choose this option to convert a text box into a Bézier text container.

 Convert to Bézier text path—to convert any element, except an Image 
element or area template, into a Bézier text path. For example, choose this 
option to convert a circle shape into a Bézier text path.

 Convert to Text Container—to convert any element, except an Image 
element or area template, into a text container. For example, choose this 
option to convert a box or circle shape into a text container.

 Convert to Area template—to convert any element, except an Image 
element or text container, into an area template. For example, choose this 
option to convert a circle shape into an area template.
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Manipulating Elements
There are several options available to manipulate elements. Elements can be 
layered, aligned, rotated, resized, grouped, and locked. Text can also be set to run 
around specified elements.

Layering Elements
Every element has a stacking order. Pageflex Studio stacks the elements in the 
order you create them, with new elements always going on top. No two elements 
can occupy the same place in the stacking order.

Note: Adjustments to the stacking order are reflected in the content on the 
Layout tab. The Layout tab shows elements as currently arranged back to front, 
rather than in the order you created them.

 To adjust the stacking order

1 Using the Selection tool ,  select at least one element. 

2 On the Element menu, point to Arrange, and then choose one of the 
following commands:

 Bring to Front. Moves the selected element to the top of the stacking 
order. 

 Send to Back. Moves the selected element to the bottom of the stacking 
order.

 Bring Forward. Moves the selected element forward by one element in 
the stacking order. 

 Send Backward. Moves the selected element backward by one element 
in the stacking order. 

Note: If you select more than one element, the selected elements maintain 
their stacking order relative to one another.

 To select an element located behind another element

If one element is behind another and completely covered by the top element, you 
cannot select it with the Selection tool. Instead, click the name of the element in 
the Layout tab to select it in the Document window. 

 To open the Layout tab, choose View  Structure and click the Layout tab.
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With the element selected, you can change its stacking order or its properties in 
the Properties panel.

Aligning Elements
You can control the position of two or more elements in relation to each other. 
Pageflex Studio aligns elements using their edges. The edges of an element are 
represented by the eight handles that appear when an element is selected. 

You have several options for aligning elements:

Alignment Option Effect Appearance

Left Edges Moves the elements 
horizontally to line up the 
left edges.

Right Edges Moves the elements 
horizontally to line up the 
right edges.

Top Edges Moves the elements 
vertically to line up the top 
edges.

Bottom Edges Moves the elements 
vertically to line up the 
bottom edges.

Horizontally 
Center

Moves the elements 
horizontally to line up their 
centers. The horizontal 
center is represented by the 
middle handle on the top 
and bottom edges of the 
element.
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Note: If an element is locked, you cannot change its alignment. For instructions 
on unlocking, see “Locking Elements” on page 83.

 To align elements to each other

1 Using the Selection tool , hold down the SHIFT key and select at least two 
elements. The first element you select becomes the anchor for aligning the 
other elements. Studio uses the coordinates of the first element you select to 
align the rest of the elements.

You can align as many elements as you want, including elements of varying 
types. For example, you can align a text container and an image container.

2 On the Element menu, point to Align, and then select an Alignment option. 

Rotating Elements
There are two ways to rotate an element or a group.

 Set the Angle property in the Properties panel under Position. 

 Use the Rotation tool 

Vertically Center Moves the elements 
vertically to line up their 
centers. The vertical center 
is represented by the middle 
handles on the left and right 
edges of the element.

Center Moves the elements both 
horizontally and vertically to 
line up the absolute centers 
of the elements.

Alignment Option Effect Appearance
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 To set the Angle property

1 Using the Selection tool , select an element or a group.

2 In the Properties panel under Angle, type a number for the rotation. Positive 
numbers rotate objects counter-clockwise; negative numbers rotate objects 
clockwise.

 To use the Rotation tool

1 Click the Rotation Tool  on the Toolbox and select an element or group.

2 Move the pointer over one of the corner handles.

3 When the pointer changes to look like the Rotation Tool , drag to rotate 
the element.

 Rotation tool around a corner handle

4 When you release the mouse button, Pageflex Studio displays the new Angle 
property in the Properties panel.

Resizing Elements
There are several ways to resize an element after you create it. You can resize a 
single element by adjusting the selection handles for the element or by changing 
the properties for the element in the Properties panel. You can change the width 
and height of two elements to match each other using the Resize command.

 To resize an element using the Selection tool

 Click the element to activate the selection handles, and drag one of the 
handles to change the element size.

Angle = 0° Angle = 30° Angle = –30°
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 To resize an element using the Properties panel

1 Select an element by using the Selection tool  or by clicking the element 
name in the Layout tab.

2 In the Properties panel, change the values in the Height and Width 
properties.

 To resize two elements in proportion to each other

1 Using the Selection tool , select two elements. Pageflex Studio uses the 
Width and Height properties from the first element you select to resize the 
elements.

2 On the Element menu, point to Resize, and then select one of the following 
options:

 Make Same Height. Changes the Height property of the second element 
you selected to match the first element.

 Make Same Width. Changes the Width property of the second element 
you selected to match the first element. 

 Make Same Size. Changes the Height and Width properties of the 
second element to match the first element.

Grouping Elements
A group is a collection of elements combined together to function as a single 
element. Creating element groups helps you organize your template layout. 
Groups can contain any type of element, including other groups.

Pageflex Studio has three types of groups: fixed groups (just called “groups”), 
vertical groups, and horizontal groups. The groups differ in the way they treat 
the position of elements within the group. Vertical and horizontal groups are 
generally used to group elements with variable content. 

 Fixed Group. The elements in the group remain in fixed positions relative to 
each other and to the rest of the template layout. Once you create a group, 
Studio locks the position of the elements so that you cannot move them 
using the Selection tool.
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 Vertical Group. The elements are grouped vertically, one on top of the other 
in a single column. The positions of the elements in the group can change 
based on the size of the variable elements and their alignment options within 
the group. You can edit the elements inside a vertical group at any time.

 Horizontal Group. The elements are grouped horizontally, one beside each 
other in a single row. The positions of the elements in the group can change 
based on the size of the variable elements and their alignment options within 
the group. You can edit the elements inside a horizontal group at any time. 

 To group elements in a fixed group

Before creating a group, arrange the elements where you want them to be in 
relation to each other. Adjust their properties, size, position, and stacking order 
before creating the group. If you want to move or edit elements after grouping 
them, you must ungroup them first.

1 Using the Selection tool , select at least two elements. A group can 
contain as many elements as you want.

2 Choose Element  Group. 

Pageflex Studio groups the elements together.

 To group elements in a vertical group

1 Using the Selection tool , select at least two elements. A vertical group 
can contain as many elements as you want.

2 Choose Element  Vertical Group.

Pageflex Studio stacks the selected elements into a vertical group. It 
determines the group order based on the vertical positions of the elements 
before you grouped them. The top element in the group was the topmost 
element on the template page.
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Your template looks like this, for example, with the vertical grouping of an 
image and a textbox:

3 To set the alignment options for the new vertical group, select Horizontal 
Alignment and Vertical Alignment options in the Properties panel under 
Special.

4 To create vertical offsets among group elements, increase the amount of 
space for Top and Bottom properties in the Properties panel under 
Bumpers. Studio maintains the Bumper space between two elements if the 
elements change size and position within the group.

If the elements in the group fill the boundaries of the vertical group 
container, you can still select the container by holding down the CTRL key 
and clicking it.
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 To group elements in a horizontal group

1 Using the Selection tool , select at least two elements. A horizontal group 
can contain as many elements as you want.

2 Choose Element  Horizontal Group.

Pageflex Studio creates the group and lines the elements up beside each 
other. It determines the group order based on the horizontal positions from 
left to right of the elements before you grouped them. The leftmost element 
on the template page becomes the first element in the group. 

3 To set the alignment options for the new horizontal group, select Horizontal 
and Vertical Alignment options in the Properties panel under Special.

4 To create horizontal offsets between the group elements, increase the 
amount of space for Left and Right properties in the Properties panel under 
Bumpers. Studio maintains the Bumper space between two elements if the 
elements change size and position within the group.

If the elements in the group fill the boundaries of the horizontal group 
container, you can still select the container by holding down the CTRL key 
and clicking it.

 To ungroup elements

1 Select the group using the Selection tool .

2 Choose Element  Ungroup. Pageflex Studio ungroups the elements.

You cannot ungroup a nested group, a group that is inside another group. You 
must ungroup the outer group first in order to ungroup the nested group.

You can ungroup elements in an area template with the Ungroup menu option.

A B C

 the outer group first

Nested group
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Locking Elements
Locking an element prevents you from changing its location on the page using 
the Selection tool. The handles on a locked element appear gray. If you try to drag 
a locked element, the pointer on the Selection tool changes to a lock symbol. You 
cannot use the Alignment or Resize commands if one of the selected elements 
is locked. 

 To lock an element

1 Using the Selection tool , select at least one element.

2 Choose Element  Lock Position. Pageflex Studio locks the position of the 
selected elements.

 To unlock an element

1 Using the Selection tool , select the element or elements you want to 
unlock.

2 Choose Element  Unlock. Studio unlocks the position of the selected 
elements.

Creating Runarounds
You can create a text runaround using a combination of a text container and a 
runaround element. The runaround element can be any other type of element 
including another text container. You can have more than one runaround element 
for the same text container. Studio places text around the runaround element.

Creating a runaround requires setting both the Runaround property for the text 
container and the Avoid Me property for the runaround element.

You can control the appearance of a runaround using the Margins properties for 
the text container and the Bumpers properties on the runaround element.

 Margins. Control the text offset from the edge of the text container.

 Bumpers. Controls the offset amount from the edges of the runaround 
element.
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 To create a runaround

1 Arrange the text container and the runaround element so that they are 
overlapping each other.

2 Select the text container.

Note: If you are selecting the text container in the Document window, use 

the Selection tool . If you use the Text tool , you cannot change the 
properties for the text container.

3 In the Properties panel, set the Runaround property to Yes.

4 Select the runaround element.

5 In the Properties panel, set the Avoid Me property to Yes.

6 The text in the text container avoids the runaround element. You can adjust 
the wrapping effect for the text lines by moving either the text container or 
the runaround element.

Creating a text 
runaround requires 
setti
ng 
two 
ele
ment to work 
together. First create 
a text block and add 
some text to it. 
Second, create a 
shape to use for the 
runaround. You can 
use any kind of 
element as a 
runaround, even 
another text 
container.

Set the 
Runaround 
property for the 
text container 
to Yes.

Set the Avoid 
Me property for 
the runaround 
element to Yes.
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Note: Text runs around either the left side or the right side of the 
runaround element, but not both.

Creating a text runaround 
requires setting two elements 
to work 
together. 
First create 
a text block and add some text 
to it. Second, text container.

Text runs around the left side 
or the right side, but not both.

Creating a text runaround 
requires setting two elements 

to work together. 
First create a text 
block and add 

some text to it. Second, text 
container.
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Defining Colors
Pageflex Studio lets you define both process colors and spot colors. For process 
colors, Studio supports two color models:

 CMYK (Cyan, Magenta, Yellow, and Black)

 RGB (Red, Green, Blue)

You must define each color for your template. All elements use the same color 
definitions. You can apply colors to container fills and borders and to text 
characters. Text color can also be part of a paragraph style definition.

 To view the list of color definitions

1 Choose Element  Define Colors. Pageflex Studio displays the Define 
Colors dialog box.

  Process colors appear with solid color blocks in the list. 

  Spot colors appear with a white spot through the color block.

2 Select a color in the list to preview a sample of the color. Under Description, 
Studio displays the complete color definition.
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 To define a color

1 On the Define Colors dialog box, click New.

- or -

On the Character or Paragraph Properties dialog box, in the Color box, 
select New.

- or -

On the Properties panel under Fill Color or Border Color, choose New.

Studio displays the Color Mix dialog box.

2 Type a name for the color in the Name box.

3 In the Type list, choose the type of color you want. The type of color 
determines how the color is treated in the final output. 

 Process Color. When you print a process color, it is made up of the 
process colors used by your printing device. 

 Spot Color. When you print a spot color, it is treated as a single ink 
color. Only one separation is created for it.
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4 In the Model list, choose a color model for defining the color. The available 
color definition boxes change according to your selection. For spot colors, the 
color definition provides a color to use for previewing the color. It has no 
effect on the final output. 

 RGB. Uses Red, Green, and Blue. Color values range from 0 to 255.

 CMYK. Uses Cyan, Magenta, Yellow, and Black. Color values range from 
0% to 100%.

5 Type values for each color, or use the sliders to adjust the color values. A 
sample of the color mix appears beside the sliders.

6 When you are finished defining the color, click OK. Studio adds the new 
color to the list of available colors.

 To edit a color

Editing a color definition changes every occurrence of the color throughout the 
template. If you change the name of the color, Studio updates the name anywhere 
it appears in the template. You cannot revert to the original color definition using 
the Undo command.

1 In the Define Colors dialog box, under Colors, select the color, and then 
click Edit. 

Studio displays the Color Mix dialog box for the color.
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2 You can edit any information in the dialog box. For example, you can change 
a process color into a spot color, or a spot color into a process color. 

3 Click OK when you are finished. Studio updates the color definition in the 
list and in every element that uses the color.

 To delete a color

Deleting a color is a permanent change and cannot be undone.

1 Choose Element  Define Colors to display the Define Colors dialog box.

2 Under Colors, select the color, and then click Delete. Studio deletes the 
color definition from the list.
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Understanding Element Properties
Each element has a set of properties that define it in both appearance and 
function. The available properties for an element depend on the type of element, 
and not all properties are available for all elements. When you select an element 

with the Selection tool , the Properties panel displays the properties for that 
element. Use the Properties panel to change an element’s properties.

Note: For Text containers, you must select the container with the Selection tool 
to see the container properties. If you select text within a container using the 

Text tool , the Properties panel displays the Text properties. See “Formatting 
Text” on page 124 for an explanation of both Character and Paragraph Text 
properties.

The Properties panel has four tabs, Form, Flex, .EDIT, and Info. Properties that 
control the appearance of the element are on the Form tab. Properties that 
control the flexible behavior of an element appear on the Flex tab. Properties 
related to Online Design and Editing Sessions and the Free Edit step in Pageflex 
Storefront are on the .EDIT tab. Properties that describe the element are on the 
Info tab.

Note: Settings on the .EDIT tab are only applicable when the template is used 
with Online Design and Editing Sessions and Pageflex Storefront.

The Properties panel groups the properties on each tab by category. All 
measurements use the units of measure specified in the Preferences dialog box. 
See “Setting Preferences” on page 33.

The Properties panel is described by function in the following pages. The 
function name is followed by a bulleted list with the following information:

 Elements: The elements to which the property can be applied.

 Description: A description of the function.

 Values: The values that can be entered or that are displayed for this property.
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Form
The following items can be found under the Form tab in the Properties panel.

Image
When you select an image, the Form tab displays the fields below.

Source

 Elements:  Images.

 Description: Identifies the source for a static image.

 Values: Type the path to the image file, or click New to locate an image 
source. For more information, see “Image Containers” on page 62.

In the Open Content File dialog box, locate the image, and click Open. 

To remove an image source, choose None.

Fit

 Elements:  Images.

 Description: Determines how an image is scaled in relation to its container.

 Values: Choose one of the following options:

 Fit Image. Scales the image according to the Horizontal and Vertical 
Scale percentages in the Properties panel. By default, the image scales to 
100%. Scales the container to match the image dimensions.
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 Fit Width. Scales the image to fit the width of the image container. The 
aspect ratio of the image is preserved and the height of the image 
container adjusts so that the image is not distorted.

 Fit Height. Scales the image to fit the height of the image container. The 
aspect ratio of the image is preserved and the width of the image 
container adjusts to accommodate the height.

 Stretch to Fit. Scales the image both horizontally and vertically to fit the 
height and width of the image container. The image may be distorted. 
For more information, see “Scaling Images” on page 65.

 Scale to Fit. Scales the image to fit within the Maximum Width and 
Maximum Height specified. Preserves the aspect ratio so the image is 
not distorted.

 Scale to Fit (Page Relative). Scales the image to fit within the 
Maximum Width and Maximum Height, which are specified relative to 
the size of the page. See “Scaling Images” on page 65 for details.

Horizontal Scale

The percentage to horizontally scale the image while maintaining its aspect ratio.

Vertical Scale

The percentage to vertically scale the image while maintaining its aspect ratio.

Maximum Width

The maximum width, in units or percentage, to scale the image. This reflects the 
size of the image container.

Maximum Height

The maximum height, in units or percentage, to scale the image. This reflects the 
size of the image container.

Line
When you select a line, the Form tab displays the fields below.

Color

 Elements: Lines.

 Description: Applies color to a line. 
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 Values: Select a color from the list, or click New to define a new color. For an 
explanation of adding colors, see “Defining Colors” on page 86. 

Tint

 Elements: Lines.

 Description: Applies a percentage of the Color specified for the line.

 Values: Tint is a percentage from 0% to 100%. 

Thickness

 Elements: Lines only.

 Description: Determines the weight of the line.

 Values: Select a thickness from the list, or type a value in points. 

Line Style

 Elements: Lines only.

 Description: Lines can be solid, dashed, or dotted. 

 Values: Solid, Dash, or Dot. Click the button  next to the value to open 
the Border Style dialog box. For more information, see “Borders and Lines” 
on page 69.

Point X, Point Y

The x- and y-axis locations for the selected point on a line. See “Point X, Point Y” 
on page 95 for details.

Size
When you select a container, shape, or group, the Form tab displays the fields 
below.

Width

 Elements: Text containers, images, area templates, shapes, horizontal 
groups, and vertical groups.

 Description: Controls the width of the element.

 Values: Enter width as a number. Studio formats the width of the element in 
the ruler units specified in the Edit  Preferences menu.
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Height

 Elements: Text containers, images, area templates, shapes, horizontal 
groups, and vertical groups.

 Description: Controls the height of the element.

 Values: Enter height as a number. Studio formats the height of the element 
in the ruler units specified in the Edit  Preferences menu.

Position
When you select a container, shape, or group, the Form tab displays the fields 
below.

Left

 Elements: Text containers, images, area templates, shapes, and groups.

 Description: This number is the horizontal coordinate of the left side of the 
element.

 Values: Position is relative to the horizontal ruler. Enter a number as a 
measurement on the ruler. The number can be positive or negative. Changing 
the ruler origin may change the value for the position, but it does not change 
the element’s location on the template. For elements inside an area template, 
position is relative to the edges of the area template container.

Top

 Elements: Text containers, images, area templates, shapes, and groups.

 Description: This number is the vertical coordinate of the element.

 Values: Vertical position is relative to the vertical ruler. Enter a number as a 
measurement on the ruler. The number can be positive or negative. Changing 
the ruler origin may change the value for the position, but it does not change 
the element’s location on the template. For elements inside an area template, 
position is relative to the edges of the area template container.

Angle

 Elements: Text containers, images, area templates, shapes, and groups.

 Description: Controls the rotation of an element or group.
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 Values: Positive numbers rotate objects counter-clockwise, negative 
numbers rotate them clockwise.

To rotate an element or group using the Rotation tool, see “Rotating 
Elements” on page 77.

Point X, Point Y

 Elements: Bézier shapes (including Text Paths, Bézier lines, Bézier text 
containers, Bézier shapes, and Bézier area templates)

 Description: Specifies the horizontal and vertical coordinates for the 
selected point.

 Values: Point X describes the position of the point on the horizontal ruler; 
Point Y describes the position of the point on the vertical ruler. Select a point 
and enter a number as a measurement on the ruler. The number can be 
positive or negative. Changing the ruler origin may change the value for the 
position, but it does not change the location of the element on the template.

X1, Y1, X2, Y2

 Elements: Lines only.

 Description: Specifies the horizontal and vertical coordinates for the two 
endpoints of a line. The first endpoint is measured by X1 and Y1, and the 
second endpoint is measured by X2 and Y2. 

 Values: X values describe positions on the horizontal ruler; Y values describe 
positions on the vertical ruler. Enter a number as a measurement on the 
ruler. The number can be positive or negative. Changing the ruler origin may 
change the value for the position, but it does not change the location of the 
element on the template.

Color and Border
When you select a container, shape, or group, the Form tab displays the fields 
below.

Angle = 0° Angle = 30° Angle = –30°
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Fill Color

 Elements: Text containers, area templates, shapes, horizontal groups, and 
vertical groups.

 Description: Applies color to the inside of the container or shape.

 Values: Select a color from the list of pre-defined color names. For an 
explanation of adding colors, see “Defining Colors” on page 86.

Fill Tint

 Elements: Text containers, area templates, shapes, horizontal groups, and 
vertical groups.

 Description: Applies a percentage of the Fill Color to the object.

 Values: Tint is a percentage from 0% to 100%.

Border Color

 Elements: Text containers, images, area templates, shapes, horizontal 
groups, and vertical groups.

 Description: Applies color to the element border. Works with the Border 
Thickness property to create the element border.

 Values: Select a color from the list of pre-defined color names. For an 
explanation of adding colors, see “Defining Colors” on page 86.

Border Tint

 Elements: Text containers, images, area templates, shapes, horizontal 
groups, and vertical groups.

 Description: Applies a percentage of the Border Color to the element 
border.

 Values: Tint is a percentage from 0% to 100%.

Border Thickness

 Elements: Text containers, images, area templates, shapes, horizontal 
groups, and vertical groups.

 Description: Determines the thickness of the element border. Works with 
the Border Color property to create the element border.

 Values: Enter a positive number. Studio measures Border Thickness in 
points.
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Border Style

 Elements: Text containers, images, area templates, shapes, horizontal 
groups, and vertical groups.

 Description: The border style can be a solid line, a dashed line, or a dotted 
line. The Border Style dialog box lets you define the style the for the line.

 Values: Solid, Dash, or Dot. Click the button  next to the value to open 
the Border Style dialog box. 

For more information, see “Borders and Lines” on page 69.

Margins
When you select a container or group, the Form tab displays the fields below.

Left, Right, Top, Bottom

 Elements: Text containers, area templates, horizontal and vertical groups.

 Description: Sets the amount of space between the contents of the container 
and the edge of the container.

 Values: Enter numbers for each property.

Bumpers
When you select a container, shape, or group, the Form tab displays the fields 
below.

Left, Right, Top, Bottom

 Elements: Text containers, images, area templates, shapes, and groups.

Margins set the amount 
of space between the 
text and edge of the 
container.

Top margin

Left margin Right margin

Bottom margin
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 Description: Specifies a required amount of space to leave around the 
outside of an element. This property works with the Avoid Me and 
Runaround properties to create a text runaround effect. When you overlap 
the element with a text container, you create a runaround, and the Bumpers 
are the amount of space between an element and the text that runs around it.

When you specify a bumper space for elements within a group, the bumper 
space determines the distance between the elements. If you are adding flex 
behavior to an element or group of elements, adding Bumpers preserves a 
uniform space between elements.

See “Creating Runarounds” on page 83 for more information.

 Values: Enter positive numbers for each property.

Columns
When you select a text container the Form tab displays the fields below.

Number

 Elements: Text containers only.

 Description: Indicates the number of columns in a text box. For more 
information, see “Adding Columns” on page 57.

 Values: Enter a positive number.

Gutter Size

 Elements: Text containers only.

 Description: Measures the distance between the columns in the text box.

 Values: Enter a positive number.

Bumpers set the amount 
of space between the 
container and any other 
containers near it.

Left 
bumper
space

Right 
bumper 
space

Top bumper space

Bottom bumper space
 98 Working with Elements



Chapter 4
Special
When you select a container, shape, line, or group, the Form tab displays the 
fields below.

Avoid Me

 Elements: Text containers, images, area templates, shapes, lines, and 
groups.

 Description: Indicates whether the text in an overlapping text container 
should avoid the element. Works with the Runaround and Bumpers 
properties to create a text runaround effect.

 Values: Choose Yes to have text avoid the element, or No to prevent any 
interaction between elements.

Runaround

 Elements: Text containers only.

 Description: Indicates whether the text in the container should flow around 
the edges of any overlapping elements with the Avoid Me property set to Yes. 
Works with the Avoid Me and Bumpers properties to create a text 
runaround effect. See “Creating Runarounds” on page 83.

 Values: Choose Yes to allow the text to flow around another element, or No 
to prevent any text runaround effects.

Suppress Printing

 Elements:  Text containers, images, area templates, shapes, lines, and 
groups.

 Description: This property prevents an element from printing. The element 
still occupies space in the template, including runaround and flex properties, 
but it is not intended to be included in the final output. 

Note: When you create a job in Pageflex Studio, you can choose whether 
the suppressed elements should print or not. For more information, see 
“Previewing Suppressed Elements” on page 339.

 Values: Choose Yes or No. 
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Overprint Border/Fill/Black Line

 Elements: Text Containers, images, area templates, shapes, lines, and groups.

 Description: This property enables overprinting for selected elements. When 
printing PostScript or PDF files, you can control how much ink goes over the 
medium using overprint. When overprint is disabled (the default), each 
colorant replaces all colorants under it, resulting in less ink on that region. 
With overprint enabled, the inks beneath the object are emitted, resulting in 
more ink on the medium.

You can set the default overprint settings for black text and black objects by 
selecting the appropriate check boxes during template setup. If you enabled 
the default overprint settings for black text during template setup, it will 
automatically get the overprint attribute set at template creation time. This 
same behavior will occur for black objects.

 Values: Choose Yes or No to enable or disable overprinting of the selected 
element. If you selected the Black Object Fills or Black Object Borders check 
boxes in the Template Setup dialog box, your choice will be reflected here 
when you use black fills or borders.

You can also override these settings for black objects in the Job Setup dialog. 
See “PostScript” on page 318 or “PDF” on page 320 for details.

Use Clipping Path

 Elements: Image containers only.

 Description: If an image has a clipping path, Studio uses it to wrap text 
around the contours of the clipping path. Clipping paths define the 
transparent parts of the image. If the image file has no clipping path 
information, setting this property has no effect.

Note: This property only applies to runaround, not the actual clipping of 
the image. You cannot create a clipping path with Studio. Use your image 
editing application to add a clipping path. 

 Values: Choose Yes or No to include the clipping path or to exclude it.

Clipping Offset

 Elements: Image containers that use clipping paths.

 Description: For .eps image files with clipping paths, the bumper is the 
distance between the clipping path of the image and the text that wraps 
around the image.
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If the image file has no clipping path information, setting this property has 
no effect. To change the offset around an image container with no clipping 
path, use the Bumper property. See “Bumpers” on page 97.

 Values: Enter a number.

Vertical Alignment (for Text Boxes)

 Elements: Text boxes only. 

 Description:  This property sets the vertical alignment of the text within a 
text box. 

 Values: Top, Center, Bottom. or Justify.

Note: If you also apply the Runaround property to the text box, the Vertical 
Alignment must be Top. 

Vertical Alignment 
set to Top, the 
default option.

Top

Vertical Alignment 
set to Center. 
Text centers top to 
bottom.

Center Bottom

Vertical Alignment 
set to Bottom. 
Text flows from the 
bottom up.

Vertical Alignment 

set to Justify. 

Text fills the 

container vertically.

Justify
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Vertical Alignment (for Horizontal Groups and Vertical Groups)

 Elements: Horizontal groups and vertical groups.

 Description: This property determines the vertical alignment of the 
elements within the group in relation to the group’s container.

 Values: Top, Center, Bottom, Justify.

Horizontal Alignment (for Horizontal Groups and Vertical Groups)

 Elements: Horizontal groups and vertical groups.

 Description: This property determines the horizontal alignment of the 
elements within the group in relation to the group’s container.

 Values: Left, Center, Right, and Justify (horizontal groups only).

For horizontal groups: For vertical groups:

Top

Center

Bottom

Top Bottom

Center Justify

For horizontal groups: For vertical groups:

Left

Center

Right

Left Right

Center

Justify
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Crop Content

 Elements: Horizontal groups, vertical groups, and area templates.

 Description: Determines whether the area template container crops the 
elements inside it or not.

 Values: Yes and No. With this property set to Yes, Studio crops any element 
inside the area template that extends past the edges of the area template 
container. 

With this property set to No, Studio does not crop any element that extends 
past the edge of the container.
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Flex
The following items can be found under the Flex tab in the Properties panel.

Flex Height

Behavior

 Elements: Text boxes, area template boxes, rectangular shapes, horizontal 
groups, and vertical groups.

Note: Flex Height does not apply to any kind of oval or polygon.

 Description: Indicates how the height of the element can change as the 
element’s contents change. You can use this property with both static and 
variable contents. When you use Flex Height, you cannot enter a number in 
the Height property for the size of the element.

 Values: None, Minimize, Maximize, Column Balance.

 None. Turns off the flex behavior.

 Minimize. The element’s container height shrinks to fit the size of its 
contents. For example, if a text box is 5 inches tall, and the text inside 
the box only needs to be 4 inches tall to fill the container, then the text 
box shrinks to 4 inches in height.

 Maximize. The element’s height expands to fill its container. For 
example, a rectangle is inside an area box, and the area box is 5 inches 
tall. With Flex Height for the rectangle set to Maximize, the rectangle 
expands to 5 inches tall to fit the area box.

 Column Balance (for text boxes only). The height of the text box 
expands or contracts so that the text fits in equal columns inside the 
bounding text box. See “Adding Columns” on page 57 for information on 
balancing columns.

Column balancing off Column balancing on
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Minimum and Maximum

 Elements: Text containers, area templates, shapes, horizontal groups, and 
vertical groups.

 Description: Specifies upper and lower limits to control the specified 
Behavior attribute. For example, with the Behavior set to Minimize, the 
value for Minimum indicates the smallest possible height for the element. 
No matter what the flexible behavior is set to, Minimize or Maximize, the 
element’s height does not shrink smaller than the Minimum value or expand 
larger than the Maximum value. 

 Values: Enter a positive number for each value. The Minimum must be 
smaller than the Maximum.

Flex Width

Behavior

 Elements: Text boxes, area template boxes, rectangular shapes, horizontal 
groups, and vertical groups.

Note: Flex Width does not apply to any type of oval or polygon.

 Description: Indicates how the width of the element can change as the 
element’s contents change. You can use this property with both static and 
variable contents. When you use Flex Width, you cannot enter a number for 
the Width property.

 Values: None, Minimize, Maximize.

 None. Turns off the flex behavior.

 Minimize. The element’s width shrinks to fit the size of its contents. For 
example, if a text box is 2 inches wide, and the text inside the box only 
needs to be 1 inch wide to fill the container, the text box shrinks to 1 
inch wide.

 Maximize. The element’s width expands to fill its container. For 
example, a rectangle is inside an area box that is 3 inches wide. With 
Flex Width for the rectangle set to Maximize, the rectangle expands to 
3 inches wide to fit the area box.
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Minimum and Maximum

 Elements: Text containers, area templates, shapes, horizontal groups, and 
vertical groups.

 Description: Specifies upper and lower limits to control the specified 
Behavior attribute. For example, with the Behavior set to Maximize, the 
maximum value indicates the widest possible width for the element. No 
matter what the flexible behavior is set to, Minimize or Maximize, the 
width of the element does not shrink smaller than the minimum value or 
expand larger than the maximum value.

 Values: Enter a positive number for each value. The Minimum must be 
smaller than the Maximum.

Copy Fit Rule
 Elements: Text containers only. 

 Description: This property specifies the Copy Fit rule applied to the 
container. 

 Values: Click the button to open the Copy Fit dialog box. You can select a 
Copy Fit rule or create a new rule to apply to the container. See “Using Copy 
Fit Rules” on page 163.

Anchor Flex

Anchor, Anchor X, and Anchor Y

 Elements: Text boxes, image containers, area template boxes, and 
rectangular shapes. Horizontal and vertical groups can have Anchor Flex, but 
the elements contained inside the group do not.

Note: Anchor Flex does not apply to any kind of oval or polygon.

 Description: The Anchor property sets a fixed point if the container changes 
its size to accommodate the flex behavior. The Anchor X and Anchor Y 
values show the numeric position of the anchor point.
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For any container with flex behavior, the size of the container adjusts for the 
size of the variable content based on the anchor point. For example, if the 
anchor point is Left/Top, and the flex height and flex width are both set to 
Maximize, the position of the left/top handle of the element remains fixed 
as the height and width change.

 Values: Click the button beside the Anchor box in the Properties panel to 
display the Anchor Point dialog box.

To select an Anchor Point:

 Click one of the nine buttons.

-or-

 Select a position in the Anchor list.

Left/Top anchor point 
remains fixed as height 
and width adjust for new 
contents
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.EDIT
The following items can be found under the .EDIT tab in the Properties panel. 
See Chapter 5, “.EDIT Tab,” on page 111 for details.

Configuration

UIClass 

 Elements: Text containers, images, area templates, shapes, and groups.

 Description: Lets you configure the options displayed in control applets and 
Storefront Free Edit tools depending on the item selected by a user of those 
applications.

 Values: Click New... and type a name for the UI class, or select a name from 
the drop-down list, which is compiled from your configuration file in the 
WebPages folder.

Constraints

Selection and Editing

 Elements: Text containers, images, area templates, shapes, and groups.

 Description: Sets rules specifying whether users of Storefront deployments 
or Online Design and Editing Sessions can select or edit this element.

 Values: Allow or Prevent.

Size and Position

 Elements: Text containers, images, area templates, shapes, and groups.

 Description: Sets rules specifying whether users of Storefront deployments 
or Online Design and Editing Sessions can resize, position, copy, delete, or 
re-layer this element. Text can still be changed.

 Values: Allow Changes or Prevent Changes.
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Info
The following items can be found under the Info tab in the Properties panel.

Name
 Elements: Text containers, images, area templates, shapes, and groups.

 Description: Allows control applet actions to select document elements by 
name.

 Values: an XML-compatible string.

Kind
 Elements: Text containers, images, area templates, shapes, and groups.

 Description: Displays the generic name for the selected element.

 Values: This field cannot be edited. Values include images, area template, 
rectangle, text polygon, and so on.

TOC Override Text
 Elements: Text containers.

 Description: Allows the entry of alternate text to be shown in a table of 
contents in place of the text in the range selection.

This is a paragraph-level property, but it cannot be set on multiple 
paragraphs at once, to avoid placing multiple same text table of contents 
entries. It is shown only for selections that are one paragraph or less.

 Values: Text.

Master Element
 Elements: Text containers, images, area templates, shapes, and groups.

 Description: Displays whether a selected element was inherited from the 
master page or not. See “Working with Master Pages” on page 189 for more 
information.

 Values: This field cannot be edited. The value is Yes if the element was 
inherited from the master, and No if it was not.
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Autochain
 Elements: Text containers.

 Description: Displays whether a text box is an autochain text container or 
not. See “Working with Master Pages” on page 189 for more information.

 Values: This field cannot be edited. The value is Yes if the element is an 
autochain text container, and No if it is not.
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.EDIT Tab

The functions on the .EDIT Tab enable you to set element options for use 
in an Online Design and Editing Session application or the Free Edit step 
in Pageflex Storefront. You can:

 create custom panels by applying UI Classes to elements;

 add constraints to elements, for example, to limit users from selection and 
editing or size and position changes;

 create alternate panels to be displayed, depending on the object selected.
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Using Templates in .EDIT and Storefront
Pageflex .EDIT is the publishing technology behind Online Design and Editing 
Sessions and the Storefront Free Edit step that enables non-designers to design 
and edit sophisticated desktop publishing documents with nothing more than a 
Web browser and an internet connection. This technology enables companies to 
offer document editing capabilities to customers, employees, marketing partners, 
and dealers or franchise owners — all through their standard website and 
without requiring the use of any plug-ins.

Pageflex Storefront is a set of tools and technologies that makes it easy to set up 
a Web-to-print store for selling customizable document products. Through an 
easy-to-use Web-based interface, you can publish and manage a catalog of 
customizable documents, set up user access, determine customization 
workflows, set site skinning, and define user profile, shipping and purchasing 
options. Storefront uses .EDIT technology in its Free Edit feature, enabling users 
to modify documents using a standard Web browser.

Online Design and Editing Sessions and Storefront Free Edit both allow you to 
create a wide range of user experiences. You can configure these editing solutions 
so that users can create their own documents or simply make changes to existing 
documents before going to press. You can offer users a lot of opportunity to make 
changes or constrain them to making a limited set of changes. Subtle constraints 
can be implemented by offering a limited number of choices in the Online Design 
and Editing Session or Free Edit user interface; by exposing only paragraph 
styles, for example, rather than font names, font sizes, and font styles, in a text 
panel.
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You can use Pageflex Studio to create templates for use in Online Design and 
Editing Sessions and Storefront. Within Studio, you can apply instructions that 
govern the extent to which the template can be modified in both of these 
applications. Give careful thought to the user experience when you create the 
template. Consider which elements you do not want users to modify at all and 
which elements you want to limit user control over. For example, you can allow 
users to edit a headline, but prevent them from moving it on the page. The screen 
shot below displays a sample template in Pageflex Studio.

 The .EDIT Tab contains fields to add instructions to the template for use with 
the control applets and document applet in Online Design and Editing Sessions 
and Storefront Free Edit. Control applets contain controls to add or change 
elements in the document template. The document applet displays the 
document template.

.EDIT Tab

Template
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Adding Constraints
Constraints limit the elements the user can change. For example, you can choose 
to allow users to modify every single element of the document, such as moving, 
adding, or deleting images and text, or you can limit them to making only 
selected changes. You can allow users to change only the text in a text container, 
but prevent them from moving it. Or you can prevent users from changing any 
text, and only allow them to move elements around.

The following are some examples of the ways in which you can add constraints:

 Use the constraints on the .EDIT tab for Selection and Editing, or Size and 
Position to restrict your users’ ability to directly manipulate objects.

 Use flex and group functionality when designing your template. These 
features enable you to ensure that the document design remains cohesive 
regardless of the amount of content a user adds or removes.

 Use variables in your design to constrain users’ ability to modify text 
content.

 Design your control applets to display only the options you want users to be 
able to change, or limit the selection of editing panels in Storefront Free Edit 
that you display to the user.

This section discusses constraints in detail, starting with the constraints created 
specifically for control applets that exist on the .EDIT tab in Pageflex Studio.

Using Constraints on the .EDIT Tab
The screen shot below shows a .EDIT tab with sample data:

The .EDIT tab contains two sections: Configuration, which holds the UIClass 
field, and Constraints, which holds the Selection and Editing and Size and 
Position fields. We discuss the constraints section first.
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Selection and Editing

With Studio, you can select an element—a text container, image, area template, 
shape, or group—and specify whether users can select and edit these elements or 
not. The default is to allow selection and editing. You can also prevent selection 
and editing.

A red circle  with a diagonal bar appears in the document applet when users 
attempt to click on an element they have been prevented from selecting. 

Note: If you prevent changes to selection and editing, you automatically 
prevent changes to size and position as well.

Size and Position

In your template, you can select a text container, image, area template, shape, or 
group, and specify whether users can resize, position, copy, delete, or re-layer 
this element. Text, image source, fill, and border properties can still be changed. 
The default is to allow size and position changes. You can also prevent size and 
position changes.

A lock icon  appears in the document applet when users attempt to move an 
element for which you have prevented size and position changes.

Using Flex and Groups as Constraints
Flex behavior allows a container to expand, contract, and reposition itself and 
adjacent containers to accommodate variable content. In Pageflex Studio, you add 
flex by specifying how containers can expand and contract when variable content 
is added. See Chapter 7, “Adding Flex,” on page 177 for details about adding flex 
to your template.

A group is a collection of elements combined to function as a single element. See 
“Grouping Elements” on page 79 for details about grouping elements in your 
template.

Flex and groups can be used to constrain user options by restricting the layout 
changes that users can make. For example, the real estate postcard below is 
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organized with a horizontal group that includes the photo of the house, 
description, and agent name.

 

When the user chooses a photo of a different size, the layout automatically 
adjusts. The user cannot override the automatic layout. 

Using Variables as Constraints
.EDIT Technology prevents users from directly editing text that has been marked 
as variable. You can release this constraint and let users modify variable values by 
supplying controls in the control applet that let them type in new text or select 
new values from a list (this is an advanced function in Storefront Free Edit).

In Pageflex Studio, you can also define rules that specify how to compute the 
value of a variable based on the values of other variables. This derived variable 
lets you define subsets of content appropriate to various situations. For example, 
to present an image of the Eiffel Tower to a prospect for a trip to Paris and a 
picture of the Grand Canyon to a prospect for a trip to Arizona. See the samples 
that ship with Pageflex Studio for more information on derived variables.

Applications using .EDIT technology can also use the rules-based variables you 
set up in Studio. To do so, first define the rules for determining variable content 
in your Studio project by following instructions in Chapter 12, “Defining Content 
Variables,” on page 268. Next, specify a path to the project file relative to the 
Pageflex Server host with the projectFileforVariableEvaluation applet 
parameter. This parameter instructs the engine to load the project and evaluate 
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its rules. See the Pageflex Programming Reference Guide for more information about 
this parameter and an example of how to use it.

Designing Your Control Applet with Constraints
Another way to constrain the choices the user has within your document is by 
limiting the choices available in the design of the control applet. For example, 
you can expose the necessary controls in the control applet so that users can 
change everything about the fonts displayed in the document, such as paragraph 
style, font size, font name, and font style, or you can expose a limited group of 
paragraph styles for users to select. 

The comparison below illustrates this example.

In the control applet on the left, the user has many options to choose from when 
formatting text. In the control applet on the right, the user can choose only from 
a list of available paragraph styles.
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Associating Objects with Alternate Panels
In your control applet, you can specify different panels for editing objects, 
depending on the object selected. The uiClass name of the panel differentiates 
between generic panels used by the majority of objects the user selects, and 
alternate panels relevant to certain specific objects. For example, if you have two 
images in your template that users can replace with alternate images, you may 
want to create two separate image panels, one for each image. The uiClass field 
in the .EDIT tab in Pageflex Studio allows you to label each image so that when a 
user selects one of the images, the control applet will display the appropriate 
panel. See the next page for an illustration.

 To Create Alternate Panels

1 In your configuration file, create a panel that will function as the generic 
panel to be displayed when objects with no uiClass name are selected. This 
generic panel should specify the panelButton to use for the panel, if any.

2 Create the panel that will be displayed when an object with a specific uiClass 
is selected. This alternate panel should not have a panelButton.

3 Add a uiClass name as a panel attribute (the example below uses 
uiClass="photo"). You may repeat steps 2 and 3 multiple times to create 
multiple alternate panels. See the code below for an example:

<panel label="Images" name="imagespanel"  uiClass="photo">
<item class="image source choice" img="KitchenImages/germany_thumb.gif" 
 value="bigpic_germany.tif" label="Germany" bold="no"/>
<item class="image source choice" img="KitchenImages/hawaii_thumb.gif" 
 value="bigpic_hawaii.tif"  label="Hawaii" bold="no"/>
<item class="image source choice" img="KitchenImages/italy_thumb.gif" 
 value="bigpic_italy.tif"  label="Italy" bold="no"/>
</panel>

4 Open the template in Pageflex Studio and select the object or objects for 
which you want this panel to be displayed.

5 Select the appropriate uiClass from the .EDIT tab. Your configuration file 
must be in the “WebPages” subdirectory of the project directory in order for 
the uiClasses you created to be displayed in Pageflex Studio. 

6 Save your template.

Note: Panels with the uiClass attribute cannot get panel buttons.
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When a user selects a mountain sketch, the Images panel displays a list of line 
art images for the user to select from:

When the user selects the photograph image, the Images panel displays a list of 
photographs instead:

User selects mountain sketch
Images panel 
displays line art

Images panel 
displays photos

User selects 
photograph image
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Naming Elements
The Info tab includes a Name field to name an element.

Naming elements is useful if you want to use control applet actions to select 
document elements by name. For example, the setAttribute action uses the 
name field to set an attribute of a named shape. Named elements are also used in 
the selection attribute of choice buttons.

In the example below, one fill-color choice applies a green border around the 
outer_box element, while another applies an aqua border: 

 <row>
   <item class="fill color choice" img="PartyImages/GreenBorder.gif" 
    value="green" selection="outer_box" />
   <item class="fill color choice" img="PartyImages/AquaBorder.gif" 
    value="aqua" selection="outer_box" />
 </row>

See the Pageflex Programmer Reference Guide for details about these functions.

Note: Names must be unique within a document and must follow the syntax of 
XML names. For example, they must start with a letter and may not contain a 
space. See the XML specification on the World Wide Web Consortium website 
for more information about XML syntax.
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Viewing Template Information
When creating your control applet configuration file, you will need information 
about the fonts and colors used in your template, as well as other characteristics. 
You can view a list of useful information about your template by selecting 
Template Info in the File menu of Pageflex Studio.

This displays the Template Info dialog box, containing the information below:

 Fonts—the names of fonts used in the template.

 Styles—the names of styles used in the template.

 Colors—the names of the colors used in the template and whether colors 
are formatted as RGB or CMYK.

 Images—the file names of static images used in the template.

 Variables—the names of variables used in the template.

 Names—the names of any elements defined on the Info tab.

Click the copy icon to copy this information onto your clipboard. Click the save 
icon to save this information into a text file. Click Close to exit.
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Working with Text

This chapter explains how to:

 Apply character and paragraph properties to text within a text container

 Create paragraph and character styles to make formatting your template 
easier and more consistent

 Create and utilize formatted content for variable input

 Create and apply Copy Fit functions for fitting text within specified 
boundaries

 Modify Asian character settings

 Find and replace text

 Find and replace fonts

 Check spelling

 Insert special characters
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Formatting Text
Pageflex Studio gives you precise control over text with paragraph styles, 
paragraph properties, and character properties. 

 Character properties control the appearance, for example, font size, color, 
and kerning of a selection of text. 

 Paragraph properties control the appearance of paragraphs. They also 
provide default character properties for the paragraph. Paragraph properties 
control the spacing between the lines of a paragraph (leading) and between 
paragraphs (paragraph spacing).

 Paragraph Styles enable you to save customized paragraph properties and 
use them to format multiple paragraphs. Changes to a paragraph style are 
reproduced automatically in the paragraphs to which the style is applied.

Character Properties

Character properties apply to sections of type you select with the Text tool. To 
format an entire paragraph, use the Paragraph properties. You can apply most 
character properties using the Properties panel, but some are available only 
through the Character properties dialog box.

 To apply Character properties

1 Using the Text tool , select a range of text within a text container. 

2 Choose Text  Character or press F8. Pageflex Studio displays the 
Character Properties dialog box.
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3 Select properties, and then click OK to apply them.

Font Name

Choose a typeface from the list. The list contains all available fonts installed on 
your system.

Font Style

Choose a font style from the list. The list contains only the font styles available 
for the Font Name you have selected.

Underline

Choose Yes or No to underline the text.

Size

Type the size, measured in points, or choose a size from the list.
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Horizontal Scale

This box controls the horizontal scaling of the font. The value 100% leaves the 
width unadjusted. Values less than 100% reduce the width of each letter, and 
values greater than 100% increase the width of each letter. 

For example: 

Fill Color

Choose a color from the list to set the fill color for the text. To define a new color, 
choose New Color. See “Defining Colors” on page 86.

Tint

Choose or type a percentage to create a tint of the selected color. Tint values 
range from 0% to 100%.

Overprint

Choose Yes or No to enable or disable overprinting for the text fill. See 
“Overprint Border/Fill/Black Line” on page 100 for details about overprint.

Outline Attributes: Color

Usually when Studio draws text, each character is fully painted with a single 
color. Studio allows the interior of a character to be painted with a different color 
than its outline/border.

Usually when you enter characters into a text container, the outline for each 
glyph is filled with the current color. However, you can change the outline color 
in this field. Choose a color for the text outline. You can choose “none” (the 
default) to display the background through the outlines, but you cannot choose 
none for color and outline color. When you first change the outline color from 
“none”, the thickness will automatically be changed from 0 to 1.

Horizontal Scale Font Appearance

100% Pageflex Studio

80% Pageflex Studio

120% Pageflex Studio

150% Pageflex Studio
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Outline Attributes: Weight (or Thickness)

Choose a thickness for the text outline. The default is one if you choose a color. 
The maximum thickness is 10% of the point size of the text. If the point size is 
reduced, the thickness is automatically reduced to this maximum thickness, if 
necessary. If the thickness is changed to zero, the outline color changes to none. 
The style of text borders is always solid.

Outline Attributes: Tint

Choose or type a percentage to create a tint of the selected color for the text 
outline. Tint values range from 0% to 100%.

Outline Attributes: Overprint

Choose Yes or No to enable or disable overprinting for the text outline.

Language

Select a language to use for the spelling and hyphenation dictionaries. When you 
set up the project template, you select a default language to use. Use the 
Language property to override the default language.

 If you select Chinese - Simplified or Chinese - Traditional, you can also set 
Chinese character settings. See “Using Chinese Character Settings” on page 
149.

 If you select Japanese, you can also set Japanese character settings. See 
“Using Japanese Character Settings” on page 151.

Hyphenation

Under Hyphenation, choose whether to allow hyphenation or not. 

 Select No if you do not want to hyphenate the text.

 Select Yes, and then click the button beside the box to select hyphenation 
options.
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Choose or type values for the following:

Word Spacing

Under Word Spacing, you can set the amount of space between words. 

 Select Default to use standard word space between words. 

Box Name Description

Hyphenation Level Controls how aggressively Studio hyphenates a 
word. The default level is Medium. Choose 
High or Low to increase or decrease the 
amount of hyphenation.
The Hyphenation Level is relative. The width 
of the text container, the letter and word 
spacing, and the paragraph alignment all affect 
how Studio uses hyphenation.

Max Consecutive Lines Controls the maximum number of sequential 
lines in the same paragraph that can end with 
hyphens. For example, if you set this to 3, then 
the paragraph can have no more than 3 
hyphenated lines in a row.

Min Chars Before Break The least number of characters in a syllable 
immediately before the hyphen.
For example:

Min Chars After Break The least number of characters in a syllable 
immediately following a hyphen.

Minimum number be-
fore a break. 

Min. Before set 
to 2 characters

Min. Before set 
to 3 characters

Minimum number 
before a break. 

Minimum num-
ber after a break. 

Min. After set 
to 3 characters

Min. After set 
to 4 characters

Minimum 
number after a 
break. 
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 Select Custom, and then click the button beside the box to set the Word 
Spacing options.

Type values for each of the following:

The value for Default must be greater than or equal to Minimum and less 
than or equal to Maximum.

Letter Spacing

Under Letter Spacing, you can set the amount of space between characters.

 Select Default if you do not want to add any additional letter spacing.

Box Name Description

Default The Default is the preferred amount of word spacing 
expressed as a percentage of the standard width of the 
space character for the font.

Minimum The smallest amount of word spacing, expressed as a 
percentage of a standard space. Type a number between 
10% and 999%. For example, if you set this to 80%, 
Studio makes a line break and justifies by adjusting the 
word spacing between 80% of the normal width for the 
current font and the maximum width. It attempts line 
breaking first for full words and then performs 
hyphenation.

Maximum The largest amount of word spacing, expressed as a 
percentage of a standard space. Type a number between 
10% and 999%.
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 Select Custom, and then click the button beside the box to set Letter 
Spacing options.

Type values for each of the following.

 To add kerning space between two characters

Using the Text tool , click between any two characters.

 To increase the kerning space, press CTRL + SHIFT + PLUS SIGN (+) ON THE 
NUMERIC KEYPAD

 To decrease the space, press CTRL + SHIFT + MINUS SIGN (–) ON THE 
NUMERIC KEYPAD

Note: You must press the PLUS SIGN(+) and MINUS SIGN(-) keys on the 
numeric keypad to use the shortcut keys to increase or decrease kerning.

To remove kerning space, see “Removing All Style Properties” on page 148.

Kerning Pairs

Under Kerning Pairs, choose whether Studio should use the kerning pair 
information for the selected font. The amount of kerning pair information varies 
from font to font. 

 Choose Yes to use the kerning information defined in the selected font.

 Choose No to prevent using the pre-defined kerning pair information.

Box Name Description

Default The preferred space between letters expressed as a 
percentage of a standard space.

Minimum If Studio cannot use the Default spacing, the minimum is 
the smallest amount of letter space it can use. 

Maximum If Studio cannot use the Default spacing, the maximum is 
the largest amount of letter space it can use.
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Super/Subscript

Under Super/Subscript, you can set the options for creating superscript or 
subscript characters.

 Select Normal to remove any existing superscript or subscript options.

 Select Subscript or Superscript, and then click the button beside the box to 
set options for your selection.

Type values for each of the following, and click OK.

Tracking

Choose or type a positive or negative value to adjust the amount of space after 
each character. Values are measured in thousandths of an em. An em is a 
horizontal unit defined by the current font. It is called an em because its width is 
typically the width of the letter ‘m’.

Baseline Shift

Under Baseline Shift, you can adjust the amount of offset from the baseline. The 
amount of baseline shift is measured in points. Enter a positive number to offset 
the characters above the baseline. Enter a negative number to offset below.

Box Name Description

Size Enter the size of the subscript or superscript characters 
as a percentage of the font size.

Position Enter the amount of offset from the baseline as a 
percentage of the font size, for subscript, enter a negative 
number to lower the characters. For superscript, enter a 
positive number to raise the characters.
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Use Ligatures

Ligatures are replacement characters for the letter pairs “fi” and “fl.” Studio can 
automatically insert ligatures in place of these character combinations if the font 
you are using has ligatures. 

 Choose Yes, and Studio automatically adds any ligatures defined for the font 
you selected. If the font does not have any ligatures defined in its character 
set, this setting has no effect.

 Choose No, and Studio does not add any ligatures.

Case

You can specify case as a character or paragraph formatting option. Choose 
between the following options:

 Normal, for upper and lower case.

 Small caps, for small caps. If you choose small caps, you have the option of 
choosing the size of the small caps, as a percentage of the capital letters. The 
default is 70%. Click the button beside the box to choose your size option.

 Upper, to change all text to upper case.

 Upper (no accents), to change all text to upper case, with no accented 
characters.

Allow Breaks

This is a Yes/No attribute. Choose No for a range of text that should not break 
apart across line breaks in a paragraph. You can use this attribute instead of using 
the special non-breaking characters (non-breaking hyphen and non-breaking 
space). See “Inserting Special Characters” on page 175.

For example, to have the digits of a telephone number, such as (617) 555-1212 
stay together in a paragraph, set this attribute to No. 

Note: This option is available only from the Character Properties dialog box. 
You cannot include this option as part of a paragraph property or style.

Paragraph Properties
Paragraph properties control the appearance of paragraphs. Paragraph properties 
control how the text is aligned, and how the paragraph breaks across a page or 
column break. You can set paragraph rules above and below the paragraph. 
Paragraph properties provide default Character properties along with additional 
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formatting properties to control the spacing between the lines of the paragraph 
and between paragraphs. 

If you are formatting an entire paragraph, set the default Character properties on 
the Paragraph Properties dialog box. Use the Character Properties dialog box 
to override the default Character properties for the paragraph. For example, if 
you want a section of text within a paragraph to appear in italics, use the 
Character Properties dialog box to override the default properties of the 
paragraph.

You can also access specific paragraph propeties from the Text menu, for 
example, click Alignment to open the Paragraph Properties Format tab.

 To create line breaks

Line breaks force text to flow to the next line without beginning a new 
paragraph.

 Choose Text  Insert  Line Break

-or-

 Press SHIFT + ENTER

 To apply Paragraph properties

1 Using the Text tool , click anywhere within a paragraph. To format more 
than one paragraph at a time, drag the text tool across several paragraphs.

Use Character properties to 
override the default 
properties for the text

Use Paragraph properties to 
format the paragraph text
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2 Choose Text  Paragraph or press F9 to display the Paragraph Properties 
dialog box.

3  Format the paragraph using the properties on each of the three tabs.

 Character Defaults. This tab contains properties for setting the default 
properties for the appearance of the paragraph text. All the properties 
from the Character Properties dialog box are available except Allow 
Breaks. See “Character Properties” on page 124 for more information.

 Format. This tab contains properties to control the format of the 
paragraph. The properties on this tab include alignment, leading, 
paragraph spacing, composition method, and orphan control. See 
“Paragraph Format Properties” on page 135 for more information.

 Tabs/Indents. This tab contains properties for setting tabs and for 
indenting paragraphs. See “Paragraph Tabs and Indents” on page 139 for 
more information.

 Rules. On this tab, you can set up paragraph rules. Paragraph rules can 
appear before or after the paragraph using the line width, margins, and 
offset you specify. See “Paragraph Rules” on page 142.
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4 Click OK when you are finished. 

Click Reset All to restore the settings in the dialog box to their original 
values.

Paragraph Format Properties
On the Paragraph Properties dialog box, click the Format tab or click 
Text  Alignment or Leading to view the Paragraph Format properties.

Composition

The composition method determines the best possible line breaks using the 
settings for hyphenation, word spacing, and letter spacing. Studio has two 
composition methods: single-line and multi-line. Multi-line composition has a 
high and low setting. 

 Single-line. This method examines one line at a time. This is the simplest 
composition method. 

 Multi-line (low). This method examines several lines at a time to decide 
how to break each line of text. It measures the amount of space across several 
lines of a paragraph and adjusts the characters on each line to make the best 
possible fit.
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 Multi-line (high). This method examines more lines at a time than the low 
setting. This is the most complex composition method, and using this 
method produces the most pleasing breaks.

Multi-line composition produces more even spacing and better line breaks than 
single-line. However, producing the final output for a job with multi-line 
composition is slower.

Alignment

Selects the horizontal alignment of text in the paragraph: Left, Center, Right, 
Justify, or Force Justify. Force Justify adjusts the spaces between words in each 
line so that all lines are justified to both margins.

Leading

Use the Leading property to set the amount of space between the lines of the 
paragraph. Use the three boxes to specify the leading.

 In the first box, choose Exactly or At Least. 

Choose Exactly for absolute leading. No matter what height the characters 
or inline elements are, the leading remains constant.

Choose At Least to set a minimum leading amount. Studio adjusts the 
leading on each line of the paragraph to accommodate the largest character 
or inline element on the line. The benefit is that the lines do not run into 
each other, but the leading may be inconsistent from line to line so that some 
lines have more space between them than others.

 In the second box, enter the leading value as a number. 

 In the third box, select whether the leading value you entered is measured in 
points (pts.) or as a percentage of the font size (%). If you use a percentage, 
then the leading changes if you change the font size. 

Note: If you choose At Least with a percentage, the minimum is 100%. 
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This example shows the difference in a paragraph with 12-point leading and one 
with 24-point leading:

Min Lines Before Break

This property specifies how many lines of a paragraph Pageflex Studio can leave 
before a page or column break. Studio must leave at least this number of lines 
before the break or move the entire paragraph after the break.

Min Lines After Break

This property specifies how many lines of a paragraph Studio can leave after a 
page or column break. Studio must leave at least this many lines after a page 
break or move the entire paragraph after the break.

Keep Lines Together

Selecting this property keeps the lines of a paragraph together across any page 
breaks or column breaks. If you click Keep Lines Together, you can also click 
Keep With Next. This additional property treats the current paragraph and the 
next paragraph as a single unit, preventing them from being separated across a 
page or column break.

Space Before and Space After

These two properties specify the amount of space before and after the paragraph. 
Enter the amount of space in points.

Each paragraph is indicated by the end-of-paragraph symbol (¶), a hidden 
character. To view the hidden characters, choose View  Hidden Characters or 
CTRL + I.
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Copy Fit Down To

This property allows Studio to reduce the size of the text to fit the text container. 
The value you provide in the Copy Fit down to box is the minimum size Studio 
can use to fit the text. The maximum size is the font size listed in the Size box on 
the Character Defaults tab. 

If you specify leading as a percentage of the font size, the leading changes when 
the font size changes. 

This attribute applies only to a paragraph. You can have more control over copy 
fitting by using Copy Fit rules. See “Using Copy Fit Rules” on page 163.

Note: Using this property overrides any Copy Fit rules applied to the text 
container. 

Drop Caps

This property creates an automatic drop cap at the beginning of the paragraph. 

 Chars. Specifies the number of characters that form the drop cap

 Lines. Specifies the number of paragraph lines it drops into. This controls 
the size of the drop cap.

Drop Cap set for 
one character to 
drop three lines.
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Paragraph Tabs and Indents

On the Paragraph Properties dialog box, click the Tabs/Indents tab or click 

Text  Tabs/Indents to set paragraph tabs and indents.

Tabs

Use tabs to align text in paragraphs. On the Tabs/Indents tab, create a list of the 
paragraph tabs. You can edit the list at any time. Studio measures tabs using the 
default unit of measure on the Preferences dialog box. See “Setting Preferences” 
on page 33.

The location of a tab is always relative to the left margin of the text container, not 
the edge of the page. If the text container has its own margins set with the 
Margins property, the tabs are still measured relative to the edge of the container. 
For example, if you have a left margin for the text container set to 0.25", set the 
tab at 0.25" or greater.

Note that tabs in Studio behave differently in some respects from tabs in other 
text formatting applications. In Studio, the nth tab character on a line is always 
associated with the nth defined tab stop, even if the text preceding the tab 
character has passed that tab stop.

For example, assume you set tab stops for a paragraph at 0.5 inches and 1.0 
inches, and type text without tab characters so that the cursor is at 0.7 inches. If 
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you now type a tab character you might expect the cursor to jump to 1.0 inches, 
but it does not. Since this is the first tab character on the line it is associated with 
the first tab stop at 0.5 inches. Since you are past that point, no advance occurs. If 
you now type a second tab character, the cursor will jump to 1.0 inches since this 
second tab character is associated with the second tab stop.  

Tabs in Studio need to behave this way because of their use in variable-length 
documents.  Studio tabs line up variable data in columns. If a slightly-too-long 
text variable caused the corresponding text to land in the wrong column, you 
could commit unintentional blunders like moving an item from the profit column 
to the loss column on a financial statement.  

 To set tabs

1 Under Tabs, enter the location of the tab.

2 Choose a tab alignment: Left, Right, or Center.

 Left. Aligns text flush to the left side of the tab location.

 Right. Aligns text flush right to the right side of the tab locations.

 Center. Centers the text at the tab location.

3 To add tab leaders, under Leaders click On, and then click Options. 
Tab leaders fill the space between the text and the next tab stop.

Enter information into each of the following:

 Font. Select a font for the leader from the list.

 String. Type a character or series of characters to use for the leader. For 
example, type a period to add a dot leader. Studio repeats the string as 
many times as necessary to complete the tab leader.
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 Force Align. Clicking this option keeps the characters in the tab leader 
in alignment with each other from paragraph to paragraph. For example, 
if you specify Force Align with a period (.) as a dot leader, all the periods 
line up vertically on the page.

4 Click Set to add the tab to the list. The dialog box remains open so that you 
can continue setting tabs. Your other options are as follows:

 Delete. To remove a tab, select it in the list and click Delete.

 Reset. To undo any changes to tabs that you have made since you opened 
the Paragraph Properties dialog box, click Reset. 

 Clear All. To clear all the tabs from the list, click Clear All.

5 Studio presets tabs at an interval you specify in the Preset Tab Interval text 
box. The default preset tab interval is .5 inches, 1.27 centimeters, or 36 
points, depending on your preferences. Enter a new preset tab interval in the 
text box to change this value.

6 Click OK to close the dialog box. Studio applies the tab settings to the 
paragraph.

Indents

Paragraph Indents are like margins for paragraphs. These settings are 
independent of the Margins property for the text container. However, the net 
result of using text container Margins and Paragraph Indents is cumulative.

Note: Although you can enter negative numbers for Paragraph Indents to create 
a hanging indent, you cannot enter a number which would move any lines of the 
paragraph outside the bounding Text container.

 First Line. Controls the indent for the first line of the paragraph relative to 
the value you enter for Left Side. Enter a negative number to outdent the first 
line.

 Left Side. Controls the indent from the left side of the paragraph.

Set the Font and the String for the tab leader
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 Right Side. Controls the indent from the right side of the paragraph.

Paragraph Rules
Paragraph rules are lines above or below a paragraph. Unlike lines drawn with 
the Line tool, paragraph rules move with the text of the paragraph. If a text 
container flexes its size for variable content, the paragraph rule can flex with the 
width of the container.

 To create paragraph rules

1 Using the Text tool , click anywhere within a paragraph. To format more 
than one paragraph at a time, drag the text tool across several paragraphs.

2 Choose Text  Rules. Studio displays the Paragraph Properties 
dialog box. 

Right 
indent

First line indent

Left indent
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3 Select the Rule Above Paragraph box, the Rule Below Paragraph box, or 
both.

4 Below the check boxes, you can set up the specifications for the rules.

5 Click OK to close the dialog box.

Box Name Description

Thickness The thickness of the rule. Thickness is always 
measured in points.

Offset For Rule Above a Paragraph, the Offset is the 
distance from the bottom of the rule to the top of the 
text.
For Rule Below a Paragraph, the Offset is the 
distance from the top of the rule to the bottom of the 
text.

Left Indent The distance from the left edge of the text container 
to the left edge of the rule.

Right Indent The distance from the right edge of the text container 
to the right edge of the rule.

Color Select a color for the rule. Choose a color from the 
list, or click New to create a new color. 

Tint Choose or type a percentage between 0% and 100% 
to create a tint of the selected color. 

Overprint Select the check box to apply overprinting for black 
paragraph rules.

Rule Above

Rule Below Right 
Indent

Offset
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Paragraph Styles
Paragraph styles allow you to format sections of text quickly and consistently. 
Editing a paragraph style automatically updates every paragraph that uses that 
style to match the new formatting characteristics.

Styles, like elements in a template, can have parent-child relationships. You can 
base a new style on an existing style to create this relationship. The style on 
which you base the new style becomes the parent, and the new style becomes the 
child. Any characteristics you change in the parent style affect the child style as 
long as the child does not specifically override the change.

For example, the parent style uses a font size of 14 points, and the child style also 
uses 14 points. When you change the parent style to 18 points, the child style 
also changes to 18 points. 

However, if the parent style uses a font size of 14 points, and the child style uses 
10 points, then changing the parent style to 18 points does not change the child 
style.

Applying character and paragraph properties through the Character and 
Paragraph menu options or the Properties panel overrides the style information. 
Studio indicates when a style has overrides by displaying a plus sign (+) next to 
the Style property in the Properties panel.

Changing a style definition or changing to a different style does not affect the 
overrides. For example, a paragraph has the style BodyText applied to it. If you 
apply bold to a specific word in the paragraph, the paragraph now contains a style 
override. If you change the definition of BodyText, the bold override remains.

 To view the template style sheet

Choose Text  Define Styles. Pageflex Studio displays the Define Styles dialog 
box.

Plus sign (+) indicates 
the style has overrides
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 The Styles box displays the names and relationships of all desired styles. All 
styles are children of the Normal style, the default style. You can edit the 
Normal style, but you can never delete it.

 Under Sample, a block of sample text appears using the style information.

 Under Description, the list of style properties appears. If a style is based on 
another style, the Description lists the base style followed by the attributes 
that are different from the base.

 To create a new style

1 On the Define Styles dialog box, click New

-or-

Parent style

Child styles 
to the parent 
“Body Text”

Parent style name
and unique attributes
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Choose Text  Paragraph Style  New. Studio displays the New 
Paragraph Style dialog box.

2 Enter the following information:

 Name. Type a name for the new style. You cannot use spaces in style 
names. Names cannot begin with numbers or punctuation, including the 
underscore character ( _ ).

 Based On. If you want the style definition to be based on an existing 
style, select the loose style in the list. The style you select becomes the 
parent style, and the new style is the child style to that parent. 

Select Normal if the style is not based on another style you have defined.

3 Click OK. Studio displays the Paragraph Style Properties dialog box. The 
options in the dialog box are identical to the options in the Paragraph 
Properties dialog box. For information about Paragraph Properties, see 
“Paragraph Format Properties” on page 135.

4 Set the Character Defaults, Formats, Indents/Tabs, and Rules for the new 
style. 

5 Click OK to save the new style.

 To edit an existing style

1 Choose Text  Define Styles to display the Define Styles dialog box.
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2 In the Define Styles dialog box, select a style in the list, and then click Edit. 
Studio displays the Edit Paragraph Style dialog box.

3 You can edit the style name in the Name box, but you cannot change the 
name of the parent style in the Based On box. If you change the style name, 
Studio updates the style name for any paragraphs you have already tagged 
with the old style name.

4 Click Properties to edit the Character and Paragraph properties for the style. 
For information on these properties, see “Paragraph Format Properties” on 
page 135.

 Click Reset All to undo any changes you have made since you opened 
the dialog box. Studio reverts all properties back to their original state 
before you began editing them.

 Click OK to accept the changes and close the dialog box.

 To delete a style

On the Define Styles dialog box, click the style name, and then click Delete. 

Note: Deleting a parent style deletes all child styles. If you attempt to delete a 
parent style, Studio displays the following warning message:
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You have the option to delete the style names and still preserve the styled 
appearance of the text.

 Click Yes to delete the style names, but leave the text formatted according to 
the style properties.

 Click No to delete the style names. The Paragraph properties revert to the 
properties for the next parent style in the list of styles. The Normal style is 
always the ultimate parent style.

 Click Cancel to cancel the action.

 To apply a style

1 Using the Text tool , select a paragraph in a Text container.

2 On the Text  Paragraph Style menu, choose a style name from the list.

-or-

On the Properties panel, under Style, choose a style name from the list. 

Removing All Style Properties

Character and paragraph properties are overrides to the underlying paragraph 
style information. Changing the style definition has no effect on any character or 
paragraph overrides you have added. Removing the formatting from a section of 
text removes all character, paragraph, and style information and returns the 
selection to the Normal style.

 To remove all formatting information

1 Using the Text tool , select the paragraph.

2 Choose Text  Paragraph Style  No Style.

Studio reapplies the Normal style to the selection and removes any additional 
formatting instructions.
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Asian Character Settings

Using Chinese Character Settings
If you specify Chinese, either Simplified or Traditional, as the language for a 
paragraph, you can set the additional formatting options unique to this choice.

 To set Chinese character settings

1 Open the Character Properties dialog box

-or-

Open the Character Defaults tab on the Paragraph Properties dialog box.

2 Select Chinese - Simplified or Chinese - Traditional in the Language box. 
Studio displays the Chinese Character Settings button.

3 Click Chinese Character Settings. Studio displays the Chinese Character 
Settings dialog box.
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4 On the General tab, you can enter the following information.

 Character Spacing. In the three boxes, enter the range of spacing to use 
between characters. 

 Chinese/Roman Boundary Space. Enter the desired range of space for 
Studio to use when using Roman characters mixed with the Chinese 
characters. Roman characters are the characters used by Latin-based 
languages such as English.

The values for Default, Minimum, and Maximum create a range of spacing 
used to justify the characters on a line. The values are expressed as 
percentages of the normal spacing for the font and font size selected.

 Default. The Default value is the desired amount of space. This is the 
amount of space Studio first tries to use.

 Minimum. This is the smallest amount of space Studio can add between 
two characters to fit the text on a line.

 Maximum. This is the largest amount of space Studio can add. 

5 In the Roman Language box, select the language to use when mixing 
Roman characters or words in the Chinese text. This setting provides the 
spelling and hyphenation dictionaries for the Roman words.

6 In the Roman Line Breaks box, choose how to break roman words across 
lines of text. Choose one of the following:

 Hyphenate. Studio uses the hyphenation dictionary for the language 
specified in the Roman Language box to hyphenate words as needed. To 
set the Hyphenation options, click the button beside the box. For 
information on hyphenation, see “Hyphenation” on page 127.

 Do Not Hyphenate. Studio does not hyphenate any Roman words.

 Break Anywhere. Studio adds line breaks between words as needed to 
justify the text in the paragraph. 

 Do Not Break. Studio does not allow line breaks between the Roman 
words in a paragraph. 

7 Click the Condense Punctuation check box to reduce the spacing around 
Chinese punctuation. 
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8 Click the Advanced tab to set the Line Breaking Constraints. These settings 
control which characters can begin and end lines of text and which characters 
must always appear together. 

Click Reset Default Settings at any time to restore the default characters. 

9 When you are finished, click OK to close the Chinese Character Settings 
dialog box. 

Using Japanese Character Settings
If you specify Japanese as the language for a paragraph, you can set the additional 
formatting options unique to the Japanese language choice.

 To set Japanese character settings

1 Open the Character Properties dialog box

-or-

Open the Character Defaults tab on the Paragraph Properties dialog box.
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2 Select Japanese in the Language box. Studio displays the Japanese 
Character Settings button.

3 Click Japanese Character Settings. Studio displays the Japanese Character 
Settings dialog box.

4 On the General tab, you can enter the following information. 

 Kanji Character Spacing. Enter the desired spacing for Kanji characters. 

 Kana Character Spacing. Enter the desired spacing for Kana characters. 

 Roman/Japanese Boundary Space. Enter the desired amount of space 
for Studio to use when using Roman characters mixed with the Japanese 
characters. Roman characters are the characters used by Latin-based 
languages such as English.

The values for Default, Minimum, and Maximum create a range of spacing 
used to justify the characters on a line. The values are expressed as 
percentages of the normal spacing for the font and font size selected.

 Default. The Default value is the desired amount of space. This is the 
amount of space Studio first tries to use.
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 Minimum. This is the smallest amount of space Studio can add between 
two characters to fit the text on a line.

 Maximum. This is the largest amount of space Studio can add. 

5 In the Roman Language box, select the language to use when mixing 
Roman characters or words in the Japanese text. This setting provides the 
spelling and hyphenation dictionaries for the Roman words.

6 In the Roman Line Breaks box, choose how to break roman words across 
lines of text. Choose one of the following.

 Hyphenate. Studio uses the hyphenation dictionary for the language 
specified in the Roman Language box to hyphenate words as needed. To 
set the Hyphenation options, click the button beside the box. For 
information on hyphenation, see “Hyphenation” on page 127.

 Do Not Hyphenate. Studio does not hyphenate any Roman words.

 Break Anywhere. Studio adds line breaks between words as needed to 
justify the text in the paragraph. 

 Do Not Break. Studio does not allow line breaks between the Roman 
words in a paragraph. 

7 Click the Condense Japanese Punctuation check box to reduce the spacing 
around Japanese punctuation.  
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8 Click the Advanced tab to set the Kinsoku settings. The Kinsoku settings 
control which characters can begin and end lines of text and which characters 
must always appear together. 

9 When you are finished, click OK to close the Japanese Character Settings 
dialog box.  
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Formatted Content
Besides using Pageflex Studio to create templates, you can also use it to create 
formatted content to reuse in multiple templates, or to use as the contents of a 
variable element.

Formatted content is a powerful feature for variable publishing. Formatted 
content greatly increases the amount of variability you can add to your projects. 
Formatted content can be as simple as adding names using a particular font, or as 
complex as adding entire sections of content. 

Besides creating templates, Pageflex Studio lets you create formatted content to 
use with your projects. You can create the following formatted content files:

 Formatted Text. A section of text that belongs within a paragraph but does 
not form a paragraph by itself. Formatted text contains character formatting 
information. It can be a single character or many sentences, and may contain 
nested elements, such as images or area templates.

 Formatted Paragraphs. A section of text that contains at least one whole 
paragraph. Formatted text contains paragraph formatting information, and 
may also contain additional character formatting, as well as nested elements, 
such as images or area templates.

 Area Templates. A section of a template that can contain any number of 
elements including text boxes, images, shapes, or even other area templates. 
Area Templates are always created within an Area Template box container. 

The exported file contains the elements you exported along with any formatting 
tags for those elements. For formatted text, the exported file includes the specific 
character formatting applied to the text, for example, font name and style.

For formatted paragraphs and area templates, the exported files contain 
paragraph and character formatting, but not paragraph style sheet information. 
For example, if you create a formatted paragraph file, and the paragraphs use a 
style called BodyText, the exported file contains the style name, but none of the 
properties of that style, such as the fonts you used, the point size, or any other 
formatting information.

When you use formatted paragraphs and area templates, you must make sure any 
paragraph styles defined in the formatted content files are also defined in the 
template you are using. Studio formats the formatted content based on the style 
sheet of the template in which you are reusing the content.
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Note: Formatted content can contain variables. There is no limit in the level of 
nesting.

Formatted Text
Using formatted text allows you to save pieces of text with character formatting 
attributes applied. When you insert the formatted text into another paragraph in 
the same template or a different one, the formatted text maintains the character 
attributes you have applied.

You can insert formatted text into a template as static content, or you can use it 
as a variable.

 To create formatted text

1 Using the Text tool , select the text you have formatted. Do not include 
the paragraph symbol in your selection. To see the paragraph symbol, 
choose View  Hidden Characters.

2 Choose File  Export  Selection. Pageflex Studio displays the Export 
Formatted Text dialog box.

3 Select options for saving the file. 

 Locate a folder for saving the new file.

 In the Save as type box, be sure the Formatted Text Files (.xft) option is 
selected.

 Under File name, type a file name.
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4 Click Save. Studio saves the formatted text with the extension .xft.

 To insert formatted text into a text container

1 Using the Text tool , click inside a text container.

2 Choose File  Insert Content. Studio displays the Open Content File 
dialog box.

3 In the Files of type box, select Formatted Text files (.xft).

4 Locate the formatted text file, and click Open. Studio inserts the text at the 
text insertion point.

 To insert formatted text into a new text box

1 Click the Selection tool , and then choose File  Insert Content. Studio 
displays the Open Content File dialog box.

2 In the Files of type box, select Formatted Text Files (.xft).

3 Locate the formatted text file, and click Open. 

The Selection tool cursor changes to a text placement icon. 

4 In the Document window, click to place a new text box containing the 
formatted text.  The formatted text is contained in a paragraph that uses the 
Normal style.
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Formatted Paragraphs
Using formatted paragraphs allows you to add multiple styled paragraphs to your 
template either as static content or as a variable. Formatted paragraphs retain the 
paragraph styles you defined for them, as well as any character attributes you 
applied. However, the paragraph styles identified in the formatted paragraphs 
must exist in any template you import them into.

Using Pageflex Studio, you can create formatted text paragraphs to use as 
variables for your project. See “Formatted Paragraph Variables” on page 257.

 To create formatted paragraphs

1 Using the Text tool , select the paragraphs you have formatted. You must 
select at least one paragraph symbol. To see the paragraph symbol, choose 
View  Hidden Characters.

2 Choose File  Export  Selection. Pageflex Studio displays the Export 
Formatted Paragraphs dialog box.

3 Select options for saving the file.

 Locate a folder for saving the formatted paragraphs. 

 In the File name box, type the file name. 

 Under Save as type, select the Formatted Paragraph Files (.xfp) option.

4 Click Save to save the formatted paragraph file with the extension .xfp.
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 To insert formatted paragraphs into a text container

Note: The paragraph style names in the formatted text must exist in the 
template before you insert the file. Studio offers the option to convert any 
missing styles to the Normal style in the destination document.

1 Using the Text tool , click inside a text container.

2 Choose File  Insert Content. Pageflex Studio displays the Insert Text 
File dialog box.

3 In the Files of type box, select Formatted Paragraph files (.xfp).

4 Locate the formatted paragraph file, and click Open.

Studio inserts the text at the text insertion point.

 To insert formatted paragraphs into a new text box

1 Click the Selection tool , and then choose File  Insert Content. Studio 
displays the Open Content File dialog box.

2 In the Files of type box, select the formatted paragraphs option.

3 Locate the formatted paragraph file, and click Open. 

The Selection tool changes to a text placement icon. 

4 In the Document window, click to place a new text box with the formatted 
paragraphs.
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Area Templates
With area templates, you can save sections of your template to reuse in other 
templates or to use as variables. Area templates are defined by the boundaries of 
an area template container. They can contain any combination of elements 
including text boxes, images, shapes, and groups.

You can create area templates to use as variable elements. Each variable area 
template can also contain other variable elements such as formatted text and 
formatted paragraphs. See “Area Template Variables” on page 257 for information 
about using area templates as variables.

 To create an area template

1 Using one of the Area Template tools, draw an area template container.

If you draw the area template container on top of other elements, Pageflex 
Studio selects the other elements and asks if you want to include them inside 
the area template. Click Yes to have Studio add the elements under the area 
template element in the Layout tab.

2 Using the other drawing tools, you can add more elements to the area 
template by drawing them inside the boundaries of the area template 
container.

In the Layout tab, Pageflex Studio shows the new elements within the area 
template.

3 Apply any necessary attributes to the elements.

 Use the Properties panel to change any of the element containers. 

 For text, apply paragraph styles and character attributes.

 Apply any variables.

Note: Studio does not save the properties of an area template on export. 
Studio only exports the contents of an area template. For example, the fill 
color, border properties, and rotation of an area template are some examples 
of the container properties that will be lost on export.

4 Using the Selection tool , select the area template container.
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5 Choose File  Export  Selection. Studio displays the Export Area 
Template dialog box.

6 Select options for saving the file.

 Locate a folder for saving the area template. 

 In the File name box, type the file name. 

 Under Save as type, the only option is to save as an 
Area Template File (.xat).

7 Click Save to save the file with the extension .xat.

 To insert an area template

If the area template contains any text with paragraph style names, the style 
names must exist in the template before you insert the file. Pageflex Studio offers 
the option to convert any missing styles to the Normal style in the destination 
document.
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1 Choose File  Insert Content. Studio displays the Open Content File 
dialog box.

2 In the Files of Type box, select Area Template files (*.xat). Studio displays 
only area template files in the list. 

3 Locate the area template, and then click Open. 

The cursor changes to an area template placement icon. 

4 In the Document window, click to place the area template. 

You can edit the elements in the area template if necessary. 
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Using Copy Fit Rules
Pageflex Studio lets you define Copy Fit rules for fitting text into a text container. 
A Copy Fit rule is a set of instructions that defines which attributes Studio 
should reduce and in what order Studio should apply them. A Copy Fit rule 
applies to a container, which means it applies to all the text inside the container. 
The text container can be any shape. You can choose to have containers with the 
same copy fit rule applied independently or synchronously so typographic 
integrity is preserved between two containers.

Note: Copy Fit rules can apply to any text container in a chain, however, Studio 
ignores Copy Fit rules in autochain containers.

The goal of a Copy Fit rule is to reduce certain text attributes until the text just 
fits into the text container, avoiding a text overflow. The values you specify for 
each attribute in a Copy Fit rule provide a lower limit to the amount of reduction 
Studio can make. You can control the text attributes you want Studio to adjust to 
make the fit.

There are two kinds of Copy Fit rules:

 Simple Rules. Studio adjusts all the text attributes in the rule 
simultaneously until the text fits into its container.

 Advanced Rules. Studio adjusts text attributes one at a time in the order 
they are listed in the rule. The Copy Fit process stops as soon as the text fits 
into its container. 

Understanding Copy Fit Attributes and Units
Copy Fit rules change the appearance of the text based on the attributes you have 
already applied through paragraph styles, paragraph properties, or character 
properties. You can use the following attributes in a Copy Fit rule.

Font Size

Use either points (pt.) or a percentage (%) of the original font size. The original 
font size is always specified in points. 

If you specify a font size in the Copy Fit rule, Studio reduces the point size of all 
the text in the container until it reaches the value. Text that began as different 
font sizes may end up at the same size as a result of the Copy Fit rule. If the 
original text is smaller than the value in the Copy Fit rule, there is no change.
Working with Text  163



Pageflex Persona Cross Media Suite User Guide
If you specify a percent in the Copy Fit rule, Studio reduces the point size of all 
the text in the container by the same percentage until the text fits or until it 
reaches the limit you set. 

You can control font size through a simple or advanced Copy Fit rule. You can 
enter font sizes values from 0.1 point to 720 points or relative values from 0% to 
100% of the font size. 

Leading

Use either points (pt.) or a percentage (%) of the original font size. When you 
specify leading for a paragraph (in the paragraph properties or the paragraph 
style definition), you can specify it either as a fixed size or as a minimum size. In 
addition, you can specify the leading in points or as a percentage of the font size. 

The leading attribute of a Copy Fit rule can also be defined as either a fixed size 
(pt.) or a percentage of the font size (%) to achieve different Copy Fit results. 

You can control leading along with font size and paragraph spacing in a simple 
Copy Fit rule. You can control it separately through an advanced Copy Fit rule. 
You can enter a fixed size from 0.1 points to 1080 points or a percentage from 
50% to 200%. 

Horizontal Scale

Specify this attribute as a percentage of the original horizontal scale. In a Copy 
Fit rule, Studio applies horizontal scaling on top of any existing horizontal 
scaling attributes. For example, if the original character attribute (before 
applying the Copy Fit rule) has horizontal spacing at 100%, and the Copy Fit rule 
specifies 90%, then the horizontal scale can be reduced to 90% of 100%, which is 
90%. 

However, if the character attribute is 90%, and the Copy Fit rule is 90%, then the 
Copy Fit rule means the horizontal scale can reduce to 90% of 90%, which is 81% 
in total. 

You can control horizontal scale through a simple or advanced Copy Fit rule. 
Enter a value from 0 to 100%. 

Space Before

Use either points (pt.) or a percentage (%) of the original space before attribute. 
Studio reduces the amount of space before each paragraph until it reaches the 
measurement you specify. If the original value is less than the value you use in 
the Copy Fit rule, there is no change to the text. 
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You can control this attribute along with leading and the space after attribute as 
part of a simple Copy Fit rule. You can control this attribute separately through 
an advanced Copy Fit rule. Enter values from 0 to 1080 points or relative values 
from 0% to 100%. 

Space After

Use either points (pt.) or a percentage (%) of the original space after attribute. 
Studio reduces the amount of space after each paragraph until it reaches the 
measurement you specify. If the original value is less than the value you use in 
the Copy Fit rule, there is no change to the text. 

You can control this attribute along with leading and the space before attribute as 
part of a simple Copy Fit rule. You can control this attribute separately through 
an advanced Copy Fit rule. Enter values from 0 to 1080 points or relative values 
from 0 to 100%.

Tracking

Tracking is always measured in thousandths of an em. Negative numbers 
decrease the amount of space after a character and positive numbers increase it.

In a Copy Fit rule, Studio applies this attribute to reduce the amount of the 
original tracking value that you specified in the character, paragraph, or 
paragraph style properties. If the original tracking value is lower than the 
tracking value in the Copy Fit rule, the text does not change.

You can control tracking through a simple or advanced Copy Fit rule. You can 
enter values from -0.25 em to 10 em. 
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Viewing Copy Fit Rules
You can add, edit, delete, and apply the Copy Fit rules for a template from the 
Copy Fit dialog box. 

 To view Copy Fit rules

1 Choose Element  Copy Fit

-or-

With a text container selected, click the Flex tab on the Properties panel. 
Under Copy Fit, click the button in the Rule attribute. 

2 Select a rule from the Rules list to view its description. 

3 You can do any of the following:

 Click New to define a new Copy Fit rule.

 Click Edit to edit the selected Copy Fit rule. You can change any part of 
the definition. 

 Click Copy to duplicate the selected Copy Fit rule.

 Click Delete to delete the rule. Studio also removes the Copy Fit rule 
from any containers in the template that use it. 

4 Click the Apply button to apply the rule to the currently selected text 
container. This button is unavailable if you have not selected a text container.

5 Click Close when you are finished viewing Copy Fit rules. 
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Defining a Copy Fit Rule

 To define a Copy Fit rule

1 Click New on the Copy Fit dialog box.

2 In the Name box, type a name for the rule. Names must begin with a letter, 
and they cannot contain spaces.

3 Next to Type, choose Simple or Advanced. The options in Definition 
section change based on your selection. 

Simple Copy Fit Rule

For a simple rule, select Definition and choose options for the rule. Studio 
applies the options simultaneously until the text fits into the container. 

 Font size down to. This option reduces the font size down to a 
percentage of the original font size or down to a specific font size. If you 
specify an exact point size in this box, text that is already smaller the 
specified amount is unaffected by the Copy Fit rule. 
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 Reduce leading and paragraph space. If you click the option to 
reduce the font size, you can also select this option to reduce leading and 
paragraph spacing in the same proportion as the font size.

 Horizontal scale down to. This option uses horizontal scaling to reduce 
the overall size of the text.  

 Tracking down to. This option changes the amount of tracking applied 
to the text. It reduces the width of the text by reducing the amount of 
space after each character. 

Advanced Copy Fit Rule

For an advanced Copy Fit rule, Studio applies each attribute in the order you 
list them until the text fits into the container. Starting with the first attribute, 
Studio reduces the value of this attribute until the text fits into the container 
or until it reaches the value you set. If the text still does not fit, Studio 
applies the same procedure to the next attribute in the list.

 For each line of the definition, choose an attribute, a value, and a unit 
(pts. or %). Tracking is always expressed in ems. 

 Continue to build the definition using the button at the top of the 
Definition section to add, duplicate, or move each attribute. 

 To delete an attribute, click the delete button  at the beginning of the 
line. 

Add new attribute Duplicate

Move attribute up or 
down

Attribute Value Units
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 Click the Fit paragraphs on single lines check box. Studio attempts to 
fit the text into the text container and also to fit each paragraph onto a 
single line. For example, if you need each line of an address to fit on a 
single line, this option prevents Studio from adding unwanted line 
breaks. 

4 Click OK to define the Copy Fit rule. 

5 In the Copy Fit dialog box, click Apply if you want to apply the new rule to 
the currently-selected text container. 

Options

Choose from the following options for simple or advanced copy fit rules.

 Fit paragraphs on single lines. Select this check box and Studio not 
only attempts to fit the text into the text container, but also attempts to 
fit each paragraph onto a single line. For example, if you need each line of 
an address to fit on a single line, this option prevents Studio from adding 
unwanted line breaks.

 Uniformly reduce text in all containers assigned this rule. Select this 
check box to copy fit all containers with this rule applied. For example, if 
you apply this copy fit rule to several containers and check this box, and 
only one container needs to apply the rule to fit text, the other containers 
will also apply it, even if text is not overflowing within them. This is 
useful if you want to maintain typographic consistency within your 
template.
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Finding and Replacing Text
Using Find and Replace commands, you can quickly locate and change text in 
any text container in the template.

Note: The Find and Replace commands can only find text that is part of the 
template. They do not find text that is part of the variable contents, even while 
previewing records.

 To find specific text

1 Choose Edit  Find or press CTRL + F. Pageflex Studio displays the Find 
dialog box. The dialog box remains open until you click Cancel.

2 In the Find What box, type the text you want to find. Select one of the two 
additional search options to refine the search.

 Click Match Case to find text that matches not only the characters, but 
also the case of the characters (uppercase or lowercase). 

 Click Match Whole Word to find the text as a separate word, not part of 
another word. For example, if you type the word “page” and check this 
box, Studio finds only the word “page,” not “pageflex.”

3 Click Find Next. Studio finds the next occurrence of the text you specified. 
To find the next occurrence, click Find Next again. 

Continue clicking Find Next until Studio displays the message that there are 
no more occurrences of the search text.
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 To replace text

1 Choose Edit  Replace or press CTRL + H. Pageflex Studio displays the 
Replace dialog box. The dialog box remains open until you close it or click 
Cancel.

2 In the Find box, type the text you want to replace. In the Replace box, type 
the text you want to replace it with.

3 Select one of the two additional search options to refine the search.

 Click Match Case to find text that matches not only the characters, but 
also the case of the characters (uppercase and lowercase).

 Click Match Whole Word to find the text as a separate word, not part of 
another word.

4 Click Find Next to find the first occurrence of the search text.

5 Choose one of the following options:

 Click Find Next to leave the found text unchanged and continue 
searching.

 Click Replace to replace the found text with the text you specified in the 
Replace box.

 Click Replace All to replace all occurrences of the found text with the 
replacement text throughout the entire template.
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Finding and Replacing Fonts
Using Find Font, you can find all the text that uses a particular font and replace 
it. Choose Text  Find Font to display the Find Font dialog.

The Document Fonts window displays the fonts in the document. The Count 
displays the number of instances of the font in the document. Below the count is 
a snippet of the selected text that has the font applied to it.

 To Find a Font

1 Choose a font and click Find First. If the first instance of the font exists, it is 
highlighted in the document pane.

2 You can switch to the document pane to edit or change this font as needed, 
then switch back to the Find Font dialog and click Find Next to continue 
finding font instances. As each instance is found, the dialog updates the Text 
field to reflect the discovered string. The Details window is updated to 
reflect the characteristics of the font selected in the Document Fonts pane.

3 If you want to replace the font, choose a Font Family and Font Style from 
the drop-down list boxes and click Change. Click Change All to change all 
occurrences of the font.
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Note: This does not change the font for the Paragraph or Character style, 
just the font of the selected text.

To undo any changes, click Cancel and then Edit and Undo.

When the Find Font feature runs out of instances of the font, the button changes 
back to Find First.

Sometimes Find Font results in a blank character or no characters found (the 
orphan case). In these cases, you might want to remove that text altogether. 
Studio may have left a trace of a font around that represents only white space.

The Find Font feature is helpful when you want to identify where specific fonts 
are used in your document. Ideally, you should not use Find Font to change font 
styles on a regular basis. A best practice is to use paragraph styles to set font 
attributes.
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Checking Spelling
Pageflex Studio has the ability to check the spelling in your template. 

 To check spelling

1 Choose Edit  Spelling. 

2 If your document uses any words not already in Studio’s dictionary, Studio 
displays the Spell Check dialog box. Under Word Not in Dictionary, it 
displays the first possibly misspelled word.

3 If the word is misspelled, fix it with either of the following options:

 In the Change To box, type the correction. Click Change to change only 
this misspelling or Change All to change all occurrences in the template.

 Under Suggestions, select the correct spelling, and then click Change or 
Change All.

4 If the word is spelled correctly, select one of the following options:

 To add the word to the dictionary, click Add.

 To leave this occurrence of the word unchanged and continue the spell 
check, click Ignore.

 To leave all occurrences of the word unchanged, click Ignore All. 

5 Studio then moves to the next possibly misspelled word. Repeat steps 3 and 
4 as often as necessary.

6 When there are no more possible misspellings, Studio closes the dialog box.
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Inserting Special Characters
You can insert text symbols into your text using the Special Characters window. 
Special characters include many common symbols for typesetting, such as open 
quotations (“) and closed quotations (”). They also include two characters to 
help with formatting:

 Non-breaking space. Use this character to keep two words from breaking at 
the end of a line. 

 Non-breaking hyphen. Use this character to keep intentionally hyphenated 
words from breaking at the end of a line.

 To use special characters

1 Using the Text tool, click to place the cursor where you want to insert the 
special character. 

2 Choose Text  Special Characters. Pageflex Studio displays the Special 
Characters window.

3 Select a character in the list, and then click Insert. Studio inserts the 
character into the paragraph. The window remains open for adding 
additional characters. Click Close to close the window.
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Available Special Characters
You can also click Text  Insert and choose an item to insert, such as a Line 
Break (SHIFT ENTER), Column Break (CTRL SHIFT ENTER), Page Break (CTRL 

ALT SHIFT ENTER), Page Number (CTRL SHIFT N), Last Page Number, or any of 
the special characters in the special characters window.

The following special characters are available for insert from the Special 
Characters menu or the Text  Insert menu option.

Name Character

Bullet •

Closing Double Quote ”

Closing Single Quote ’

Copyright ©

Dagger †

Degree °

Double Dagger ‡

Double Quote "

Ellipsis …

Em Dash —

En Dash –

En Space

Euro €

Horizontal Fill

Indent Here

Leader Fill

Left Guillemet «

Non-breaking Hyphen -

Non-breaking space

Opening Double Quote “

Opening Single Quote ‘

Pound Sterling £

Registered ®

Right Guillemet »

Single Quote '

Soft Hyphen -

Tab

Trademark ™

Yen ¥
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Adding Flex

Flex is the ability of elements in a template to expand, contract, and 
move as needed to fit the dimensions of the project’s variable contents. 
Flex is one of the unique features of variable publishing with Pageflex 
Studio. Using flex changes a static design into a sophisticated variable 
one. This chapter assumes you have a working knowledge of the 
various elements and properties in a Pageflex Studio template.
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Understanding Flex Behavior
Studio containers and shapes can use flex behavior. Flex behavior allows a 
container to expand, contract, and reposition itself and adjacent containers to 
accommodate the variable contents of each document in a project. Pageflex 
Studio adds flex with three properties.

 Flex Height — how the height expands and contracts

 Flex Width — how the width expands and contracts

 Anchor Flex — which direction the element expands and contracts

Flex Height and Flex Width determine the flexible behavior of an element. You 
can maximize or minimize each behavior to control how the element expands 
and contracts its dimensions. The Anchor Flex property sets the anchor point, a 
fixed point around which the element can flex. No matter how much the element 
expands or contracts, the Anchor Point remains fixed.

Note: Image containers do not use flex behavior to change size. Use scaling to 
change the size of the containers. See “Scaling Images” on page 65.

Parent-Child Relationships for Elements
To understand how flex behavior works, it is important to understand how 
elements are nested inside each other. Every element in a Pageflex Studio 
template can be a parent or a child to another element. Parent elements contain 
child elements. 

If you create a horizontal group with a rectangle and an oval inside it, the 
rectangle and oval are child elements in relation to the parent horizontal group. 

Note: Flex behavior does not apply to image containers. Images change size in 
variable documents based on the Image Scaling property. See “Scaling Images” 
on page 65 for more information.

Also note, the Anchor Point property is not available for any element inside a 
horizontal or vertical group, or any element pasted inline into a text paragraph. 
The elements inside these groups are “floating,” meaning they do not have fixed 
locations on the page. 

“Child” elements

Horizontal Group, 
the “parent” element
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Minimizing Height or Width
When you set Flex Width or Flex Height to Minimize, the element size shrinks 
(or grows) to fit whatever it contains. Use Minimize to control the flex behavior 
for a parent element so that the parent element contracts to fit the elements 
contained within it.

For example, a text box is a parent element to the text it contains. Setting Flex 
Height to Minimize makes the text box contract to fit the text inside it.

Minimize does not always make the container smaller in final documents. In 
some cases, the container may have to become larger to accommodate the 
variable elements inside it. 

The container element 
shrinks to fit its contents

Text box with 
no flex behavior

Text box with 
Flex Height = Minimize
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Maximizing Height or Width
When you set Flex Width or Flex Height to Maximize, the element size 
expands to fill the container that holds it. In general, use Maximize on a child 
element to make it expand to fit its parent container element.

For example, a rectangle inside a vertical group has Flex Width set to Maximize.

Because Maximize behavior depends upon the size of the bounding element, it 
works best when combined with other flex behaviors. 

The element expands 
to fill its container

Top rectangle has 
no flex behavior

Top rectangle with 
Flex Width = Maximize
 180 Adding Flex



Chapter 7
Combining Flex Behaviors
Much of the power of flex comes from combining the flex behaviors with 
horizontal and vertical groups. Minimize and maximize work together by 
offsetting each other. As Maximize expands a container, Minimize contracts 
around it. 

In the next example, the vertical group contains a rectangle and a text box set to 
maximize and minimize their heights, respectively. The vertical group has no flex 
behavior.

In another example, you can use flex behavior to be sure that three adjacent 
elements all have the same height. The horizontal group here contains two text 
boxes and a rectangle. The horizontal group has Flex Height set to Minimize, 
which means the group container is contracting as much as possible to fit the 
elements inside it. At the same time, the elements inside the group have Flex 
Height set to Maximize. 

As the text box minimizes, the rectangle fills the space

Text box set to 
minimize its height

Rectangle set to 
Maximize its height
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The middle text box is the one with the most text, and it becomes the element 
that determines the size for all three elements in the group. The middle text box 
expands just enough to fit the text it contains because the Minimize property of 
the group is forcing each element in the group to become as small as possible. 
Once the horizontal group container contracts as much as it can, the other text 
box and the rectangle expand to match the height of the group container. The 
text container does not contract enough to cause the text to overflow.

Setting Anchor Points
The Anchor Point provides a fixed point around which an element can flex.

 

As Studio ingests the variable contents for each document, the Anchor Point for a 
flexible container remains constant no matter how much the container expands 
or contracts.

Horizontal group set 
to minimize its height Rectangle and two text 

boxes set to maximize

Text box with the most text determines 
the height for all three elements

Left/Top anchor point 
remains fixed as height 
and width adjust for 
new contents
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Note: The Anchor Point property does not apply to elements inside a 
horizontal or vertical group, or to an element pasted inline into a block of text. 

Anchor Point set to Right/Top

Document 1 Document 2 Document 3
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Setting Boundaries for Flex
While adding flex helps you create complex variable documents, you may need to 
set some limits on how much the elements in your document can flex. There are 
several properties you can use to control the boundaries for flexible behavior.

 Margins

 Bumpers

 Flex Minimum

 Flex Maximum

Using Element Margins and Bumpers
The spaces created by Margins and Bumpers are preserved when you apply flex 
behavior to any element. Margins control how close the contents of an element 
can approach the edges of a container. Bumpers control how close elements can 
be next to each other. For information on Margins and Bumpers, see 
“Understanding Element Properties” on page 90.

In the following example, a vertical group contains a rectangle. The vertical group 
has all Margins set to 0.25 inches, and the rectangle has Flex Width set to 
Maximize.

The rectangle’s width expands to the left and right margins.

Vertical Group 
container with 
Top Margin = 0.25"

Rectangle with 
Flex Width=Maximize
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In the following example, a vertical group contains two rectangles. The vertical 
group has Flex Height set to Minimize, and the top rectangle has Top and 
Bottom Bumpers set to 0.25 inches.

The Bumper space between the top of the rectangle and the vertical group 
container is preserved when the container contracts.

Setting Minimum and Maximum
The Minimum and Maximum for Flex Height and Flex Width set the range for 
how much the element can change size. The Minimum sets the smallest size, 
and the Maximum sets the largest size. The Minimum must be smaller than the 
Maximum.

For example, a text box has Flex Height set to Minimize, and a Minimum 
Height set to 1 inch. For each variable document, the text box minimizes to fit 
the variable text. No matter how small the amount of text, the height does not 
shrink below 1 inch.

Vertical Group with 
Flex Height = Minimize

Rectangle with 
Top Bumper=0.25"
Bottom Bumper = 0.25" Bumper 

Spaces

Document 1:
Text box flexes 
to fit the text

Document 2:
Text box does not shrink 
below the Minimum

Minimum 
height
Adding Flex  185



Pageflex Persona Cross Media Suite User Guide
If you change the Minimum Height to zero, Studio shrinks the height to zero if 
the variable content is empty. The text box appears to disappear, but it is not 
deleted from the template. 

In the following example, a text box contains a variable to indicate whether an 
item pictured is on sale. The text box has Flex Height set to Minimize, and a 
Minimum Height set to zero. 

Document 1
Item is on sale. Variable 
contents are displayed.

Document 2
Item is not on sale.
Text box disappears and 
next item in catalog 
appears instead.

Lawn Furniture Lamps and Tables
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Setting Auto-Hide Conditions
You can set conditions on elements or paragraphs so that if a variable has no 
value, Studio hides the element or paragraph during output. Studio does not 
examine the type of variable, but only determines if the variable has a value. If 
the variable contains any value, auto-hide will fail and the element or paragraph 
will be displayed.

 To Auto-Hide an Element or Paragraph

1 Choose an element or paragraph.

2 Select the Flex tab in the Properties panel.

3 Type the name of a variable in the Auto-Hide Condition field. The variable 
must exist in your project.
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Working with Master Pages

Master Pages provide the standard layout information for document 
templates, including guides, margins, and page borders and recurring 
logo images or text. They also provide the models for pages created in 
variable-length documents. A document may use a series of master 
pages. Master page management helps you set up automatic page and 
section numbering, add headers and footers that are automatically 
repeated on every new page, and apply a consistent template style to 
imported PDFs.
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Using Master Pages for Page Layout
Master pages are background layers shown with each document page. They can 
have no elements, or elements that will appear on each document page 
associated with the master, such as page numbers, guides, headers, and footers. 
There are two types of master pages that you can choose from.

 Using Left/Right Masters specifies a master page for left-hand pages, and a 
different master page for right-hand pages. This feature allows you to specify 
margins for book binding, for example.

 Using Single Page Masters specifies a single master for all pages.

When you first create a new template, you must choose whether you want to use  
Left/Right Masters or Single Page Masters in the Template Setup dialog box.

Note: You cannot change the master page format you have chosen once you 
have created your template.
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 To choose Left/Right Masters

 Check the Masters Left/Right box  in the Pages section of the General tab 
of the Template Setup dialog box.

 To choose Single Page Masters

 Leave the Masters Left/Right box unchecked in the Pages section of the 
General tab of the Template Setup dialog box. 

Note: Studio uses single-page masters by default.
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Pages Tab
After the document is created, master pages and document pages are displayed in 
the Pages tab in the Structure panel. This gives an overview of all pages in the 
template, including master pages.

You can manipulate the page representations in the Pages tab to change the real 
document pages by doing the following:

 Double-click a page to view or edit the selected page in the document area.

 Drag and drop a page or pages to re-order the document.

 Drag and drop a master page into the document page list to create new 
document pages associated with that master.

 Drag and drop a master page onto a document page to apply the master to 
that page.

 Single-click a page to select it as the potential target of an editing action.

 Press CTRL click and SHIFT click to extend page selection to multiple pages.

 Right-click on a page to choose an option from a context menu.

 Move the mouse over a document page to view a tool tip that displays more 
information about the document page. 

 For static document pages, the tool tip provides the full page number, 
including prefix. 

 For variable pages, the tool tip provides the associated variable name. See 
“Creating Variable-Length Documents” on page 203 for details.

 For filler pages, the tool tip provides information on how the filler page 
will affect handedness and page count.

Pages tab with Single Page Masters Pages tab with Left/Right Masters

Master Page List

Document Page List
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Managing Master Pages
Studio assigns master pages a prefix character, such as A, B, or C, which is 
displayed on document pages to indicate which master is assigned. Pages using 
the “No_Master” master page have no prefix. 

The No_Master master cannot be edited or deleted. It is there to provide the 
option to assign a blank page master to a document page. When legacy 
documents are opened, they appear with single page masters with “No Master” 
assigned. “A-Master A” is assigned by default to the first and all new document 
pages.

Creating Master Pages

 To create a new Master page

1 Choose Page  New Master...

-or-

Right-click in the Master Page list on the Pages tab and choose New 
Master...

This displays the New Master dialog box.

2 Studio automatically assigns the prefix character, which is the next available 
letter in the alphabet. It cannot be edited. Type a Name for the master page 
in the text box, or make no change to use the default name.

3 Check the Add Autochain text container if you want to create a text 
container that will automatically autochain to another page if there are text 
overflows. See “Automatic Pages” on page 204 for more information.

4 Click OK to create the master page.
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Editing Master Pages
You can edit master pages like you edit document pages, except the elements that 
you add become master items for each document page associated with that 
master. To edit a master page, double-click on its page representation in the 
Master Page List on the Pages tab.

 To change the name of a Master page

Use the Master Setup dialog box to change the name of a master page. It is the 
same as the New Master dialog box, except that the autochain option is no longer 
available. Once a master has been created, use the Element  Autochain menu 
command to set a selected text container to autochain on text overflow. See 
“Automatic Pages” on page 204 for details.

1 Choose Page  Edit Master

-or-

Right-click in the Master Page list and choose Master Setup

This displays the Master Setup dialog box.

2 The prefix character cannot be edited. Type a new Name for the master page.

3 Click OK to change the name for the Master Page. The name is changed for 
all document pages that reference this master page.

Inserting Pages Based on a Master Page

 To insert pages

1 Drag and drop a master page into the document page list to create new 
document pages associated with that master.
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-or-

Choose Page  Insert Pages or right-click in the Document Page list and 
choose Insert Pages. This displays the Insert Pages dialog box.

2 Enter the number of pages to insert in the Insert text box.

3 Choose the Location to insert pages, in the beginning of the document, at 
the end of the document, or before or after a specific page.

4 If you have chosen to insert pages before or after a specific page, choose that 
page in the drop-down list.

5 Choose the Master page to use for the pages to be inserted.

6 Click OK to insert pages.

Applying a Master Page to Document Pages

 To apply a Master page to Document pages

1 Drag and drop a master page onto a document page to apply the master to 
that page.

-or-
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Choose Page  Apply Master or right-click on the selected master page 
representation, and choose Apply Master. This displays the Apply Master 
dialog box.

2 Select the master page to apply in the Apply Master drop-down list.

3 Choose the document page range to apply this master page to.

4 Click OK to apply the master page to this document range.

Duplicating Master Pages

 To duplicate a Master page

1 Choose Page  Duplicate Master or right-click on the selected master 
page representation and choose Duplicate Master. This displays the 
Duplicate Master dialog box.

2 Select the master page to be duplicated.

3 The prefix character cannot be edited. Enter a new name for the duplicate 
master page.

4 Click OK to create a duplicate of the selected master page.
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Deleting Master Pages

 To delete Master pages

1 Choose Page  Delete Master or right-click on the selected master page 
representation and choose Delete Master. This displays a confirmation 
dialog box.

2 Confirm that the master page listed is the one that you would like to delete, 
and click OK to delete this page. Studio displays a warning if any document 
pages use the master.

3 Click OK to delete the master. The document pages that use the deleted 
master are converted to pages using No_Master. Studio deletes master items 
from document pages if they haven’t been modified on the document page.
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Automatic Page Numbering
Studio provides the ability to set up automatic page numbering fields on master 
pages, as well as the ability to create sections with different number formats, for 
example for a forward or introduction. These capabilities are discussed in this 
section.

Setting up Automatic Page Numbering

 To set up automatic page numbering

1 Select the master page on which to set up automatic page numbering. You 
can either choose a master page from the page selection toolbar or double-
click on a master page in the Pages tab.

2 Create a text frame on the Master page.

3 Place the cursor in the text frame and select Text  Insert  Page 
Number. The page number is represented by the variable <P#> on the master 
page. 

If View  Variable Highlights is selected, the page number variable is 
highlighted in gray on the Master page. On document pages, the page 
number is resolved and presented as the appropriate page.
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Setting Up Section Numbering

 To Set Up Section Numbering

1 Single-click a page in the document page list in the Pages tab to select it.

2 Choose Page  Section Numbering or right-click on a selected document 
page representation and choose Section Numbering. This displays the 
Section Numbering dialog box.

3 Choose the page on which to start a new section.

4 Choose a Numbering option:

 Choose Automatic to automatically continue the numbering 
sequentially from the previous section

 Choose Start at to enter a specific value with which to start numbering.

5 Under Format, choose a numbering style from the drop-down list.

6 Under Prefix, choose a text string to incorporate into the page number, for 
example “4-1,” “4-2,” and so on.

7 Click OK to create the new section.
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In the Pages tab, new sections cause a line break. A gray line, extending to the 
margins of the document pages area, is inserted to mark the break between 
sections.

Pages in the Pages tab show the page numbers in the numbering format that was 
chosen for the section in which they are located. They do not show page prefixes. 
For example, you would add a section if you want to list an index with roman 
numerals after pages with numeric numerals, as shown in the image to the right.

Gray line marking 
break between 
sections.
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Elements on Master Pages
A document page displays the elements placed on the master page it is based on. 
You can in effect add headers and footers to all document pages by adding text 
boxes at the top and bottom of your master page. Elements placed on master 
pages are called master items. 

You can select and edit any master item on a document page. Once you edit a 
master item on a document page, edits made to the same property of the same 
item on the master page will no longer affect the item on the document page. 

For example, create a text box on a master page and then edit the size of the text 
box on a document page that uses that master.  Now the text box will no longer 
change size in the document if you change its size in the associated master. 
However, if you now change the fill color of the text box in the associated master, 
the fill color will change in the document page.

Selecting Master Items
Studio displays round selection handles when you select master items. When you 
edit a master page, all selected master items have round handles. On a document 
page, document page elements have square selection handles.

The Info Tab provides a read only “Master Element” property that indicates 
whether a selection is a master item or not. If the selected element is a master 
item, the Master Element property value is “Yes.” If the selected element is not a 
master item, the Master Element property value is “No.”

Selection handles 
on a master item

Round

Selection handles on a 
document page element

Square
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Revert to Master
When you edit a property of a master item on a document page, the master item 
no longer inherits changes made to that property that are made on the master 
page. However, changes to other properties are inherited. In this way, edits to 
master element instances are similar to the way paragraph styles can be modified 
by paragraph and character properties. If you want to remove any changes you 
have made to a master item on your document page, Studio lets you revert a 
modified master item to its original state.

 To revert a modified Master Item to its original state

1 Select the modified master item on the document page.

2 Choose Element  Revert to Master

The selected element reverts back to the state it was in when first inherited 
from the master.

Changing Master Items to Document Elements
Studio offers the ability to completely detach a master item on a document page 
from the master using the Edit  Cut and Edit  Paste in Place menu 
commands.

The element is copied exactly in the position it was copied from and behaves as a 
normal element selection. It is fully detached from the master, which means that 
any changes made to that element in the master will not affect the detached 
master item. It now functions as a regular document element.

 To detach a Master Item from the Master page

1 Choose the master item on the document page.

2 Choose Edit  Cut

3 Choose Edit  Paste in Place
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Creating Variable-Length 
Documents

With Pageflex variable-length document features, you can design 
document templates that use automatic, variable, and filler pages to 
add or remove pages based on the amount of text that needs to be 
presented in a specific document. Automatic pages are created by text 
overflow, variable pages by the application of document variables, and 
filler pages by rules that govern handedness or page count.
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Automatic Pages
Automatic page insertion occurs when text overflows in selected text containers 
in Studio. 

You must specify that text overflowing from a text container on a particular page 
should be automatically chained, or “autochained,” to text containers on pages 
created and inserted into the document automatically until all text has flowed. 
These containers are known as autochain text containers.

You can add an autochain text container on a document page or a master page, or 
convert an ordinary text container into an autochained text container in either 
place. New pages generated by autochain text containers are based on autochain 
masters, master pages with an autochain text container on at least one of their 
pages. You can create as many autochain masters as you want, but only one 
autochain text container can appear on each page.

In order to set up an autochained text container, first create an autochain master, 
and then set a text container on a document page to autochain on overflow.

 To create a new master with an autochain text container

1 Choose Page  New Master or right-click in the Master Page list and 
choose New Master. This displays the New Master dialog box.

2 The prefix character cannot be edited. Type a Name for the master page in 
the text container or do nothing to use the default name.

3 Check the Add Autochain text container if you want to create a text 
container that will automatically autochain to another page of the same 
master type if there are text overflows.
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4 Click OK to create the master page. This causes rectangular autochain text 
containers, sized to the page margins, to be inserted on the master. If left/
right masters are in use, Studio creates autochain containers on both left and 
right sides.

 To create an autochain text container on an existing master

You can add a new text container to create an autochain text container, or modify 
an existing text container to include autochain text properties.

1 Select a master page on which to add an autochain text container.

2 Single-click a text container to select it. 

3 Choose Element  Autochain. This displays the Autochain dialog box.

4 From the drop-down list box, choose the master page that you want new 
document pages to use when text overflows in the autochain text container.

Note: Only autochain masters are offered as options.

5 Click OK to create the autochain text container.

Note: If you are using left/right masters you should create a autochain text 
container on both left- and right-hand pages.
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Identifying Autochain Text Containers
The input and output selection handles at the top and bottom of a text container 
on a master page change when a text container becomes an autochain text 
container. When an autochain text container is created on a master page, the 
input handles change to an autochain in point and an autochain out point.

The output selection handles on autochain text containers on document pages 
are different from the output selection handles on chained text containers, as 
shown below. Additionally, if the autochain text container was created on a 
master page, its selection handles are round.

 To set a document page text container to autochain on overflow

You can set a text container on a document page to autochain text overflows to 
pages specified on an autochain master.

1 Select a text container by single-clicking on the text container.

2 Choose Element  Autochain

Master Item

Input 
handles

Autochain Text Container

Autochain
In

Autochain 
Out

Autochain Text Container

Autochain 
Out

Chained Text Container

Chain 
Out
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This displays the Autochain dialog box.

3 Select an autochain master to be used for any pages automatically inserted if 
the text container overflows. 

4 Click OK to create the autochain text container.

 To unchain an autochain text container

1 Select an autochain text container by single-clicking on the text container.

2 Choose Element  Unchain

Studio unchains the autochain text container.
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Autochain Text Containers in the Pages View
When an autochain text container is added to a master page, its icon in the 
Master Page list shows a graphic to indicate that it can be used for automatically 
inserted pages. 

In the image below, Master A is not an autochain master. Master B, Master C, and 
Master D are autochain masters. Overflow text creates new pages on both left 
and right pages when Master B is used. However, overflow text creates new pages 
only on the left page when Master C is used, and only on the right page when 
Master D is used.

When you set a text container on a document page to autochain on overflow, the 
icon representing that document page is updated to indicate that the page 
contains an autochain link, as shown above.

If the text container set to autochain does overflow, the pages required to present 
all text are automatically inserted. These automatic pages can disappear if text is 
removed and are represented by pages with dotted outlines. Arrows appear 
between the gaps in the sequence of automatic pages to show that they are 
grouped or connected to the initial static page.

In the screenshot above, text inserted on page 3 created two automatic pages, 4 
and 5. If text is inserted on page 2, automatic pages are created between pages 2 
and 3.

Autochain Masters

Document Pages set to 
Autochain on Overflow

Automatic Pages
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Chaining Autochain Text Containers
It is possible to set up a sequence of chained text containers to act as a single 
autochain container. An example showing two chained text containers on a 
master page is displayed below.

If text overflows from the last container, Studio generates automatic pages.

 To autochain a chain of text containers

1 Click the Chain tool in the Toolbox.

2 Drag the mouse in the document area to create and size the first text 
container in the chain.

3 Drag the mouse in the document area to create and size the second text 
container in the chain.

4 Select the last text container in the chain.

5 Choose Element  Autochain. This brings up the Autochain dialog box.

6 Choose the autochain master you would like to use when text overflows in 
these text containers from the drop-down list.
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7 Click OK to add the autochain in and out links to the chainted text 
containers, thus forming a chain of containers that acts as one autochain text 
container on the master.

Unchaining Autochain Text Containers
You can unchain autochain text containers or chained autochain text containers. 
Once you do so, the containers become ordinary text containers and no longer 
support the generation of automatic pages.

 To unchain autochain text containers

1 Select the autochain text container you would like to unchain.

2 Choose Element  Unchain.

 To unchain a chain of autochain text containers

1 Select the text container you would like to unchain.

2 Choose Element  Unchain. Studio displays the Unchain dialog box when 
you unchain a chained text container set to autochain. This dialog gives you 
the option of unchaining both chain and autochain links.

3 Choose whether you want to clear both chain and autochain links, chain 
links only, or autochain links only

 Clear both Chain and Autochain out links clears any chain links in or 
out of the text container as well as any autochain links out.

 Clear Chain in link only clears any chain links in or out of the text 
container.
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 Clear Autochain out link only changes a chained autochain text 
container to chained text containers when it is applied to the last 
container in a set of autochain text containers.

Note: Clear Autochain out link only works only on the last container in a 
set of autochain text containers.

Reordering and Removing Pages With Autochain
This section describes what happens when pages with Autochain links are 
inserted, moved, or deleted.

 Only static pages can be moved or deleted. 

 Automatic pages move as a group.

Automatic pages stay with the page that contains the their “parent” 
autochain link. For example, if page one of a set of automatic pages were 
dragged to a new location, page one plus the entire set of automatic pages 
associated with it would also be relocated. 

 If the page with the autochain link is removed, the Autochain link is removed 
along with the page.

Inserting Page Breaks
The Text menu has an option to insert a page break in text. This is useful if you 
need to force text to break in a certain place in your text flow, so that the 
automatic page insertion set up for the parent text container can insert a new 
page.

 To insert a page break

1 Place the cursor at the beginning of the text where you would like the break 
to occur.

2 Choose Text  Insert  Page Break.
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Converting Dynamic Pages to Static Pages
Automatic pages may not always remain visible in a document. If enough text is 
removed from the flow of text that causes the insertion to happen, the last page 
in an automatically inserted chain of pages, for example, can be removed.

The only content on a dynamic page that can be edited is the stream of 
autochained text. Because the page can disappear when content shrinks, you can 
make no other edits. If you want to make any other edits to the page or add 
images, for example, you must convert the automatic page to a static page.

 To convert dynamic pages to static pages

1 Select the last page in the sequence of pages that you would like to convert to 
static.

2 Choose Page  Convert to Static Page.

3 Click OK to convert the selected dynamic page and all prior dynamic pages 
associated with the selected page to static pages.

For example, you have inserted a block of text which creates four automatic 
pages, as shown below by the dotted lines.

If you choose the third dynamic page in the Document Page list in the Pages tab 
and convert it to a static page, it converts itself and the prior two dynamic pages 
associated with it to static pages, as shown below.

The last two automatic pages remain dynamic.
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Variable Pages
You can use variable pages to design templates that include different pages based 
on variable values. For example, you can create a custom product brochure 
personalized to show just those items a particular user is interested in, typically 
by having the user select the items from a list on a website.

Studio uses the “Document” variable type to set up variable pages. Document 
variables are created using the same variable setup as for creating text, image, 
and area template variable types. See “Understanding Variable Types” on page 
256 for more information on these variable types. The value of a document 
variable resolves to either a Pageflex document template (.xdt) file or an Adobe 
Acrobat portable document format (.pdf) file.

You can insert document variables between pages in a document template to 
splice in pages based on the value of the document variable. As with other 
variables, Studio resolves document variable values during variable data 
ingestion at preview or submission time.

You must follow the steps below to create a template that incorporates variable 
page capabilities:

 Create the .xdt files or PDF documents to be imported

 Create document variables in the main template, each specifying which .xdt 
file or PDF to import

 Create and place variable-page placeholders based on the document variables

These steps are described in the sections below.

Creating Document Templates
You can create both the main template and a template to be imported into it with 
the template creation tools in Pageflex Studio. You can also insert externally 
produced PDFs or generate PDFs from Studio output and insert them as variable 
pages.

If you create .xdt files for insertion, keep the page size, master page type, and 
page orientation the same as those in the main template.  Since PDFs are 
imported as images, their document size can be anything the main template can 
accommodate.
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Creating Document Variables
Create document variables using the variable setup dialog used for creating other 
variable types such as text, image, and area template variable types. See “Adding 
or Editing Variables” on page 261 for instructions.

If you specify an .xdt file as a document variable value, be sure to choose files in 
which the page size and master page format are compatible with the parent 
document it is ingested into.

PDF page images are positioned in the center of the pages of the parent 
document.

Inserting Variable Pages
You can insert variable pages within document templates using menus or directly 
through the Pages tab.

Note: You must have created a document variable in a project and have that 
project open in order to create a variable page.
 214 Creating Variable-Length Documents



Chapter 9
 To insert variable pages using menu choices

1 Choose Page  Insert Variable Pages

-or-

Right-click in the document pages list and choose 
Insert Variable Pages

This displays the Insert Variable Pages dialog box.

2 Choose the location within the pages of the template to insert the variable 
pages. Insert the variable pages before or after a specified page, or at the 
beginning or end of the document.

3 Choose the document variable from a list of all those available for the 
currently open project to determine which document to insert.

4 Choose which master page to apply to any PDF insertions. “[No_Master]” is 
the default. 

Note: This feature offers you the chance to set up page numbering for 
inserted PDF pages since the master you choose can have page number 
variables. The master items will always be layered on top of PDF page 
images.

5 Click OK to insert the variable pages.
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 To insert variable pages using drag-and-drop

1 Select a document variable from the variable list of an open project.

2 Drag the document variable to the area in the Document Page list on the 
Pages tab where you would like to insert the variable pages.

3 Drop the document variable into the Document Page list on the Pages tab. 
This displays the Insert Variable Pages dialog box. Follow steps 2-5 in the 
previous procedure to choose your options and insert variable pages.

Style name conflicts
Style names may differ between the inserted document and the main document. 
“Style” refers to paragraph style, color, copyfitting rule, and master page 
definitions in document template TSL style files. Name conflicts can occur in any 
of these definitions. An example of a paragraph style name conflict is a main 
document that has a “body” paragraph style and an inserted document that also 
has a “body” paragraph style definition.

The style name conflicts on master pages occur in the user assigned names for 
the master pages rather than the prefix names. For the master page named “A-
BackgroundMaster,” “A” is the automatically assigned prefix and 
“BackgroundMaster” is the name assigned by the user.

Inserted documents adopt the style definitions of the parent document directly in 
case of conflict. Other styles that exist in the inserted document, but not in the 
main document are added to the paragraph style, color, copyfitting rule, and 
master page definitions of the parent document temporarily during ingest. These 
added definitions are visible to you during preview.

Viewing and editing variable pages
Variable pages appear as place holders within the Document Page list in the 
Pages tab, highlighted with the variable highlight color, as shown below. They 
can be selected, deleted, repositioned, and included in a page numbering section 
like any document page.
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If you select a variable page, it is displayed in the document area in the variable 
highlight color, with a label in the center that says it is a variable page, to signify 
that one or more variable pages may be inserted based on the document variable 
value listed. It then lists the document variable value. You can click the link in 
the document area to edit the variable page setup.

 To edit variable pages

1 Double-click a variable page in the Document Page list on the Pages tab and 
click the link “Click to edit.”

-or-

Select a variable page in the Document Page list on the Pages tab and choose 
Page  Edit Variable Pages.

-or-

Right-click on a variable page insertion point in the Document Page list on 
the Pages tab and choose Edit Variable Pages.

This displays the Edit Variable Pages dialog box.

2 Choose the document variable from a list of those available for the currently 
open project to determine which document to insert.

3 Choose which master page to apply to any PDF insertions. “[No_Master]” is 
the default.

4 Click OK to make the edits.
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Previewing Variable Pages
You can use the Preview command to cause variable data to be ingested live. The 
page representations in the Pages tab change to show the results of Document 
variable ingestion. If the value of a Document variable resolves to a document file 
name, then the representation changes to show the single or multiple pages of 
that document that are inserted. Inserted pages are colored with the variable 
highlight color. A graphic appears on top of the first page in the insertion 
sequence. Arrows appear between the gaps in a sequence of multiple pages to 
shown that they are grouped or connected together. If the value of a document 
variable resolves to no value, then no place holders are shown.

The example above shows what the page representations with multiple Variable 
pages looks like before and after variable data ingestion. The post ingest example 
shows that a three-page document with autochain text containers was inserted at 
the first insertion point, a one-page document at the second, and a four-page 
document at the third.

Variable pages can consist of a document which itself contains automatic pages, 
variable pages, and filler pages. However, at the main document level, inserted 
documents show only the actual document pages resulting from all sub-
insertions.

It is possible for a document template to be completely comprised of variable 
pages. No static pages need exist. This is useful if you want to construct 
documents out of pre-created single or multiple page document components. It is 
also useful to “stitch” PDF documents created with other authoring tools into 
single files can be output through a Studio job.

Pages tab
Pre-ingest

Pages tab
Post ingest
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Filler Pages
Publishers frequently need to enforce usage conventions for left- and right-hand 
pages, specifying for example that chapters begin on a right-hand page. Some 
binding methods also require that the total number of pages in a publication be 
even. Other binding methods require that pages fit a set number of pages. 
Designers and print production experts working with static page layout can 
insert or remove pages manually to meet these conventions. But when you work 
with variable-length document features, you can not, since your documents can 
change in length dynamically. You must make such requirements explicit in 
template designs. Pageflex Studio provides the ability to create filler pages to 
address this need.

Inserting Filler Pages
Studio lets you manage the number of filler pages you want to insert through an 
option on the Page menu. The selections are the same for left/right and single-
page masters.

 To create a simple filler page rule

1 Choose Page  Insert Filler Pages

-or-

Right-click in the Document Page list on the Pages tab and choose 
Insert Filler Pages.

You see this dialog box:
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2 Under Insertion Point Location, select After Page or Before Page in the 
first drop-down list, and then select the number of the page the new page 
will follow or precede. Or select Beginning of Document or End of 
Document to place the filler pages at the beginning or end of the document.

3 Under Filler Page Master, select a master page for the new page to use.

4 Under Rule Type, choose Simple to specify whether the new page should be 
an odd or even page. Choose Advanced to specify a multiple of filler pages. 
See below for advanced instructions.

5 Under Definition, specify whether the new page should be an odd-
numbered page and force the next page to be a right-hand page if you are 
using left/right masters, or an even-numbered page and force the next page 
to be a left-hand page with left/right masters.

6 Click OK to insert the filler page. In the Document Page List on the Pages 
tab, you will see a filler page placeholder. You can reposition this placeholder 
to change the location of your filler page.

Inserting filler pages does not guarantee the automatic insertion of a dynamic 
page. Studio evaluates your definition at production time and inserts a page only 
if necessary to satisfy the conditions in your definition.

For example, if you specify inserting an even page to force the following page to 
be an odd page, Studio will not insert a page if the next page is already an odd 
page.

 To create an advanced filler page rule

1 Choose Page  Insert Filler Pages

-or-

Right-click in the Document Page list on the Pages tab and choose 
Insert Filler Pages.
 220 Creating Variable-Length Documents



Chapter 9
This displays the Insert Filler Pages dialog box.

2 Under Insertion Point Location, select After Page or Before Page in the 
first drop-down list, and then select the number of the page the new page 
will follow or precede to specify the location. Or select Beginning of 
Document or End of Document to place the filler pages at the beginning or 
end of the document.

3 Under Page Master, select a master page for the new page to use.

4 Under Rule Type, choose Advanced to specify a multiple of filler pages.

5 Under Definition, choose a number the page count will be a multiple of, 
plus a specific number of pages, to choose where in the set your next page 
will fall. 

For example, if you choose to insert 4 filler pages plus 2 Pages, your next 
page will be the third in a four-page set. See the examples below.

6 Click OK to insert the filler pages. In the Document Page List on the Pages 
tab, you will see a filler page placeholder. You can reposition this placeholder 
to change the location, and amount of your filler pages.
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Advanced Filler Page Example
Assume you want two pages to appear at the end of the document and you need 
to keep the total page count to a multiple of four.  You need to insert filler pages 
to ensure that your final static page completes a four-page set, so you use a rule 
with “A multiple of 4 plus 2 pages.” The illustrations below show what you  see 
in the Document Page list of the Pages tab in several different examples.

Case 1: No Filler Pages Inserted

No filler pages are inserted because the page count before the pages to be 
inserted is either two or already a multiple of four + two.

Case 2: One Filler Page Inserted

One filler page is inserted because the page count before the pages to be inserted 
is either one, or a multiple of four plus one.

Case 3: Two Filler Pages Inserted

Two filler pages are inserted because the page count before the pages to be 
inserted is either zero, or an even multiple of four.

Case 4: Three Filler Pages Inserted

Three filler pages are inserted because the page count before the pages to be 
inserted either three or a multiple of four plus three.
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Viewing Filler Pages
Studio displays filler page placeholders in the Document Pages list in the Pages 
tab. The symbol is a small page with a plus sign to indicate that a page might be 
added. If a page is added based on the filler page definition, double-click it in the 
Document Page list to display a it in the Document window. The document page 
has a dotted outline to indicate that it is a dynamic page, as it may or may not be 
added, depending on the variable values when you run the job.

Note: You will not see filler page placeholders in the document area during 
preview. The Document window always shows you exactly what will print when 
you output the document with the specified profile values. So, either you will see 
a filler page if it is necessary, or no page where the filler page placeholder was in 
the template.

Filler Page 

Dynamic page
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Editing Filler Pages
You can make changes to filler pages at any time by editing them.

 To edit filler pages

1 Double-click the filler page placeholder in the Document Page list on the 
Pages tab and click the link “Click to edit”

-or-

Select a filler page insertion point in the Document Page list on the Pages tab 
and choose 
Page  Edit Filler Pages

-or-

Right-click on a filler page insertion point in the Document Page list on the 
Pages tab and choose Edit Filler Pages.

This displays the Edit Filler Pages dialog box.

2 Make any changes necessary and click OK to apply your changes.
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Adding a Table of Contents

This chapter explains how to use Studio features for creating, editing, 
and updating a table of contents. The table of contents prints a list of 
text you have marked with selected styles. As you bring variable data 
into a Studio template to create a suite of related documents, Studio 
dynamically updates the table of contents to reflect changing content 
and page numbers.
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Creating A Table of Contents
You can create a table of contents (TOC) based on the text styles in a document. 
For example, all text styled with “Title” could be collected for the TOC. Studio 
automatically collects multiple TOC items and updates text and page numbers in 
the document as content and flow change. You can also specify styles for TOC 
entries themselves and assign simple plain-text alternate TOC entries. You may 
have more than one TOC in your document.

 To create a new Table of Contents

1 Create a text container for the table of contents. See “Text Containers” on 
page 54.

2 Insert the text cursor in the container and choose Text  New Table of 
Contents.

This displays the New Table of Contents dialog box.

3 On the left is a list of the paragraph styles used in the template. Put a 
checkmark beside the styles which you want to include in the TOC.
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4 Highlight a checked paragraph style to change its Entry options.

5 Under Format, select a paragraph style to use to display the table of contents 
entry and associated page number. The paragraph styles are defined in the 
template. The default is Normal.

6 Under Page #, select a position in which to place page numbers relative to 
the corresponding text. You can put numbers After Text or Before Text, or 
you can select None to suppress page numbers from the TOC. The default is 
After Text.

7 Under Insert between text and number, choose the leader to use between 
the text and the page number. Choose either an Em Dash, Em Space, En 
Space, Horizontal Fill, Leader Fill, Space, or Tab. The default is a space.

8 Click OK to create and view the table of contents.

Note: The TOC is highlighted in grey. You can turn this off by unchecking 
Variable Highlights in the View menu.

Updating and Editing a Table of Contents
Once you have created a TOC, you can edit it using a dialog box, or you can 
choose a menu option to request an update of all TOCs. While editing a 
document, all TOCs are updated to show the most current view of entries in a 
doc. Studio automatically updates all TOCs during preview and job submission. 

If you make format changes to text styled with TOC styles, those changes show 
up in the TOC entry as well.
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 To edit a local Table of Contents

1 Position the cursor within the TOC you want to edit.

2 Choose Text  Edit Table of Contents.

This displays the Edit Table of Contents dialog box.

3 Make any changes you want to the entries or text styles.

4 Click OK to update page numbers and add any new appropriately styled 
entries.

 To update all Tables of Contents

 Choose Text  Update All Tables of Contents.

Viewing TOCs in the Document Area
Studio highlights table of content entries and page numbers in light gray. You can 
turn this highlighting on or off using the Variable Highlights option on the View 
menu.

 To toggle highlighting Tables of Contents in the Document window

 Choose View  Variable Highlights

Studio highlights your TOC entries and page numbers in light gray.
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Viewing TOCs in the Layout Tab
Studio labels the table of contents with an icon in the Layout tab.

Overriding the Text Content of a TOC Entry
By default, the text of a table of contents entry will be the exact text to which the 
associated style applies. You cannot edit the text directly in the TOC. If you want 
to edit the text in the TOC, you can use the Info tab in the Property panel to 
supply alternate text to be used instead of the styled text in the TOC.

 To supply alternate text for a TOC entry

1 Highlight the original text for the TOC Entry.

2 From the Properties panel, choose the Info tab. 

3 Enter your preferred text in the box to the right of the TOC Override Text.

Note: You have access to this option whether or not the style of your text 
selection is included in a TOC definition in your document. Studio will use 
the new text you supply if the style is included, and ignore the text if not. If 
you leave the Text Range field blank, the styled text remains in the document 
in your TOC.
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Creating Projects

This chapter describes how to create, open, and save projects in 
Pageflex Studio. Projects tie together all the components of variable-
data publishing.

This outlines the format of project files and explains how to add data 
sources and map variables. It also discusses the difference between 
database jobs that use content data sources and Web-based 
transactional jobs that use Web forms as a profile data source.
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Understanding Projects
A Pageflex project is a set of variable data and job definitions stored within a 
project file (with a file extension of “.pf”). Studio places project files in project 
folders, which contain document template files (with file extensions of “.xdt” 
and “.tsl”) and subfolders for other resources needed by a project such as text, 
images, scripts, Web pages, and data base files. Use Pageflex projects to produce 
documents driven by input data and submitted to a driver to generate output.

The contents of project folders vary based on the design of the document to be 
produced, as well as how the data for document production is collected. Data for 
Web-to-print jobs can be entered by a user typing into Web page forms, while 
other jobs can be driven directly from database records. In addition, content used 
to populate a variable document can be stored directly in the project folder, or 
elsewhere in a asset management database.

Project Folders
Project folders provide the “input,” the information that goes into each 
document in a job. Studio creates these project folders when you create a new 
project. You work with these folders while using Pageflex Studio to create the 
final job.

Every project has a main project folder with five or more folders inside it. The 
folders inside the main project folder are named for the type of content files they 
contain. Do not change the names of these folders.

If the project was unpacked by Pageflex Packager, there may be a Project Fonts 
folder in the main project folder. The machine generating the output must have 
these fonts installed in order to properly output the job.

Note: If your projects share the same content, you can use the same folder for 
both projects. 

 main project folder
 Area Templates
 Images
 Document Actions
 Scripts
 Text
 WebPages
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When you create a new project, Studio creates an associated project folder in the 
file system, with subdirectories for other project contents, as shown in the list 
below. These subfolders provide a structure for users to add templates and other 
project content as they work to build a working variable data production.

 Area Templates. You should store any area templates you create for variable 
productions in this folder.

 Images. Any images that you use in your project should be stored in this 
folder.

 Document Actions. Store scripts that will be used for document actions 
here.

 Project Fonts. Fonts are stored in this folder when you use Pageflex 
Packager to consolidate projects.

 Scripts. Store any Visual Basic or JavaScript scripts in this folder.

 Text. Store formatted character and paragraph files in this folder, for use with 
variables.

 WebPages. Store Web pages in this folder.

The screenshot below displays the contents of a typical project folder.
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When you open a project in Studio, the Project panel displays its job and variable 
definitions as well as the supporting project folder template and content files in 
three tabbed views:

 Variables Tab

 Jobs Tab

 Files Tab

These tabs are described below.

Variables Tab
The Variables tab contains a list of the variables in your project, and a toolbar 
with buttons to add a data source, add variables, apply variables, and remove 
variables.
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Jobs Tab
The Jobs tab contains a list of the jobs in your project, and a toolbar with buttons 
to add a job, preview a job, preview a job with the current template, and generate 
output for a job.

Files Tab
To help you access and edit files, the Files tab offers a filtered view of project 
folder contents.

A Pageflex project file is identified with the extension .pf. When you create a 
project, you identify the data source for your templates and variables. 

A profile data source, typically a database, houses the records that build a suite 
of variables for use in Pageflex documents. Each record in the profile data source 
creates one final document. 

A profile data source can be external to Pageflex.  You can submit transactional 
jobs from a Web browser or another application, for example. In this case, the 
profile data source is the information submitted from the other application.
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A content data source is the directory to use to generate content variables. 
Content variables are created programmatically by rules, Library queries, scripts, 
or Plug-ins. You can use profile variables to create content variables. Profile 
variables are required for all projects while content variables are optional. To 
manage a content data source, you can use one of the options below or a 
combination of them. Profile variables get their values from the profile data 
source, or from a constant value you specify.

 Your file system. Pageflex has a default hierarchy of folders for storing 
content data source files. Pageflex Studio creates these folders when it 
creates the project.

 Pageflex Librarian. You can catalog content source files using categories for 
the purpose of retrieving these files for your Pageflex project. With Pageflex 
Studio, you can create queries to the contents stored in Librarian.

 An asset management database. Through an optional content source 
plug-in, you can create queries to contents stored in an asset management 
database application.

Storing Content in the File System
Using the file system as a content data source involves setting up folders to store 
static and variable contents. Pageflex projects have a default hierarchy of folders 
that Studio creates for every project, and it always searches the default folders 
first for contents.

Pageflex Studio automatically creates the default folders when you create a new 
project and displays the following views within the Files tab:

 Templates, for displaying template files (.xdt/.tsl)

 Library, for displaying file collections made with Pageflex Librarian (.pfl)

 Area Templates, for displaying and storing area template files (.xat)

 Images, for displaying and storing image files (.tif, .eps, .jpg, .pdf, and .gif)

 Project Fonts, for displaying and storing fonts if folders have been packaged 
and unpackaged using Pageflex Packager (.ttf, .pfm, .pfb, and .otf)

 Scripts, for displaying and storing scripts (.vbs and .js)

 Text, for displaying and storing plain text, formatted text, and formatted 
paragraph files (.txt, .xft, and .xfp)

 WebPages, for displaying and storing Web interface pages (.htm, .html, 
.xml, .asp, and others)

As you gather the content for your project, store it in the appropriate folder to 
make it available to your Pageflex project.
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Working with Transactional Jobs
A transactional job is a job submitted from a Web page or another application. 
Typically, you set up a transactional job to create one record at a time. The person 
requesting the job through a Web page submits the variable information for the 
job. This information becomes the profile data source for the job. 

A transactional job uses all the same project resources as a non-transactional 
one, with the one exception of the profile data source named in the project file. 
The information submitted with the job takes the place of the profile data source 
information.

You can preview a transactional job in Studio.

Note: You can create and preview transactional jobs with Studio, however, you 
need Pageflex Server or Pageflex Storefront in order to run these jobs. See 
Chapter 14, “Generating Output with Pageflex Server,” on page 351 for details on 
how to generate job output.
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Building New Projects
Follow the steps below to create a new project.

 To create a new project

1 Choose File  New  Project

-or-

Click the Project icon  in the toolbar.

This displays the New Project dialog box.

2 Under Project Name, enter the name of the project.

3 Under Project Folder, enter the location of the folder that you would like to 
use for project files, or use the folder icon to browse to a location.

4 Check the box to "Create initial template and job" if you want to 
automatically create a template and job associated with this project.

5 Click OK to create the project. If you have checked the box to create an initial 
template and job, you will see the Template Setup dialog. See “Building New 
Templates” on page 39 for instructions. The initial job will be associated with 
this template.
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Opening an Existing Project
Follow the steps below to open an existing project.

 To open an existing project

1 Choose File  Open or click the open icon  in the toolbar. This displays 
the Open File dialog box.

2 Locate the project and click Open. You can open only one project at a time. 
You cannot open a project if another user has it open.

3 Click OK to open the file in Studio
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Saving Projects
Follow the steps below to save a project.

 To save a project

1 Choose File  Save Project or choose File  Save Project As or choose 
File  Save All or click the Save Project  icon in the toolbar or click the 
Save All  icon in the toolbar. This displays the Save Project As dialog 
box.

2 Enter a File name for the project.

3 Click Save to save the project.

 To save current project and all open templates

You can save the current project and all open templates with Save All.

1 Choose File  Save All or click the Save All  icon in the toolbar

2 Enter a File name and click Save for each new template. Your project and 
previously saved templates are saved with their current names.
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Packaging Projects
Since Pageflex projects contain images, fonts, and other elements that can exist 
in multiple locations on your network, you cannot copy or move projects using 
only the file system. Studio enables you to package projects for this purpose. 
Pageflex Packager consolidates project files into a package with .zip extension 
which it can then open on the target system. Create packages using the stand-
alone Pageflex Packager application (see Chapter 17, “Packager,” on page 387 for 
details), or by following the steps below in Studio.

 To package a project

1 Choose File  Make Packager Zip. This displays the Save Package File 
dialog box.

2 Enter a File name for the package.

3 Choose a compression level.

4 Click Save to save the package. Open the package by using the Pageflex 
Packager application, located in the Pageflex installation directory, and 
accessible from the Studio program menu from the Start menu.
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Connecting to a Profile Data Source
Studio connects to the profile data source using ODBC (Open Database 
Connectivity). You can use any ODBC-enabled database as a profile data source. 
You can connect to the profile data source in one of two ways:

 If you are using a Microsoft Access database (.mdb) or a comma-separated 
value (.csv) file, you can connect directly to the database file. Connecting 
directly saves you the trouble of setting up the data source through the 
ODBC Control Panel.

 If you are using an ODBC-enabled database, you must first set up a 
connection to it through the ODBC Control Panel. See “Setting up a Profile 
Data Source” on page 243.

Note: While you can use a Microsoft Excel (.xls) file, you should change the file  
to a Microsoft Access database file or export it as a CSV file and assign it to as the 
data source, as Microsoft Excel spreadsheets have a tendency to insert extra rows 
of blank records when used as data source files, which can produce erroneous 
output records.

Working with Databases
Databases allow you to assign a data type for each field in the database. A data 
type identifies the kind of data the field contains and what operations you can 
perform on the data. For example, number fields can only contain numbers, and 
you can use them in numeric calculations. Text fields can contain almost any 
combination of letters, numbers, and symbols, but you cannot perform 
arithmetic calculations on them.

Database applications provide automatic formatting features to make the data 
appear a certain way. These automatic formatting features change only the 
appearance of the data, not the actual value of the data. For example, if your 
database has a field for storing a dollar amount for the cost of something, the 
data may appear as “$1,200.00” in the database even though you typed “1200” to 
enter the data. The currency symbol and the comma are a part of data filter 
applied to the numeric data in the field to keep the data looking consistent. 

When you work with a database in a project, make sure all the fields in the 
database use the Text data type, and that the data in each field appears exactly as 
you plan to use it in your project. Do not use any automatic formatting features 
of the database application because Studio cannot read such formatting. Your 
data appears in the Studio application without special formatting.
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Using a Microsoft Excel Spreadsheet as a Database

We do not recommended that you use Microsoft Excel as a data source, as Excel 
does not allow you to declare data types explicitly, which may cause corruption to 
your data. This is because spreadsheets support mixed data types in a column. 
For example, one cell can be text, another can be a date, another can be a number, 
and so on. Because of this, the ODBC driver makes a best guess at what the data 
in the column is, based on the format of all of the data in the column. Sometimes 
this guess can be incorrect, corrupting your data. 

Databases avoid this problem by forcing you to declare your data type ahead of 
time. You can change all your cells to text in Excel to avoid this issue, but doing 
so only changes the new data, not any existing data in the cells. So unless you do 
this from the onset, in most cases you will have to retype any data that is already 
in the cells.

 If you must use Excel, we recommend that you save your Excel file as a CSV and 
use the CSV as your data source.

Using a Microsoft Access Database

To use a Microsoft Access database, follow these guidelines.

 Define all fields using the Text data type. 

 If you import data from another application into a new table, you can choose 
the Text data type for each field during the import process.

 Do not use the Input Mask property or the Format property to format the 
appearance of data in a field. 

Setting up a Profile Data Source
If you are using an Access database, save the file in a location where Studio can 
work with it. The main project folder is a good location for this file.

If you are using an ODBC-enabled database, you must set up an ODBC 
connection to it. You can set up this connection at any time using the ODBC 
Control Panel. 

Note: You must set up ODBC on each computer you use. If you set up your 
data sources for creating the project using Studio, you do not need to set them up 
again for if you are using the same computer. However, if you change computers, 
or if you transfer the project file to another computer, you must set up the 
identical ODBC connection for the new computer.
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 To set up an ODBC data source with ODBC control panel

1 In Windows 2000, choose Start  Programs  Control Panel  
Administrative Tools

2 In the Administrative Tools window, double-click the Data Sources (ODBC) 
icon.

3 In the ODBC Data Source Administrator window, click the System DSN 
(Data Source Name) tab to display the current list of system DSNs.

4 Click Add to add a new DSN.

5 In the Create New Data Source dialog box, select the appropriate driver for 
the type of database you are using as a profile data source, and then click 
Finish.

6 Windows displays a window for setting up ODBC for the type of database 
you have selected. 

 Under Data Source Name, type the name for this data source. The Data 
Source Name must match the Data Source Name in the Studio project 
file.

 Under Description, you can add a description of the data source to help 
you identify it. This information is optional.

 The remaining options in this dialog box vary according to the driver you 
have selected. These options provide information for the ODBC driver to 
locate the database and read its contents.

Click OK twice to save the changes and close the dialog box and the ODBC Data 
Source Administrator.
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Adding a Data Source
All projects require a data source. The data source provides the connection to the 
profile data source. A data source can be an ODBC-compliant database, Microsoft 
Access database file, Microsoft Excel workbook, or a CSV file. Additionally, you 
can create a transactional job that uses data from Web browser forms or other 
applications. However, in order to generate output for these jobs, you must use 
Pageflex Server or Pageflex Storefront.

Note: Although each project can have only one data source, you can use more 
than one table from the database.

Adding the data source also involves mapping the fields in the data source to 
become variables in the project. Studio can create variables automatically with 
the same names as the fields in the database, or you can manually create each 
variable with a unique name.

 To add a data source

1 Choose Variables  Data Source or click the Add Data Source icon  on 
the Variables tab of the Project panel.

2 Select the Source Type.

 ODBC Data Source. Choose this option if you are using an 
ODBC-compliant database.

 Database File. Choose this option if you are using a Microsoft Access, 
Excel, or CSV database file.
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Using an ODBC data source

 Select ODBC Data Source, and click OK. Studio displays the Select 
Data Source dialog box.

 Click the Machine Data Source tab to view the list of available data 
sources.

 Choose a data source in the list, and click OK. 

To create a new machine data source, click New. Studio launches the 
Data Source Wizard to help you set up a new ODCB connection. See 
“Using the Data Source Wizard” on page 252 for more information. 
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Using a database file

You can use Microsoft Access (.mdb), Microsoft Excel (.xls), or comma-separated 
text (CSV) files as data sources. Follow the steps below to open a database file.

 Select Database File, and click OK. Studio displays the Open Database 
File dialog box.

 Choose the file type from the file type list below the file name. Locate 
and select the database file, and click Open.
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3 Studio adds the data source name to the Project panel and displays the Data 
Source Setup dialog box. 

4 On the Tables tab, select at least one table to use. 

 Hold down the CTRL key to select more than one table, or hold down the 
SHIFT key to select consecutive tables.

 Click Select All to select all the tables in the list.

 Click Deselect All to select none of the tables.

Note: The list may include some tables created by the database application 
for its own purposes.
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5 Click the Variables Mapping tab. 

In the Table list, select a table. The list includes all the tables you selected on 
the Tables tab.

6 The Field list shows the available fields for the selected table. Select all the 
fields or only the fields you want to use. Hold down the CTRL key to select 
more than one field.

Note: You do not need to select all the fields at this time. You can define 
profile variables manually at any time.

7 Click Map. The new variable name appears next to the field name in the list. 
Studio creates a new plain text variable for each selected field using the same 
name as the field. You can use the Variables tab on the Project panel to 
change to any other kind of variable later.

8 Optional: In the Primary Key list, you can select a field to be the primary key. 
A primary key identifies a field in a database where each value is unique. 
Studio uses the primary key field to identify each record in a job. Having a 
primary key helps identify problem records when you produce the final job.

9 To add variables from more than one table, select the next table in the list 
and repeat the mapping procedure. 

10 Optional: If the database you are using as a data source requires a login name, 
click the Login tab.
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11 Type the Login and the Password in the boxes.

12 Click OK when you are finished mapping. Studio adds the new profile 
variables to the Project panel. 

 To edit the data source

1 On the Project panel, click Add Data Source . Studio displays the Modify 
Data Source dialog box.

2 Choose to Edit the current data source to make changes to the current data 
source.
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 On the Tables tab, you can add more tables.

 On the Variables tab, you can map additional variables.

 On the Login tab, you can type the Login and Password.

3 Click OK when you are finished.

 To change the data source

Each project can have only one data source. Use caution when changing the data 
source for an established project. Variables that you have defined change to a data 
source of None. Studio does not delete the variables. It only removes their data 
source. Any jobs you have created no longer have a data source selected. 

Mapping the variables in the new data source creates additional variables. If you 
want to use the existing variables, you can also edit their definitions to use fields 
in the new data source.

Note: Changing the Source Type between ODBC Data Source and Database 
File creates copies of the existing variables with “_2” added to the name. The 
original variable is changed to a data source of None. You can edit the original 
variables if necessary.

1 On the Project panel, click Add Data Source . Studio displays the Modify 
Data Source dialog box.

2 Choose to Replace the current data source and follow the instructions for 
adding a new data source if you want to replace the data source. See “Adding 
a Data Source” on page 245. 

3 Click OK when you are finished.

 To remove the data source

1 On the Project panel, click Add Data Source . Studio displays the Modify 
Data Source dialog box.

2 Choose to Remove the current data source to remove the data source 
entirely.

3 Click OK to confirm that you want to remove the data source.
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Using the Data Source Wizard
If you need to create a new data source for your project, you can launch the Data 
Source Wizard while adding the data source. The Wizard provides step-by-step 
help with making the ODBC connection to the database you are using. 

You can also set up this connection using the ODBC Data Sources control panel. 
The control panel allows you to add, remove, and reconfigure your OBDC data 
sources. See “Connecting to a Profile Data Source” on page 242 for more 
information. 

 To create a new data source with the Data Source Wizard

1 On the Project panel, click Add Data Source . 

2 Under Source Type, choose ODBC Data Source. 

3 On the Select Data Source dialog box, click the Machine Data Source tab.

4 Click New. 

5 Studio launches the Data Source Wizard to assist you. The Wizard creates 
Machine Data Sources. Machine Data Sources are only available to the 
machine you are using, and they cannot be shared across a network.

Select the type of data source, and click Next.
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 User Data Source. A User Data Source is available only to the user who 
was logged on when it was created. 

 System Data Source. System Data Sources are available to all users who 
log on to this machine. 

6 Select the appropriate driver for the data source. For example, if you are 
using a Microsoft Access database, select Microsoft Access Driver (.mdb).

Click Next to continue.

7 The Wizard displays the driver you selected. Click Finish to close the Wizard 
and open the driver setup dialog box for the driver you selected.

8 In the driver setup dialog box, enter the following information. 

 Under Data Source Name, type the name for this data source. The Data 
Source Name must match the Data Source Name used to create the 
project with Pageflex Studio.

 Under Description, you can add a description of the data source to help 
you identify it. This information is optional.

 The remaining options in this dialog box vary according to the driver you 
have selected. These options provide information for the ODBC driver to 
locate the database and read its contents.
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9 Click OK to close the driver setup dialog box and to return to the list of data 
sources. 

10 Select the new data source in the list, and click OK. 
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Variables

This chapter explains Studio variable types and sources.  It also 
discusses how to apply content and profile data source variables to 
template elements. Topics include defining variables with rules, scripts, 
and library queries and using JScript or VBScript to combine variables 
or evaluate them mathematically.
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Understanding Variable Types
Pageflex Studio uses many different kinds of variables. Each variable holds a 
specific kind of variable content. When you create a template with Pageflex 
Studio, it is important to use the correct container type for each variable.

Plain Text Variables 
Description: Plain text is text without formatting attributes or additional 
tagging information. Plain text is also called ASCII or Text Only. Plain text cannot 
contain any references to variables or any special formatting characters.

Template Container: Plain text variables appear inside text containers. They 
inherit their formatting from the paragraph and character attributes that 
surround the variable.

For example, if you insert a plain text variable inside a paragraph with the style 
Heading applied to it, Studio formats the variable using the Heading style 
because the plain text variable has no formatting of its own.

Formatted Text Variables 
Description: Formatted text is a section of text that belongs within a paragraph 
but does not form a paragraph by itself. Formatted text contains character 
formatting attributes but does not contain any paragraph-level attributes. 
Formatted text can include other variables.

For example, the text may contain bolded words or italicized phrases. The text 
can be as short as a single character or as long as many sentences, provided it 
does not contain a paragraph break.

Template Container: If you use formatted text variables, you must place them 
inside text containers. They maintain the character-level formatting as specified 
when they were created. They inherit all other formatting attributes from the 
paragraph and character styles that surround them. For example, the formatted 
text variable inherits the leading and paragraph spacing attributes from the 
paragraph that contains it.
 256 Variables



Chapter 12
Formatted Paragraph Variables 
Description: Formatted paragraphs contain at least one whole paragraph. They 
contain paragraph-level formatting information, including paragraph styles and 
paragraph spacing. They might also contain additional character formatting. 
Formatted paragraphs can include other variables.

Template Container: Text containers hold formatted paragraphs. They maintain 
the character-level and paragraph-level formatting specified when they were 
created. If the paragraphs have paragraph styles applied, only the name of the 
paragraph style is exported, not the definition of the style. Paragraph style 
definitions are stored with the template file. In other words, a formatted 
paragraph maintains the name of a paragraph style used to create it, but not the 
style attributes. If the template does not define the paragraph style named in the 
formatted paragraph, the paragraph inherits the default “Normal” style.

Image Variables 
Description: Images are the pictures and graphics that enhance the template 
design. Pageflex Studio supports the following image formats: TIFF, EPS, JPEG, 
PDF, and GIF.

Template Container: If you use image variables, you must apply them to image 
containers.

Area Template Variables   
Description: An area template is a section of a template that can contain any 
number of elements. Using area templates as variables allows entire sections of 
your template to vary for each record. 

Template Container: Area templates are always contained within an Area 
Template container. Area Template containers can be rectangles, ovals, or 
polygons.

Document Variables 
Description: Documents are Studio document template (.xdt) files or Adobe 
Acrobat (.pdf) files.

Template Container: Document variables are child documents that are inserted 
into the pages of a parent document template.
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Formatted HTML Variables 
Use formatted HTML variables to tag HTML pages for HTML output. See 
“Creating Variables for HTML Elements” on page 354 for a description and 
details about this variable type.

Formatted HTML Paragraph Variables 
Use formatted HTML paragraph variables to tag HTML pages for HTML output. 
See “Creating Variables for HTML Elements” on page 354 for a description and 
details about this variable type.

Campaign URL Variables 
Use campaign URL variables to tag campaign-related output. See the Pageflex 
Campaign Manager Guide for a description and details about this variable type.

Campaign HTML Form Variables 
Use campaign HTML form variables to add automatically-generated form fields 
to your campaign-related output. See the Pageflex Campaign Manager Guide for a 
description and details about this variable type.

Note: You cannot submit campaign variables for output with Studio.
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Understanding Variable Sources
Variables are divided into two classes: profile variables and content variables. 
Profile variables get their values from the profile data source, or from a constant 
value you specify. Profile variables are required for all projects, while content 
variables are optional. You can use profile variables to create content variables. 
Content variables allow you to add more personalization to your documents. You 
cannot use a content variable to create or otherwise change a profile variable or 
any other variable. 

You can also change the source or type of a variable as needed. For example, you 
can change a profile variable from using plain text to an image variable where the 
text is the name of an image file.

Profile Variables
The first profile variables are created when you add the Data Source and map 
the fields in it to new project variables.

Profile variables have two sources:

 Profile Data Source Table.  The tables you specify when you add the Data 
Source are the profile data source tables. The variable gets its value based on 
a field in the database table.

 Constant.  A constant is a variable that does not change its value. 

Content Variables
You can create content variables to add other kinds of variables in addition to 
the variables from the profile data source. Content variables can be text, images, 
or formatted content you add to enhance the customization of your variable 
project. You use profile variables to define the content variables. You cannot use 
content variables to define other content variables.

For example, to add an image based on a profile variable, you can create a content 
variable that examines the values in a profile variable and selects the images to 
use. The content variable can calculate a result from a script, or it can use a rule 
to decide which image to use. 
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Content variables can have the following sources:

 Rule. A rule is a set of conditions and results. 

 Script. Studio can evaluate both JScript and VBScript to define a variable.

 Library Query. If you use Pageflex Librarian to categorize the content data 
source files, you can write a library query to select the content files to use 
based on those categories.

 Content Source Plug-Ins. You may have additional content source plug-ins 
for Studio. Plug-ins allow you to connect to media asset management 
systems and other types of databases.

Source Files for Content Variables
A content variable definition can be a rule, a script, a library query, or a content 
source plug-in. The source files must be stored in specific locations in order for 
Studio to use them. The location of the source files depends on the source type of 
the variable.

 If you define a variable with a rule, a script, or a library query, you must store 
the source files for the variable inside the matching folders within the main 
project folder. The Text folder contains plain text, formatted text, and 
formatted paragraphs together. The names of the other folders indicate the 
kind of content they store.

 If the variable definition relies on a content source plug-in, please consult the 
documentation for the plug-in for more information. A content source 
plug-in can have its own requirements for the source files.

Main Project Folder

 Area Templates

 Document Actions

 Images

 Project Fonts

 Scripts

 Text
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Adding or Editing Variables
You can add or edit a variable at any time. You can edit any of the information for 
a variable, including its name, kind, or even its source. For example, you can 
change the variable source from a rule to a script. You can even change a profile 
variable to a content variable. However, when you change the source of a 
variable, you must also change its definition.

 To add a variable

1 Choose Variables  Add Variable or on the Variables toolbar, click the Add 
Variable icon . Studio displays the Edit Variable dialog box.

2 Enter the following information.

Box Name Description

Name Type a name for the variable. Names must 
begin with a letter. After the first letter, you 
can use letters, numbers, and the underscore 
character (_). Do not use spaces.

OK to publish 
without value

If you select this option, the driver generates 
output even if this variable is empty.
If you clear the check box, and the variable is 
empty in a record in the job, the driver 
generates an error when you run or preview 
the job.
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3 In the Source box, choose a source for the variable. See “Understanding 
Variable Sources” on page 259 for more information, or the specific sections 
mentioned below.

 Profile Data Source Table. See “Defining Profile Data Source Variables” 
on page 266.

 Constant. See “Defining Constant Variables” on page 267.

 Rule. See “With a Rule” on page 268. 

 Script. See “With a Script” on page 271. 

 Library Query. See “Using a Library Query” on page 275.

 Content Source Plug-in. See “With a Content Source Plug-In” on page 
276. 

4 Based on the Source you selected, enter the definition of the variable under 
Definition. 

 To duplicate a variable

1 In the Project panel, click the Variables tab. Studio displays a list of the 
variables in the project.

2 Click a variable to select it and choose Variables  Duplicate Project 
Variable.

3 Edit the information for the variable.

Note: If you change the Source, you must also change the definition of the 
variable.

4 Click OK to duplicate the variable.

Kind Choose the kind of variable. See 
“Understanding Variable Types” on page 256.

As File Click the check box if the result of the script 
produces a file name for Studio to ingest. For 
image variables, this option is always selected.
Clear the check box if the result is literal text 
you want to appear in the document.

Box Name Description
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 To edit a variable

1 In the Project panel, click the Variables tab. Studio displays a list of the 
variables in the project.

2 Double-click a variable to open the Edit Variable dialog box or click a 
variable to select it and choose Variables  Variable Setup.

3 Edit the information for the variable. 

Note: If you change the Source, you must also change the variable’s 
definition. 

4 Click Apply to save your changes. 

Adding a Variable to a Template
Once you open a project, you can add the variables from the project to the 
template. As you add each variable, Pageflex Studio updates the Layout tab to 
show the variable name in the Variable column. 

You can add variables from the Variables list by:

 Dragging and dropping variables onto elements

 By using the Apply Variable  icon on the variables tool bar. 

To delete a variable, right-click on the variable in the variables list and choose 
Delete Project Variable.

 To add a variable using drag and drop

1 Choose View  Project  Variables. Studio displays the list of variables 
for the open project.

2 Drag a variable from the list. As you drag the variable, the cursor changes to 
a plus sign (+) whenever you are over an acceptable location to add the 
variable.

 To add a variable to an existing container, drag the variable into the 
container.

 To add a variable into a new container, drag the variable to an empty area 
on a page. Studio adds the appropriate container for the variable type.
Variables  263



Pageflex Persona Cross Media Suite User Guide
 To apply variables using the Variables list

1 Select a location for the variable. 

 To apply text variables, use the Text tool . 
Click inside a text box or text oval to position the text cursor.

 To apply image or area template variables, use the Selection tool . 
Click an image container or an area template box.

2 Click a variable in the variables list

3 Click the Apply Variable icon on the variables tool bar  or choose 
Variables  Apply Variable. 

Note: If the Apply button is unavailable, the type of variable you are trying 
to apply is incompatible with the selected container element. For example, 
you cannot apply a text variable to an image container.

 To remove a single or multiple selected variables

1 In the container, select the variable or variables you want to remove.

 For text variables, use the Text tool .

 For image and area template variables, use the Selection tool .

You cannot combine the two types of variables in one selection.

2 In the Variables list, click the Remove Variable icon . Studio removes the 
selected variable or variables. For text variables, Studio leaves the text for the 
variable names as plain text inside text containers that used to contain 
variables. Use the Text tool  to delete the text. 

 To remove all variables

1 Choose Variables  Remove All Variables. 

2 This action is irreversible.  You see a dialog box asking you to confirm that 
you want to remove all variables from the template.

3 Click OK to have Studio remove all text, image, and area template variables 
from the template. 

The names for text variables remain as editable text in this case as well. 
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Variables displayed on Layout tab

When you apply a variable to the template, the variable is displayed on the 
Layout tab next to the element.

As shown above, when a formatted paragraph variable is applied to a paragraph, 
the paragraph displays as a Multi-Paragraph element in the Element column on 
the Layout tab, with the name of the variable in the Variable column. When a 
plain text or formatted text variable is applied to text, it displays as a Character 
element. Image and Area Template variables are displayed in the Element 
column with the names of any applied variables in the Variable column.
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Defining Profile Data Source Variables
 A profile data source variable is a variable that gets its value from a field in 

the profile data source. You can create a profile variable manually if you do not 
want to create it when you add the data source. You can also do this if you change 
the data source and need to re-map existing variables to the new data source.

 To add a profile data source variable manually

1 Add a new variable, or open an existing one to edit its definition. See “Adding 
or Editing Variables” on page 261.

Studio displays the Edit Variable dialog box.

2 In the Source box, choose the table in the profile data source that you want 
to use. The table name follows the data source name.

3 Under Definition, select the field in the data source to use as a source for the 
variable. The list shows all available fields in the table you selected in the 
Source box. 

4 Click OK to save the variable. 

Profile Data 
Source name

Table in data 
source
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Defining Constant Variables
  A constant variable is a profile variable with a constant value. It does not 

change from record to record. Although the name sounds like an impossible 
contradiction, constant variables have many uses. For example:

 You can define a constant variable for a term or name that may change while 
you are developing the project. For example, you may be using a prototype 
name for your product while the final name is being determined. If you use a 
constant variable for the name, when you change the value of the variable, 
the name changes automatically throughout the project.

 If you are submitting transactional jobs from a Web browser or another 
application, you can use constant variables as place holders for pieces of 
information that the other application submits. 

Since a constant variable is a type of profile variable, you can use it to define 
content variables.

 To create a constant variable

1 Add a new variable, or open an existing one to edit its definition. See “Adding 
or Editing Variables” on page 261.

Studio displays the Edit Variable dialog box.

2 In the Source box, choose Constant. 

3 Under Definition, type the constant in the Value box. 

4 Click OK to save the variable. 
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Defining Content Variables
A content variable definition can be a rule, a script, a library query, or a content 
source plug-in.

With a Rule
  A rule defines the conditions Pageflex Studio uses to select each instance of a 

content variable. A rule is made up of conditions and results, also called 
“if… then” statements. If a condition is true, then Studio uses the matching 
result. The condition (the “if” part) checks if a value in a profile variable is 
related to the value of another profile variable or to a value you specify. The result 
(the “then” part) provides the value of the variable for Studio to use if the 
condition is true.

A rule can have one condition and one result, or it can have several conditions 
and several results.  A condition can have multiple lines linked together with 
“and” or “or.” The rule ends with a default result, the result to use if none of the 
conditions are true.

When you define a rule, you need to consider the complete range of conditions 
that are possible, and then provide a result for each condition. For example, if 
you are building a rule around a particular field in a database, then you need to 
consider all the possible values for that field. You should always provide a final 
result to use if none of the conditions are true, even if the final result is empty. 

 To define a content variable with a rule

1 Add a new variable, or open an existing one to edit its definition. See “Adding 
or Editing Variables” on page 261.
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Studio displays the Edit Variable dialog box.

2 In the Source box, choose Rule. 

3 Under Definition, build the conditions and results statements that make up 
the rule.

Delete an “if” statement

Move a 
statement 
up and down

Duplicate an 
“if” statement

Add a new “if” statement

Condition

Default 
Result

Result
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Note: The buttons to delete, duplicate, and move the “if” statements are 
active only if you select the first line of the condition.

To create the condition, choose or enter values in the four boxes as shown 
below:

 Choose a profile variable.

 Choose a qualifier: Is, Is Not, Contains, Starts With, or Ends With.

 Choose another profile variable, or type a value in the box. This box can 
be blank for an empty value.

 To add another line to the condition, choose And or Or.

4 In the Result Is box, choose a result from the list, or type a value for the 
result. 

 If you selected the As File check box, the box displays the variable 
source files available for the variable Kind you selected. These content 
files are stored in the Text, Images, or Area Templates folders for the 
project. 

 If you did not select the As File check box, type the result as text. 

For example, if you have the following rule definition:

If the As File check box is selected, Studio inserts the contents of the text file 
dog_text_file.txt into the text container.

If the check box is not selected, Studio inserts the literal text 
“dog_text_file.txt” instead.

Profile variable Qualifier Another profile 
variable or 
literal text

And/Or link
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5 Continue to build the variables definition.

 To add more “If” statements, click the Add a New “If” Statement 
button .

 To duplicate a statement, click the duplicate button . 

 To delete a statement, click the red delete button  next to the word “If” 
or “Else If.” 

 To delete a line in the condition, click the black delete button for that 
line.

6 Finish the rule by choosing or typing a default result in the Otherwise 
Result Is box. This is the result if none of the conditions are true. You can 
leave this blank, but remember that if none of the conditions are true, the 
result is empty.

Note: The driver displays an error when you run the job unless you also 
select the OK to publish without value check box.

7 Click OK to save the variable. 

With a Script
  Scripts extend the range of possibilities for content variables. With scripts, 

you can perform operations and calculations on the profile variables to create 
new content variables. Scripts also let you mathematically evaluate profile 
variables, something you cannot do using rules. For example, you can define a 
variable based on whether the value of a profile variable is “greater than” or “less 
than” another value. 

Scripts can refer only to profile variables, not other content variables. You cannot 
use a script to change the value of another variable. The result of a script affects 
only the variable it is defined for.

Studio supports two scripting languages:

 JScript®— an object-oriented scripting language developed by Microsoft, 
mostly compatible with JavaScript and EcmaScript.

 VBScript®— a subset of the Microsoft® Visual Basic® programming language

You can decide which language you want to use. This guide provides a brief 
explanation of some basic scripts. It does not explore the full range of capabilities 
for using scripts. For a complete explanation of both JScript and VBScript, visit 
the Microsoft Web site at: http://msdn.microsoft.com/scripting/
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Using Scripts with Pageflex Studio

Pageflex Studio has three requirements for all scripts. 

 You can use only one function per variable.

 You can use Profile variables by reading their values through a special 
function created for this purpose. To use a profile variable called 
profile_variable, for example, use the following syntax:

PFGetValue(“profile_variable”) 

The function PFGetValue is a global function name accessible to scripts 
executed by Pageflex applications. 

 The final returned value from a script must be a text string. If your script 
returns a number, make sure it converts the number to a string for Studio. 

 To define a variable with a script

1 Add a new variable, or open an existing one to edit its definition.
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Studio displays the Edit Variable dialog box.

2 In the Source box, choose Script. 

3 In the Definition section, choose a script language in the Script Language 
box. Choose either JScript or VBScript, to match the script language you are 
using.

4 In the Script File list, select a script file from the list of files saved in the 
Scripts folder. You can use the Script editor to create a new script or to edit 
the current one.
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To use the Script editor:

 Select New, or click the button beside the Script File box . 

 Write a script in the text area.

For help writing JScript, see “Using JScript” on page 279. For help 
writing VBScript, see “Using VBScript” on page 281. 

 Use spaces to indent lines of code.

 Click Save to save the script. If you did not name the script file already, 
Studio prompts you to enter a file name. Use the extension .js for 
JScript, and .vbs for VBScript. 

Studio saves all scripts in the Scripts folder inside the main project 
folder.

5 Type the name you gave the function in the Function Name box.

6 Under Parameters List, add the parameters for this function. Studio passes 
these parameters on to the function. For example, Price(AskingPrice,10000) 
in the example above.

Add fields from your data source by choosing them in the Variables field and 
clicking Add Variable, or add a literal value by entering it into the Literal 
field and clicking Add Literal. Use the up and down arrows to resort the 
parameters list. Or click to highlight a parameter in the list and click 
Remove to remove it from the list.

7 Click OK to save the variable. 

System Variables

Two system variables are available to scripts executed from Studio.

 _sys_ProjectPathName

Reports the project's file full path, such as “C:\Pageflex\Projects\Flyer.pf”
 _sys_JobName

Reports the name of the job, such as “PostScript Job 1”

Sample VBScript:

Function MyProjectPathName()
     MyProjectPathName =  PFGetValue("_sys_ProjectPathName")
End Function
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Using a Library Query

  If you have created a library using Pageflex Librarian, you can define a 
content variable using a library query. A library query finds content files based on 
the associated categories. You create categories and assign values to each 
category for content files when you create the library.

Note: Before you can create a library query, you must create a library inside the 
project folder and define its categories with Pageflex Librarian. 

 To define a variable using a library query

1 Add a new variable, or open an existing one to edit its definition.

Studio displays the Edit Variable dialog box. 

2 In the Source box, choose Library Query. 

3 In the Library box, choose the library to use. You can click View Library to 
start Pageflex Librarian and view the library contents.

Note: If you have not created a library, the Library box is unavailable. You 
must create the library inside the main project folder with Pageflex Librarian 
before you can create a library query. 

4 In the large box below the Library box, begin building the query. 
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A library query can have one or more statements joined together with “And” 
or “Or.” Each statement has four parts, as shown below:

 Library Category. Library categories contain the words used to classify 
each library item. You can also use the filename of the content file. 

 Operator. The operator is the “verb” for the statement. It defines the 
relationship between the library category and the profile variable or 
literal text that follows. 

 Profile Variable or Literal Text. In this box, you can select a profile 
variable to use, or you can type literal text to use to create a relationship 
to the library category. 

 Connector. You can connect multiple statements using the expressions 
“And” or “Or.” 

5 When you are finished building the query, click OK to save it. 

Note: See Chapter 16, “Librarian,” on page 375 for details about using 
Librarian.

With a Content Source Plug-In
With Pageflex Studio you can create additional content variables through content 
source plug-ins. Each plug-in is designed for a specific purpose such as 
connecting to a type of database or performing a calculation. Some plug-ins 
require you to set them up before you can use them to deliver variable content.

Library Category 
or Filename

Operator Profile Variable 
or Literal Text

Connector
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 To set up a content source plug-in

1 Choose Variables  Content Source Plugins. This displays the Source 
Plug-ins dialog box:

2 The dialog box lists all the available plug-ins that have been installed. Choose 
a plug-in from the list, and click Setup.

3 If the plug-in requires setting up, Studio displays a setup box. Follow the 
manufacturer’s instructions for setting up the plug-in.

Consult the documentation supplied with the plug-in for more specific 
information about plug-in features.
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 To define a variable using a content source plug-in

1 Add a new variable, or open an existing one to edit its definition.

Studio displays the Edit Variable dialog box.

2 In the Source box, choose the content source plug-in.

3 Under Definition, click the name of the Plug-In Variable editor to open the 
Content Source Plug-In editor. 

4 Enter the required information for the plug-in. 

5 Click OK to save the variable.
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Using JScript
Use the Script editor in Pageflex Studio or another text editor to write a script. 
JScript uses the following basic conventions.

 Each line begins a new statement. Extra blanks lines and spaces are ignored, 
so feel free to use them to make your code more readable.

 End each statement with a semi-colon (;).

 All names are case sensitive. A variable called FirstName is not the same as a 
variable called firstname. 

 Use two forward slashes (//) for single line comments. 

 Save the file with the extension .js. Save all scripts in the Scripts folder 
inside the main project folder. If you use the Script editor, Studio saves the 
script to the Scripts folder for you.

 To combine two variables using JScript

The following example script shows how a script can combine two profile 
variables into a single variable. This is also called “concatenating.” 

The example uses the following variable names. For your script, substitute the 
variable names that match the variables in your project.

 Profile Variables: first_name and last_name

 Content Variable Name: full_name

In the Studio Script editor window, write a script using this script as a guide. 

function full_name() // combine the first and last names
{

var result = PFGetValue("first_name") + " " +
PFGetValue("last_name");

return result;
}

For example, if the first name is “John” and the last name is “Smith”, the script 
returns the value “John Smith”.
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 To mathematically evaluate variables using JScript

In this example, the script evaluates a numerical field from the profile data 
source to determine which text string to return. It uses an “if-then-else” 
statement to determine which string to return based on how large the customer’s 
total purchases were.

The example uses the following variable names. For your script, substitute 
variable names that match the variables in your project. 

 Profile Variable:  total_purchases

 Content Variable Name:  qualification

In the Script editor window, write a script using the following text as a guide. 

function qualification () //evaluates how much customer spends
{

if (PFGetValue("total_purchases") >= 2000)
result = "Dear Platinum customer.";

else if (PFGetValue("total_purchases") >= 1000)
result = "Dear Golden customer.";

else 
result = "Dear valued customer.";

return result;
}

For example, if the customer spends $2,200, the script returns the text, 
“Dear Platinum customer.” 
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Using VBScript
You can use the Script editor window in Studio or Microsoft Visual Basic® to 
write a script in VBScript. VBScript uses the following basic conventions.

 Separate lines using the Return key. VBScript ignores extra lines and spaces, 
so feel free to use them to make your code more readable. 

 Always use a Function instead of a Sub since only a Function can return a 
value.

 Use the single apostrophe ( ' ) to mark comments. 

 Save the file with the extension .vbs. Save all scripts in the Scripts folder 
inside the main project folder. If you use the Script editor, Studio saves the 
script to this folder for you. 

 Do not nest double quotes (") in double quotes or single quotes (') in single 
quotes. Use a combination of double quotes and single quotes for nesting. 
For example:
result = "<_char font_name='/Charter BT'>Name</_char>"

 To combine two variables using VBScript

The following example script shows how a script can combine two profile 
variables into a single variable This is also called “concatenating.” 

The example uses the following variable names. For your script, substitute 
variable names that match the variables in your project.

 Profile Variables: first_name and last_name

 Content Variable Name: full_name

Using a text editor, write a script using the following text as a guide. 

Function VBFullName() ' combines first and last names
VBFullName = PFGetValue("first_name") & " " 

& PFGetValue("last_name")
End Function

For example, if the first name is “Sam” and the last name is “Brown”, the script 
returns the value “Sam Brown”.
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 To mathematically evaluate variables using VBScript

In this example, the script evaluates a numerical field from the profile data 
source to determine which text string to return. It uses an “if-then-else” 
statement to determine which string to return based on how large the customer’s 
total purchases were. The example uses the following variable names. For your 
script, substitute variable names that match the variables in your project. 

 Profile Variable: total_purchases

 Content Variable Name: qualification

Using a text editor, write a script using the following text as a guide. 

Function vbqualify()
If PFGetValue("total_purchases") >=2000 Then

vbqualify = "Dear Platinum Customer."
ElseIf  PFGetValue("total_purchases") >= 1000 Then

vbqualify = "Dear Golden Customer."
Else

vbqualify = "Dear valued customer."
End If

End Function

For example, if the customer spends $1,500, the script returns the text, 
“Dear Golden customer.”
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Creating Jobs

Templates provide the form for your variable publishing project. Jobs 
are the instructions for creating the final output for the project from your 
templates and variable content. This chapter explains how create jobs. 
It also explains the steps to take if you are using Pageflex Studio to 
submit transactional jobs from a Web browser or another application.
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Overview of Jobs
Jobs are the instructions for creating the final output for your project. You can set 
up as many jobs as you need to generate output in the formats you require. The 
output driver uses the information you supply in the job, along with the data 
sources, variables, and template for the project, to generate output.

Configure jobs using the Job Setup window. Job setup offers the ability to set the 
following job options.

 Record Selection. When a data source exists, you can set rules for the data 
records to use for data ingest. When a data source does not exist, this option 
is not available.

 Output. Set options such as the destination to place final output, page 
ranges to print, and choose content options for images and print 
suppression.

 Marks and Bleeds. Set the crop marks and bleed area for the document. You 
can set this option only for jobs with XDT template-, PostScript-, and PDF-
based formats.

 Page and Sheet. Set the page and sheet imposition styles and sizes. You can 
set this option for jobs only with XDT template, PostScript, and PDF 
formats.

 Document Actions. Specify a sequence of actions to be performed whenever 
a document is assembled during job execution or preview, for example, to 
change form attributes for an element based on profile variable values.

 Post Processes. Choose a program or batch file to perform additional tasks 
after each record is created or after each job is finished, or after both of these 
events have been completed.

The rest of this chapter goes over these job options.

To create a transactional job for Web submissions, see “Creating and Previewing 
Transactional Jobs” on page 340.
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Adding a New Job
Click Add Job  on the Jobs tool bar in the Project panel. Studio displays the 
Job Setup dialog box.

Primary Job Settings
Enter the primary settings for the job at the top of the window.
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 Job Name. Type a name for the job. A job name can include spaces and 
symbols.

 Data Source. Select the data source, or select (none) for no data source. For 
example, you would choose (none) if you are using Studio for transactional 
jobs. See “Creating and Previewing Transactional Jobs” on page 340 for 
details.

Note: If you choose (none), the record selection properties are no longer 
necessary, so these properties no longer appear on the Job Setup window.

 Template. Select a template to use. Each job uses a single template. This list 
displays templates that exist in the project folder, therefore, you must have a 
template in the project folder for it to appear in the list. If the template you 
want to use does not appear in the list, exit the Job Setup dialog and save the 
template to the project folder. Then open the Job Setup dialog again and 
choose the template from the list.

 Format. Select the format for the final output. Click Properties to set the 
format properties, such as the PostScript Printer Description (PPD), if 
appropriate. Once selected, your choice of PPD is listed below the format on 
the Job Setup window, or the text is hidden if the format does not allow for a 
PPD. See “Selecting Output Formats” on page 315 for details.

Record Selection
Select a Data Source and click the Record Selection option to identify the 
records you want to include in the job. Under Selection Tools, click Simple to 
use a set of simple tools for record selection, or click Advanced to enter a SQL 
statement.
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Simple Record Selection

The Simple method lets you select records from a single table in the data source. 
If you are using more than one table in the data source, you must use advanced 
record selection.

 In the In Table list, select the table from the data source.

 In the Sort By list, select a field to use for sorting the records. Studio sorts 
the records alphanumerically in descending order (for example, 0-9 or A-Z). 
If you choose (none), Studio sorts records in the same order as the database 
table. The sort order may be important for arranging records for imposition.

 Under Select, click All Records or click Subset of Records.

If you click Subset of Records, build a statement in the box to specify how 
to select the records to use.
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Begin each statement with a field in the selected data source table. Connect 
that field with an operator to another field or to literal text you type. You can 
connect multiple statements using “and” or “or.”

In the example above, Studio selects the records in which the “LastName” 
field begins with the letter A or the letter S.

Advanced Record Selection

The Advanced method lets you write your own SQL query. In the SQL 
Statement box, type the text of the query. If you are using two tables in the data 
source, you must write a SQL query to join them.

Output
Click the Output option to select output options.

In the Destination field, choose a folder or a printing device to send the final 
output. The Default Output Folder is the Final Output Folder that you set for 
the Pageflex Server host when you configure task processing settings. See the 
Pageflex Server Guide for details. If you are submitting output using Studio, see 
Chapter 14, “Generating Output,” on page 345 for details.

If you want to direct output to a different location—such as to override the Final 
Output Folder set on your Pageflex Server host or send output directly to a 
printer—click the folder icon  to browse for a folder, or the printer icon  to 
browse for a printer.

For Page Range, choose the range of pages to output:

 Click All to output all pages.

 Click Range to enter a range of pages to output. Enter the page range in the 
box. Use a hyphen to denote a consecutive page range and separate non-
consecutive pages with commas. For example, to print pages 1 through 15 
and page 22 and 25, enter “1-15, 22, 25”.

Field in Data 
Source Table

Connector

Text or a Field in 
Data Source
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For Output Files, choose how you want to group output into files.

 Data Record. Choose to generate one document per data record. This is the 
default output method.

 Job. Choose to generate all documents for the job in one combined output 
file.

 Batch. Enter a specific number of data records to combine into a single 
output file. For example, to create output files with 10 data records in each 
file, enter “10” in the data record field, as shown below.

 Page. When producing bitmap or .eps output, you can only choose to output 
one file per page.

Note: If you are going to impose multiple pages on one output sheet, for 
example, using step and repeat or cut and stack imposition styles, you cannot 
generate one document per data record. However, you can create one output file 
per sheet by entering the minimum number of data records per sheet in this field. 
See “Specifying Page and Sheet Settings” on page 293 for more information about 
imposition styles.

Content Options

In the Content Options section, choose whether to omit or include images, 
include low resolution images, or print suppressed elements:

 Images. Pageflex Studio allows you to customize image data output for your 
project. The options you select depend on several factors, such as whether 
you are using an Open Prepress Interface (OPI) server, what type of printing 
device you are using, and whether you are using a content source plug-in that 
supports substituting different image resolutions. Select from the following 
options:

 Omit. Click Omit to send no image data for EPS, TIFF, or JPEG file 
formats. Other formats, such as GIF or placed PDF, are always included.

This is useful if you are using OPI or some other mechanism to insert the 
images downstream. If selected, the output will not include image data 
for the above formats, but will preserve the OPI comments for an OPI 
server to use. In the final output, the job includes only the OPI 
comments and no image data. If you are not using an OPI server, image 
containers will be empty. For VPS, omitted images are supplied by the 
imaging device using a VPS-specific mechanism.
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 Include. Click Include to include image data using the format specified 
under output properties.

If you include images in Binary format, the driver includes the high-
resolution image files and creates Binary data. Select these options if 
your printing device supports it.

If you include images in ASCII format, the driver includes the high-
resolution image files and creates ASCII data. Select these options for 
printers that do not support Binary data.

See “Options” on page 319 for details on how to set the format in the 
Image Format setting for PostScript PPDs or “PDF” on page 320 for 
details on how to set it in the Page Content Format setting for PDFs.

 Low resolution (if available). Select this check box to include low 
resolution image data, if it is available, if you are using a content source 
plug-in. See the Pageflex Programming Reference Guide for details about 
content source plug-ins.

 Suppression. Select the Print suppressed elements check box to override 
the print suppression property. See “Suppress Printing” on page 99 for an 
explanation of the suppress printing property for elements.

Note: If you chose to omit images and print suppressed elements, if the 
suppressed element is an image, it will still be omitted.

Paper Tray Assignments

In the Paper Tray Assignments section, you can assign custom job media name, 
such as cover pages or inside pages to specific paper trays on PostScript printers 
using the PPD Input Slot. See “Adding Paper Tray Assignments” on page 332 for 
details.
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Marks and Bleeds
Click Marks and Bleeds to set these options.

On this page, you can set marks and bleeds for your output. The screen shot 
above displays unit values of Inches, but the units are based on your system 
locale.

The following options are available:

 Crop Marks. Select the Include Crop Marks check box to add crop marks to 
show the edges of the document. Clear this check box to remove crop marks. 
Set the Offset and Length.

Note: If you are using step and repeat or cut and stack imposition styles, 
make sure the paper size you have selected can accommodate the space 
needed for crop marks.

 Bleed Area. Select the Include Bleed Area check box to print any elements 
that extend beyond the edges of the document. Clear this check box to 
disable bleed area. Set the Top, Bottom, Left, and Right margin sizes.
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 Page Information Area. Choose whether you want to show custom 
information in your output.

 Include general page information. Select this check box to add the 
project name, job name, template file name, data record number, page 
number, current date, and current time to the bottom edge of the page, 
outside the bleed area. Clear this check box if you do not want to include 
this information.

 Include custom information. Select this check box to add custom text 
to the bottom edge of the page. Enter the text in the box. 

Click the arrow to choose from a list of system variables to include, such 
as Project Name, Job Name, Transaction ID, Destination Directory, or 
Current Document.

Type system variables in brackets to insert them as custom information, 
for example, to insert the project name, type:
<<_sys_ProjectName>>

Note: Page information extends .5 inches below the page. This space is 
added to display page information, even if no bleed is specified. Consider this 
when setting bleed area margins or footers.

See the sections below for setting page and sheet settings, document actions, and 
post processes. These job options allow you more control over your output. You 
can use the defaults for these options to create a simple job. When you are 
finished setting up the job options, click:

 OK to save the job options and close the dialog box.

 Preview to preview the job on screen using the options you have 
selected. See “Previewing a Job” on page 337. 

 Generate Output to display the Generate Output dialog box. See 
Chapter 14, “Generating Output,” on page 345 for details.
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Specifying Page and Sheet Settings
Click the Page and Sheet option to specify the orientation and scale of each 
document page, as well as how each page will print on a physical sheet of paper.

Imposition Style
Click Imposition Style to configure how each page will be printed on a sheet of 
paper.

Choose from the following imposition styles in the list box to impose the pages 
onto a sheet:

 Single Page. Each page of a document with variables ingested from a single 
data record is laid out on its own sheet.

 Step and Repeat (Single Record). Each page of a document with variables 
ingested from a single data record is repeated on a sheet. The result is that 
each sheet has the exact same document page repeated multiple times on it 
and the number of sheets will correspond to the number of data records—
one record is imaged per sheet.

 Step and Repeat (Multi Record). Each page of a document with variables 
ingested from multiple data records is laid out a sheet. The result is that each 
sheet has the same template page with different data merged on it in a 
sequence across each sheet that corresponds to the order of records in the 
database.

 Cut and Stack (Multi Record). Each page of a document with variables 
ingested from multiple data records is laid out a sheet. Only, the result is that 
each sheet has the same template page with different data merged in an order 
that proceeds sequentially between sheets, resulting in cuttable stacks of 
documents.

Sheets with multiple document pages imaged onto them are most appropriate for 
simple two-sided documents such as business cards and postcards. The 
imposition styles are described in detail below.
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Single Page

Choose the single page imposition style to lay out each page of a document on its 
own sheet, with variables ingested from a single data record, as illustrated below.

This is the default mode for printing. It is appropriate for documents with any 
number of pages. Pageflex Server outputs each page once on its own sheet and 
generates a complete set of sheets for each merged data record. Click Single 
Page in the Imposition Style field to choose this style.

Single page imposition style shows only page options and no sheet options 
because there are no sheet layout options for single page imposition, since there 
is only one page image. Studio determines the sheet size by examining the 
document size plus any marks and bleeds, if no PPD is selected or if it does not 
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Record 1
Page 1

Sheet 2

Record 1
Page 2

Sheet 3

Record 1
Page 3

Sheet 4

Record 1
Page 4
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apply. If you selected a PPD, the PageSize specified in the PPD determines the 
sheet size. Single page imposition style only offers horizontal and vertical scale.

Step and Repeat (Single Record)

Choose the step and repeat “single record” imposition style to lay out each page 
of a document multiple times on the same sheet, with variables ingested from a 
single data record, as illustrated below.

This style is good for getting multiple copies of each page on one sheet. It is 
appropriate to use for documents with any number of pages. Pageflex Server 
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Creating Jobs  295



Pageflex Persona Cross Media Suite User Guide
generates a complete set of sheets for each merged data record. Click Step and 
Repeat (Single Record) in the Imposition Style field to choose this style.
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Step and Repeat (Multi-Record)

Choose the step and repeat “multiple record” imposition style to lay out each 
page of a document multiple times on the same sheet, with variables ingested 
from multiple data records. The illustration below shows a one-sided document 
with eight different merged data records.

This style is good for one- or two-sided cards, such as business cards or 
postcards. Pageflex Server merges different data records in a sequential order that 
you can set to proceed by rows (across from left) or columns (down from top) on 
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each sheet before filling the next one. Click Step and Repeat (Multi-Record) in 
the Imposition Style field to choose this style.

Cut and Stack (Multi-Record)

Choose the cut and stack “multiple record” imposition style to lay out each page 
of a document multiple times on the same sheet, with variables ingested from 
multiple data records and arranged so that documents are stacked in the proper 
page order when cut. The illustration below shows a one-sided document with 
eight different merged data records. Notice the difference between the order of 
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these records and those in the illustration for the step and repeat “multiple 
record” imposition style on page page 297.

The illustration below shows how documents, such as business cards or 
postcards, would be stacked using a 40-record data source. For example, you 
could use this imposition style to arrange postcards by zip code.

Note: The stacks are evened out to impose the maximum number of pages per 
sheet.

Pageflex Server merges different data records in a sequential order that you can 
set to proceed in a stacking order so that when the sheets are aligned and cut, the 
sort order you chose in the Record Selection option in the Job Setup dialog is 
preserved. As with the step and repeat multiple record imposition style, you can 
also set the data merge sequence order to proceed by rows (across from left) or 
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columns (down from top). Click Cut and Stack (Multi-Record) in the 
Imposition Style field to choose this style.

Sheet Size
The Sheet Size displays the size of the physical sheet of paper to impose 
document pages on. For single page imposition, this is the same as the page size, 
plus any marks and bleeds.

If you choose an imposition style other than Single Page, you can set the sheet 
size in the PPD. Most PPDs list the sheet size in the PageSize field. If you are 
using a format that does not support PPDs, such as PDF output, you can choose 
the sheet size from a list box, or choose (Custom) and enter a custom width and 
height (see screen shots below).

If Studio detects a default sheet size from the PPD, it sets the sheet size to that 
value by default. Otherwise, the default setting is (Custom) with 0 height and 0 
width. You must choose a sheet size to produce output using imposition styles 
other than single page. Studio displays a warning if you haven’t chosen a size or 
entered a custom size.
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PDF and Custom Sheet Size

Choose a sheet size from the drop down list, for example, choose Tabloid to 
impose pages onto an 11 by 17 inch sheet of paper:

Choose (Custom) and enter a custom width and height for the sheet:

Note: The units for sheet size—such as inches or millimeters—are derived 
from your regional and language settings in your installation of the Microsoft 
Windows operating system. Click Regional and Language Options in the 
Control Panel to change these settings. Studio uses inches for non-metric 
regions and millimeters for metric regions.

 To set the sheet size with a format that supports PPDs

1 Click Properties next to the Format box in the primary job settings area.
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2 Select a sheet size in the PageSize property. Select Same as Document to 
set the sheet size as the same size as the template page size.

3 Click OK to save these settings.

Page Size
The page size section displays the size of the job template. This information may 
be useful when planning the number of pages to output on a sheet. You cannot 
change these values as they are set in the template.

Note: Set the units for Page Size and all other properties in the Job Setup 
dialog in the Preferences dialog on the Edit menu.
 302 Creating Jobs



Chapter 13
Data Merge Sequence
The data merge sequence section offers options for determining the sequence 
that data records are merged with multiple instances of a document template 
page. The available options for the data merge sequence change based on the 
imposition style you select. A graphic shows an example of how the records will 
be laid out for this type of imposition and data record sequence. The styles are 
described below. 

Since the Single Page imposition style uses one sheet per page, the data merge 
sequence is not used, and is hidden from view.

(No Options)

The Step and Repeat (Single Record) imposition style offers no options for the 
data merge sequence, but the sequence is shown to illustrate how a single record 
will be merged multiple times on a sheet, making all page instances the same.

Across from left

The Step and Repeat (Multi Record) and Cut and Stack (Multi Record) 
imposition styles offer two options. When you select Across from left for the 
data merge sequence, the data is merged by row. Once a row is filled, the next 
row to the right is filled.

Step and Repeat Cut and Stack
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Note: With cut and stack imposition, the data records are filled one on top of 
the other in sheets, so that, for example, you can sort printed output destined for 
the same place in stacks, such as by zip code.

Down from top

The second option offered for the Step and Repeat (Multi Record) and Cut 
and Stack (Multi Record) imposition styles is Down from top. In this data 
merge sequence, the data is merged by column. Once a column is filled, the next 
column below is filled.

Note: With cut and stack imposition, the data records are filled one on top of 
the other in sheets, so that, for example, you can sort printed output destined for 
the same place in stacks, such as by zip code.

Options
The following options are displayed for each imposition style.

Page Options are displayed for all imposition styles.

 Page Orientation. Select an orientation for the template page from the 
choices provided. The page orientation describes the way in which the page is 
oriented on the sheet, not whether the template is a landscape format (wider 
than it is high) or a portrait format (higher than wide) template. Set the 
template orientation using the Template Setup dialog available from the 
File menu in Studio. Use the page orientation to describe how the template 
page is oriented on the sheet.

 Portrait (up). Choose this option to orient the page with the text facing 
up.

Step and Repeat Cut and Stack
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 Portrait (down). Choose this option to orient the page with the text 
facing down.

 Landscape (left). Choose this option to orient the page with the text 
moving from left to right.

 Landscape (right). Choose this option to orient the page with the text 
moving from right to left.

 Horizontal and Vertical Scale. Scale options can only be set for the Single 
Page imposition style. For the other three imposition styles, the values are 
automatically set to 100% and cannot be changed. Enter a percentage value 
in either of these fields to scale the horizontal and vertical axis by that 
amount.

Sheet Options are displayed for all imposition style selections except Single 
Page.

 Number of Page Rows and Number of Page Columns. Enter the number 
of page images to be laid out in rows and in columns on a sheet. The default 
value for each of these is 2.

 Gaps between Rows and Gaps between Columns. Enter the size of the 
horizontal and vertical spaces that should appear between pages on each 
sheet. The default value for each of these is .5 inches.

 Top/Bottom Margins and Left/Right Margins. Enter the minimum size of 
the horizontal and vertical space to preserve around the outside of the grid of 
pages to be printed on a sheet. The default value for all margins is .5 inches.

 Print Style. Select the print style for the output.

 One Sided. Select this option for simplex output.

 Two Sided—Normal Turn. Select this option for duplex output that will 
be flipped over from the right or left side when the back of a sheet is 
printed. This is the default setting.
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 Two Sided—Tumble. Select this option for duplex output that will be 
flipped over from the top or bottom when the back of the sheet is 
printed.

Maximum Pages Per Sheet
The Maximum Pages per Sheet button is displayed for all imposition style 
selections except Single Page. Click this button to raise the Maximum Pages 
per Sheet dialog. This dialog calculates the maximum number of pages that can 
be imposed on the sheet size specified and offers to set the Number of Page 
Rows and Number of Page Column option values to achieve this maximum. 
For example:

Studio calculates the maximum number of pages that can be imposed based on 
the template page size and the currently specified sheet, gap, margin sizes, 
marks, and bleeds. Click OK to accept the suggested page rows and columns or 
Cancel to exit without making changes.

Error Handling: Imposition Setup Problems
The following imposition errors may occur during setup:

 Imposition setup specified doesn’t fit on sheet. The horizontal or vertical 
size of the layout of pages, gaps, and margins exceeds the bounds of the sheet 
size.

 Marks and Bleeds don’t fit in gaps. The size of the crop marks, bleeds, or 
document information marks exceed the size of the page gaps.

 Marks and Bleeds don’t fit in margins. The size of the crop marks, bleeds, 
or document information marks exceed the size of horizontal or vertical 
margins available.
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Configuring Document Actions
Document actions are a series of functions, specified as scripts or compiled code, 
that describe changes that should be made to a document each time it is 
assembled during job preview and execution. These functions can cause a variety 
of property changes to many document elements.

For example, you can change form attributes, such as color, border, or style, of 
template elements based on profile variable values, such as favorite color, gender, 
or age. So if you are designing a marketing campaign that will customize 
documents based on a customer’s favorite color, you can set a document action to 
use this profile variable for the title, picture border, and rule colors in a brochure 
that they order online.

You can use the Name property on the Info tab to refer to elements in a template 
by name in a document action. For example, if you use an element named 
“BackgroundBox” to show a background color in your template, you can write a 
document action script to find this element by name and set its fill color.

You can create document actions using a variety of code file formats, including 
Jscript.NET, VB.NET, C#, and .NET compiled as DLL assembly files. Studio loads 
these files from the Document Actions project folder. See the Pageflex 
Programming Reference Guide for details on how to create document actions.
Creating Jobs  307



Pageflex Persona Cross Media Suite User Guide
Click Document Actions in the Job Setup dialog to display the Document 
Actions section.

The Execute field at the top of the document actions section offers a choice of 
whether default actions or custom actions should be executed when the job is 
run.

Default Actions
Select Default Actions to assemble documents normally. Two document actions 
normally performed by Pageflex, evaluating variables and merging variable data, 
are derived from a virtual PageflexActions file. These are the EvaluateVariables 
and MergeData actions, which are listed and disabled.

Custom Actions
Select Custom Actions to enable the document action controls. You can now 
add, remove, duplicate, and arrange the execution order of all actions, including 
the PageflexAction default actions.

If you create a custom action sequence and then switch back to using default 
actions, you will lose your custom action list when you click OK to close the Job 
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Setup dialog, therefore, Studio displays a dialog to confirm that this is what you 
want to do.

Click Yes to continue to switch to default actions, or No to cancel. If you choose 
to continue, your custom action list is preserved as long as the Job Setup dialog 
is open, which allows you to switch back. However, once you click OK to close 
the Job Setup dialog, the list is lost.

Adding Document Actions
Click Add to add a Document Action file.

The drop-down list enumerates all files in the Document Actions folder as well 
as PageflexActions, the virtual file containing the EvaluateVariables and 
MergeData actions. Select a file and click OK to add the file to the Document 
Action list. When you click OK, Studio attempts to compile the file. If Studio 
encounters any errors in this process, it displays an error dialog and does not add 
the Document Action file.

Removing Document Actions
Select a Document Action file and click Remove to remove it. To cancel 
removal, click Cancel at the bottom of the Job Setup page.

Duplicating Document Actions
Select a Document Action file and click Duplicate to copy it to the bottom of 
the list.
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Moving Document Actions
Select a Document Action file and click the up or down arrow to move it up or 
down in the list. Actions execute from top to bottom in the order listed.

Specifying Action Class, Method, and Arguments
Select a row to reveal controls for specifying class, method, and arguments 
available in the document action file, described below:

 Class. Choose a class from the drop-down list that enumerates all public 
classes found in the file, or “Default” if no classes are specified.

 Method. Choose a method from the drop-down list that enumerates all 
static, public methods with string arguments for the selected class.

 Arguments. This field displays the arguments chosen for the action and a 
Set Arguments button. Mouse over this field to display the full text of the 
arguments. When the action requires no arguments, this field displays
“(No Arguments)” and disables the Set Arguments button.

Click the Set Arguments button to set arguments. This brings up the Set 
Arguments dialog.

The dialog lists all arguments required by the method with the name in the 
Argument field, a drop-down list box with choices for the value type in the 
Value Type field, and the value in the Value field.
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Choose from two different value types, constant or variable, described below:

 Constant. Choose this value type for Studio to interpret the value as a 
string constant. The Value field becomes an editable text field where any 
value can be typed.

 Variable. Choose this value type for Studio to interpret the value as a 
variable name. The Value field becomes a drop-down list box that 
enumerates all project variables.

Compilation Errors
When you click the Class, Method, or Arguments controls on a selected row, if 
the date and time of the file when it was first compiled and added is out of sync 
with the date and time of the file when the row is clicked, then Studio makes a 
new attempt to compile the action. If Studio finds errors, it displays the 
Compilation Errors dialog to indicate the problem.
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Adding Post Processes
A post process is an executable program (.exe), a batch file(.bat), or script you 
create to perform additional tasks after each record is created, after each batch 
file is created, or after the whole job is completed. For example, you can create a 
post process to move files to another folder or to attach a final PDF file to an e-
mail message.

The post process can use any user-defined variables in the project as arguments. 
It can use the profile and content variables you created for your project, as well as 
system variables defined during output creation. System variables include values 
such as the Project Name, the Job Name, and the Transaction ID. For a complete 
list of system variables, see the Pageflex Server Guide. You can pass system 
variables as arguments to the post process.

When processing a record or job that has a post process, the output driver 
launches the post process and then moves on to the next record or job without 
waiting for the post process to complete.

 To add a post process

1 Open an existing job or add a new one. See “Adding a New Job” on page 285.
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2 Click Post Processes and select the Execute Post Process check box (Clear 
this check box to prevent post processes from being executed). Studio 
displays the Post Process Setup dialog box.

You can add post processes in three areas:

 Record. The driver will run a record post process after creating each record.

 Batch. The driver will run a batch post process after creating each batch.

 Job. The driver will run a job post process after creating the job.
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Fill in the post process fields as explained in the table below.

Box Name Description

Executable Enter the full path to the post process file, either an 
executable program (.exe) or a batch file (.bat).
Click the folder button to browse for the file. The file 
must be available to the computer running Pageflex 
Studio or Server.

Arguments You can pass arguments to the post process from 
Pageflex Studio or Server by typing the argument in 
the Arguments box with a space between arguments.
To pass a user-defined variable or system variable, 
type the variable name in double angle brackets, such 
as <<FirstName>>, for example. Click the button 
beside the Arguments box to select a 
commonly-used system variable from the drop-down 
list. See the Server Setup and Reference Guide for a 
complete list of system variables.
 314 Creating Jobs



Chapter 13
Selecting Output Formats
In the Format drop-down list on the Job Setup dialog, select the format for the 
final output. There are several different formats you can use, including custom 
formats created with the Pageflex renderer plug-in interface. The most common 
formats are listed below.

Note: Studio displays all supported formats in the drop-down box, but you will 
be able to generate output only with those you have licensed to use.

 Bitmap. A format that generates a simple raster image (JPEG, TIFF, etc.) 
representation of a document page. This may be useful for previewing and 
proofing output, as well as printing on non-standard devices.

 Convert PostScript to PDF. This format uses Adobe Normalizer to create 
PDF output. It generates PostScript output and processes the output with a 
Distiller joboptions file to produce a PDF file. Be sure that the Template 
orientation (“Building New Templates” on page 39) and the Page orientation 
(“Options” on page 304) are configured to produce the output you desire. 
See “PostScript” on page 318 for instructions on using a PPD.

 CreoScitex VPS. A variable data format based on PostScript. It allows 
caching of images to maximize printing speed.

 Document Instance. A format is unique to Pageflex projects. A document 
instance is a Pageflex template format with the variable contents of one 
record ingested into the template as the default contents. You can open and 
edit a document instance with Pageflex Studio.

 Encapsulated PostScript (EPS). A format that allows document pages to be 
printed or used as images on other document pages. The resulting EPS files, 
which contain low resolution TIFF previews, can be inserted into pages of 
other documents with Studio or other publishing software.

 Indigo JLYT. This format is supported by HP/Indigo for variable data 
printing. It supports various optimizations for HP/Indigo presses, especially 
the ability to cache recurring images for high speed printing.

 Optimized PostScript. This PostScript format caches images for reuse so 
that the same image does not have to be processed multiple times. This 
reduces file size and transmission time for print jobs which contain recurring 
images. This may speed up the printing process if the press is equipped to 
optimize the handling of PostScript forms.
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 Portable Document Format (PDF). A de facto standard for document 
interchange and printing. It is based on the Adobe PostScript imaging model, 
but has been both refined and expanded to make it more universal. It uses 
the Adobe PDF Library to ensure the highest reliability and optimization.

 PostScript. A de facto standard in the print industry. Pageflex applications 
produce PostScript that has been tested with a variety of print systems and 
workflows.

 PPML/PostScript. Personalized Print Markup Language (PPML) is an 
industry standard that Pageflex, as a member of the Print On Demand 
initiative (PODi) helped to define. This format allows recurring images to be 
cached for high speed printing. As a standard, PPML allows interoperability 
across a wide range of presses from different vendors. Pageflex PPML output 
has been certified by PODi as being fully standards compliant, and has been 
tested with many presses and workflows.

 PPML/VDX. A standard developed by the Committee on Graphic Arts 
Technical Standards (CGATS), based on PPML. PPML/VDX is distinguished 
from PPML in that all the content is in PDF format, and the XML portion of 
the data is embedded within PDF. This enables the production of a single 
output file that permits interoperability and very efficient printing on presses 
that support this output format.

 Xerox VIPP. A format based on PostScript. VIPP offers a variety of modes for 
different printing workflows. Pageflex supports hybrid mode VIPP, which 
mixes PostScript and VIPP operators in output. The VIPP operators allow 
caching of recurring images for high speed printing. In the Pageflex 
implementation of this format, the driver fully composes all document pages 
before it generates output.

Note: You can also choose an HTML or HTML-email format. However, you 
must choose an HTML template in the Template list in order to see this output 
format. See Chapter 14, “HTML Output,” on page 347 for details.
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Setting Format Properties
Once you have chosen a format, click Properties (next to the Format field) to 
open the Output Properties dialog box. The options available to you will change 
depending on the output format you chose:

 EPS. Choose between displaying an EPS preview or no preview. See below 
for details.

 PostScript. If you chose the Convert PostScript to PDF, CreoScitex-VPS, 
Indigo-JLYT, Optimized PostScript, PostScript, PPML/PostScript, or any 
other format derived from PostScript, choose a PostScript printer description 
(PPD), settings, and options for output. See “PostScript” on page 318 for 
details.

 PDF. If you chose native Portable Document Format (PDF) or PPML/VDX 
(which is derived from PDF), choose a multitude of options, including page 
content, meta data, image, security, font, and view options. See “PDF” on 
page 320 for details.

 Bitmap. Choose format, compression, color matching, and size options. See 
“Bitmap” on page 330 for details.

Note: The Document Instance and Xerox VIPP formats do not have properties, 
so the Properties button is unavailable.

EPS
If you chose to create EPS output, click Properties to display the EPS Properties 
dialog box.

Choose between the following EPS Preview Formats:

 24-Bit Color Preview. Choose this option to create a 24-Bit TIFF color 
preview of the EPS for viewing. The TIFF preview is embedded in the EPS 
file, and is used by applications that cannot directly display EPS directly, such 
as Studio, Adobe FrameMaker, and Microsoft Word. By using the TIFF 
preview, these programs can show an approximation of the final image on 
screen during editing.
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 No Preview. Choose this option if you do not want to create a preview.

PostScript
If you chose to create PostScript output or you are using a proprietary output 
format that require a PostScript Printer Definition (PPD), click Properties to 
display the Format Properties dialog box.

PPD

Each printer vendor supplies a PPD file for their print device. This enables those 
who create documents and templates to specify specific settings for the print 
device. Each PPD has a settings unique to the printer it was designed for. In the 
PPD list, select a PPD file to use or (None) for no PPD. A PPD file contains 
information about the capabilities of a printing device. The available options for 
each PPD file vary with each printing device.
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The PPD may contain device-specific PostScript code which will be inserted into 
your output if those options are selected. Be sure to use a PPD that matches the 
actual printing device that will receive the PostScript data.

Note: If your PPD file is not listed while creating the job, copy it to the 
Programs\PPDfiles directory and restart Studio. If you are using Pageflex Server 
to create output, also copy the PPD file to the PPDfiles directory on each Server 
machine (see the Pageflex Server Guide for details).

Settings

Select the properties you want for the PPD file you selected. Most PPD options 
let you specify a paper or page size to use. When a property reads “Same as 
Document,” the PPD property uses the value from the template setup. For 
example, if the template page size is “letter,” the PPD uses letter-size as well. 
Studio uses the following settings to enhance your output options:

 PageSize. The PageSize field determines the size of the sheet. Choose a size 
from the drop-down list. See “Sheet Size” on page 300 for details about how 
Studio uses this setting for imposition.

Note: If you are printing bleeds, you must select a page or paper size large 
enough to accommodate the bleed area in addition to the size of the 
template.

 InputSlot. The InputSlot field specifies the printer paper tray to use for 
output. See “Adding Paper Tray Assignments” on page 332 for details.

Options

Select from the following options.

 Alignment. If you are using single page imposition, select the Center on 
page check box to center the document on the output page.

Studio uses the PageSize value for page centering. To make this option 
available, you must select a PageSize other than “Same as Document” in the 
Settings section.

 Preserve ICC Profiles. Select this option to preserve color profiles in JPEGs 
and TIFFs that have been tagged with ICC profiles.

 Overprint. Select Override Settings to override overprint properties for 
text, text outlines, fills, and borders using the color black in the document. 
Select “Knockout” to disable overprint or “Overprint” to enable it.
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PDF
Pageflex drivers can create PDF output using a built-in Adobe PDF Library. When 
you create a PDF output job, you have to select the PDF options to use. These 
options are also available when you use the PPML/VDX format. You can find out 
more information about these settings in the Distiller Parameters documentation 
and the PDF Reference guide published by Adobe. The Adobe Acrobat online 
help may also have some helpful information as many of the features are similar. 
Click Properties to display the Output Properties dialog box.
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General

Set general options on the General tab. Choose from the following options:

 Compatibility. Select the version of Acrobat you want the document to 
support. Currently, the Pageflex PDF Renderer makes use of features that are 
only compatible with Acrobat 3.0 (PDF 1.2). Only the version number of the 
PDF version in the file header changes.

 Page Contents. Select a check box to enable the function, or clear the check 
box to disable it.

 Compress Page Contents. Instructs the renderer to compress the page 
contents using the “Flate” or “ZIP” encode filter. This can reduced the 
sizes of page contents by as much as 60% depending upon the contents.

 ASCII Compatible. Encodes binary streams as pure ASCII if selected, or 
includes binary streams in the output if not selected. This uses the 
ASCII85EncodePages Distiller parameter. ASCII 85 encoding allows safe 
transmission over 7 bit channels. This instructs the PDF Renderer to 
encode the page contents with an ASCII 85 Encode filter to enable 
transmission of the page contents over a 7-bit communications channel.

Note: For backward compatibility purposes since most data 
communication channels these days are 8-bit. Old e-mail channels used to be 
7-bit only, hence the reason for Base64 encoding of e-mail attachments.

 Fast Web View. Optimizes the file for fast Web view. This includes 
quickly displaying pages, such as the first page when the file is first 
opened and subsequent pages when the reader goes to another page; 
enabling the user to follow links before the page has been fully loaded; 
and displaying pages as they load.

This instructs the PDF Renderer to save the PDF as “linearized” for 
faster viewing over the Web. Linearization reorders the objects in the 
PDF so that the objects required to view the first page of the PDF are 
placed first in the PDF. In this way, these objects are transmitted first and 
can be displayed before the rest of the PDF is transmitted.

 Override Overprint Settings. Override the overprint properties for  text, 
text outlines, fills, or borders using the color black in the document. This 
overrides all of the settings for black objects in the entire document. The 
check box is cleared by default to prevent the overprint settings for legacy 
artwork from being unexpectedly changed. Select the check box and select 
“Knockout” to disable overprint or “Overprint” to enable it for a property.
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 Meta Data. Add an Author, Subject, and Keywords to associate with this 
PDF file. Acrobat displays these items in the Description field in the 
Document Properties dialog box. 

There are several positive benefits to these exposed features:

 Author. You can attribute the job or author to a specific firm or person.

 Subject. You can attribute the job to a particular firm.

 Keywords. Useful for Copyright statements.

Additionally, Acrobat Catalog will pick up on these fields and allow you to 
search a collection of PDFs based on the contents.

Note: At any time, you can click Reset Defaults to reset all the fields on every 
tab back to the defaults. You can also click OK to save the changes, or Cancel to 
exit without saving changes.

Image

Click the Image tab to set image options.

The image options specify compression and downsampling for images. You may 
want to experiment with these options to find an appropriate balance between 
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file size and image quality. You can choose downsampling and compression for 
color, grayscale, and monochrome images.

 Downsampling. Select this check box and a resolution to reduce the number 
of pixels in an image by averaging the values of surrounding pixels using a 
Bicubic filter. Enter the resolution for the downsampling.

Adobe recommends that the resolution setting for color and grayscale be 1.5 
to 2 times the line screen ruling at which the file will be printed. The 
resolution for monochrome images should be the same as the output device, 
however, saving a monochrome image at a resolution higher than 1500 dpi 
increases the file size without noticeably improving image quality. You may 
also want to consider whether users need to magnify a page. For example, if 
you are creating a PDF of a map, consider using a higher image resolution so 
users can zoom in on the map. 

Note: Resampling monochrome images can have unexpected viewing 
results, such as no image display. If this happens, turn off resampling and 
convert the file again.

The following table shows common types of printers and their resolution 
measured in dpi, their default screen ruling measured in lines per inch (lpi), 
and a resampling resolution for images measured in pixels per inch (ppi). For 
example, if you were printing to a 600-dpi laser printer, you would enter 170 
for the resolution at which to resample images.

Images should be sampled at a rate suitable for the desired, ultimate output. 
For example, if the output is destined for a high speed digital press then 600 
dpi should be good enough. If it is for a display then 100 dpi should be more 
than adequate. If the output for a high speed digital press is to be displayed 
for proof purposes, consider JPEG compression at a low QFactor (see below) 
instead of resampling. That will increase the PDF Renderer throughput as 
well as significantly reducing the file size of the PDF. Downsampling will 
only slow down the PDF Renderer and cause significant memory 
consumption.

Printer resolution Default line screen Image resolution

300 dpi (laser printer) 60 lpi 120 ppi

600 dpi (laser printer) 85 lpi 170 ppi

1200 dpi (imagesetter) 120 lpi 240 ppi

2400 dpi (imagesetter) 150 lpi 300 ppi
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It is best to have a single high resolution image (for example, 600 dpi) and 
then to apply the following filters to it in the following situations:

 Display, preview, and proof—no downsampling (if possible) and a low 
JPEG quality factor (QFactor).

 Print production—no downsampling (if possible) and ZIP (Flate) or 
JPEG encoding with a high QFactor.

Note: There are some image types that the PDF Renderer does not and cannot 
downsample, such as Masked images, Images with Alpha Channels (Soft Mask), 
and Indexed Images. Downsampling of these images may create image artifacts 
that may not meet quality expectations.

 Compression. Select this check box and a compression format. This option 
reduces the file size using the compression algorithms of the selected format. 
For Color Bitmap Image Compression, choose JPEG or ZIP compression.

 JPEG. Select this compression method for color or grayscale images. 
JPEG works well on continuous-tone photographs that contain more 
detail than can be reproduced on-screen or in print. 

 QFactor Slider. Use the slider to adjust the quality, or QFactor. The 
higher the QFactor the higher the compression and the lower the quality. 
The lower the QFactor the lower the compression but the higher the 
image quality. Move the slider to the right to increase the QFactor and 
therefore the compression. Move the slider to the left to lower the 
QFactor and therefore decrease the compression and improve the image 
quality. The text box next to the slider lists the size in kilobytes. You can 
also enter the size directly into this box. 

 ZIP. Select this compression method for color, grayscale, or monochrome 
images. ZIP is a lossless encoding scheme, which is not true with JPEG. 
JPEG is a lossy encoding scheme. ZIP works well on images with large 
areas of single colors or repeating patterns, such as screen shots, simple 
images created with paint programs, and black-and-white images that 
contain repeating patterns. ZIP compression does not allow you to set 
the quality with the slider. Studio uses 8-bit zip compression.

 CCITT Group 4. Select this compression method for monochrome 
images. CCITT (International Coordinating Committee for Telephony 
and Telegraphy) is appropriate for black-and-white images made by paint 
programs and any images scanned with an image depth of 1 bit. CCITT is 
a lossless method.
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Note: Be sure to scan monochrome images as monochrome, not grayscale. 
Some scanners save scanned text as grayscale images by default. Grayscale text 
compressed with the JPEG compression method may be muddy and unreadable.

Click Reset Defaults at any time to reset all the values on both tabs of the dialog 
box.

Security

Click the Security tab to set these options.

You can limit access to a document by setting passwords and by restricting 
certain features, such as printing and editing. When a document has restricted 
features, any tools and menu items related to those features are unavailable. The 
following security options are available.

PDF Output Properties PDF Document Properties

These images show the relationship between the PDF output 
properties you can set when creating the PDF, and how the PDF 
document properties reflect these settings.
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 Open Password. This password, also known as the document open 
password, is just for opening the document. Set a password if you want to 
restrict who can view the document. Acrobat uses the RC4 method of 
security from RSA Corporation to password-protect documents. If you want 
to restrict printing or changing the document then include the security 
settings below.

 Security Password. This password, also known as the permission or owner 
password, is necessary to change the security settings for the document. Set 
a password that for someone to enter to be able to change security settings. 
Studio uses the same security methods as Adobe Acrobat; if the user chooses 
to select one of the security options and fails to assign a security password 
then there will be no way of changing the security settings. In this way, you 
can create a PDF with security settings that can never be changed.

Note: If you forget a password, there is no way to recover it from the 
document. It's a good idea to store passwords in another secure location in 
case you forget them. Also, keep a backup copy of the document that is not 
password-protected.

 Disable Printing. Prevents users from printing the PDF.

 Disable Hi-res Printing. Prevents users from printing high resolution 
output. This setting prints the document at no higher than 150-dpi 
resolution. Acrobat viewers earlier than version 5.0 do not recognize this 
security setting. For viewers that do recognize the setting, this option 
disables the conversion of the document to PostScript.

 Disable Copy To Clipboard. Prevents users from selecting and copying text, 
images, and other content onto the clipboard. It also prevents utilities that 
need access to the contents of the file, such as Acrobat Catalog, to get those 
contents. The PDF Document properties refer to this setting as “Content 
Copying”.

 Disable Editing Notes. Prevents users from entering editing notes. The 
PDF Document properties refer to this setting as “Editing”.

 Disable Page Extraction. Prevents users extracting pages from the 
document. Users cannot insert pages from the PDF into another PDF using 
Document  Insert Pages or Document  Replace Pages.
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Fonts

Click the Fonts tab to set font options.

Choose an option for how to handle the fonts used in each document.

 Do Not Embed Fonts. This option does not embed the fonts. The font 
names are retained if the fonts are available when the document is opened. 

 Embed All Fonts. This option embeds all the characters for all the fonts 
used in each document, even unused characters.

 Embed/Subset All Fonts. This option embeds all the fonts, but only the 
characters that actually appear in the document.
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Views

Click the Views tab to set view options.

Choose options to configure the initial view settings for your PDF. In the 
Document Options section, choose how you want to display the document.

 Show. Choose the panels to display when someone first views the document.

 Page Only displays only the page in the Document pane.

 Pages Panel and Page displays the thumbnail view in the Navigation 
pane as well as the page in the Document pane.

 Page Layout. Choose how to layout pages in the Document pane.

 Default uses the defaults set by the user in their viewer.

 Single Page displays one page at a time in the Document panel.
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 Continuous arranges the pages in a continuous vertical column.

 Facing arranges the pages side-by-side, displaying only one or two pages 
at a time, with odd pages to the left.

 Continuous Facing arranges the pages side-by-side in a continuous 
vertical column, with odd pages to the left. If a document has more than 
two pages, the first is displayed on the right to ensure proper display of 
two-page spreads.

 Magnification. Choose the initial magnification.

 1600%-25% fits the page to the selected magnification.

 Fit Page resizes the page to fit entirely in the window.

 Fit Width resizes the page to fit the width of the window.

 Fit Visible resizes the page so that its text and graphics fit the width of 
the window. Part of the page may be out of view.

 Default uses the defaults in the user preferences. See EditPreferences 
in the Acrobat viewer to set these options.

 Open to Page Number opens the document to the specified page 
number.

In the Window Options section, choose the properties of the window for when 
someone opens the document.

 Resize Window to Initial Page. Select this check box to resize the window 
to the page size of the initial page of the document.

 Center Window On Screen. Select this check box to center the window on 
the screen.

 Open in Full Screen Mode. Select this check box to open the window in full 
screen mode. 

Note: If you enable full screen mode, the page layout and magnification 
options will be disabled, as the page layout is automatically set to single page 
and the magnification will be set to fit page.

 Window Title. Choose to use the File Name or the Document Title as the 
title of the window.

In the User Interface section, choose to hide or show specific controls.

 Hide Menu Bar. Select this check box to hide the menu bar.

 Hide Toolbars. Select this check box to hide all toolbars.

 Hide Window Controls. Select this check box to hide all window 
controls.
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Bitmap
If you chose to create Bitmap output, click Properties to display the Bitmap 
Properties dialog box.

Note: If you are using a Pageflex WebForm to submit the job to Pageflex Server, 
also select Default Output Folder in the Send to box.

Select from the following options.

 Bitmap Format. Select a bitmap output format. The Pageflex Bitmap driver 
supports one of three bitmap formats: JPEG, TIFF, or Compuserve GIF. Use 
one of these bitmap formats to create image files as the final output. The 
bitmap driver does not support PostScript options.

 Quality/Compression. If you select the JPEG format, you must choose 
between a better quality image with a larger file size or a lesser quality image 
with a smaller file size. Move the slider between the two options, or enter a 
number from 1 to 100 in the box, where 1 is the best quality and 100 is the 
smallest file size.

 Color Matching. Select the Generic CMYK check box to create the bitmap 
using a generic CMYK color profile. The result is bitmap output that more 
closely matches CMYK print colors. 

Under Size, select options to set the size of the bitmap.

 In the Adjust size using list box, choose Percent, Width, or Height.

 If you choose Percent, the size is determined as a percentage of the 
document size. Enter a percent for the image size in the Percent box. 
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 If you choose Width or Height, enter the number of pixels for the 
dimension you specified. The other dimension is calculated in proportion 
to the size you specify.

Click OK when you are finished to save changes, Cancel to exit without saving, 
and Help for online help.
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Adding Paper Tray Assignments
You can assign paper trays specified in the PPD InputSlot to specific job media 
to be used for each page in your template, including master pages. For example, 
you can load hard paper stock for report covers in one paper tray of your printer 
and glossy paper for insert pages in another paper tray, then set the job media for 
each page using the Info tab on the Properties panel.

You can set job media for master pages so that whenever you apply that master 
page to a page in your template, the associated job media will also be used.

Mapping Job Media values to PPD input slots, rather than mapping pages to 
input slots, provides for portability of templates between projects and jobs with 
different PPD settings.

 To add paper tray assignments

1 Create Job Media names.

2 Assign job media to pages in your template.

3 Select an output format and PPD that supports the Input Slot parameter.

4 Map job media to input slots.

5 Put the appropriate paper into the printer tray before you generate output.

These steps are described below in detail.
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Create Job Media Names
Job Media is a user-defined name for the type of media to use for output for a 
specific page. Studio saves job media names as part of a project. You then assign 
these names to template pages in Studio. 

Select Job Media from the Jobs menu to add or delete job media names.

Enter a job media name and click Add. To delete a media name, highlight the 
name and click Delete. Click OK to save changes and exit the Job Media dialog, 
or click Cancel to exit without saving changes.
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Assign Job Media to Pages
Select a page in your template and click the Info tab in the Properties panel.

Choose a job media name to assign to the page output. Choose the empty space 
to use the paper tray used by the previous page. Choose (default) to use the 
default paper tray as specified in the PPD. To assign a master page to job media, 
click the Pages tab, double-click a master page to select it, and click the Info tab 
in the Properties panel.

Select a job media type to apply it.
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Select Output and PPD
In the Job Setup dialog, select a format that supports PPDs.

Click Properties to open the Format Properties dialog. Choose a PPD that 
supports the InputSlot parameter.

Paper Tray Assignments Not Available

If you chose an incompatible format, such as a format that does not use PPDs, 
the paper tray assignments will not be available in the Output section of the Job 
Setup dialog.
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Map Job Media to PPD Input Slot
The Paper Tray Assignments section in the Output section of the Job Setup 
dialog lists all job media assignments available in the project.

By default, Studio assigns the default input slot to all job media. The default 
job media represents the input slot value for all pages that are not assigned to a 
specific job media. You can map the default media value onto the default input 
slot or to any specific tray. To map job media to an input slot, click the box next 
to the job media and choose a tray from the drop-down list.

Incompatible PPD Format

If you chose an incompatible PPD format, you will not be able to map job media 
to an input tray and the paper tray assignment controls will be disabled.

Default 
Job 
Media Default 

Input 
Slot
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Previewing a Job
Once you have applied some project variables, you can preview the project 
records in a job. Previewing helps you determine whether your template correctly 
accommodates the variable content of the project.

You have two options for previewing the project records for a job, depending on 
whether the job specifies a profile data source.  The data source for a job is listed 
on the Input tab of the Job Setup dialog box. 

 Jobs using a data source. If the job has a data source, you can preview the 
records in that data source. Before you can preview the records for a 
particular job, you must make sure you have set up ODBC for each of the  
data sources you use in the project.

 Jobs with no data source (transactional jobs). If a job has no specified 
data source on the Job Setup dialog box, you can enter information to use 
for each variable. Using this information, Studio creates a preview for a 
single record. You have the option to submit the preview record for final 
output. 

Note: This type of preview is helpful if you are designing your project to 
accept transactional job submissions from another application such as a Web 
browser. See “Creating and Previewing Transactional Jobs” on page 340.

 To preview a job with a data source

1 Select a job that lists a Data Source on the Job Setup dialog box. For a job 
with no data source, see page 341.

2 If you want to view the variable content used in each record, choose Jobs > 
Variable Content View. The Variable column shows the name of each 
variable. The Content column shows the value for each variable:
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Open the Variable Content View before opening a preview window, as you 
will not be able to open it after you have begun previewing a job.

3 To open the Job Preview window, perform one of the actions below.

 On the Job Setup dialog box, click Preview

 Select a job in the Project panel, and choose Jobs > Preview

 Select a job in the Project panel, and choose the Preview Job icon  in 
the Job toolbar

Or to preview the job using the template currently selected in the document 
area, perform one of the actions below.

 Select a job in the Project panel, and choose the Preview Job with current 
template icon  in the Job toolbar.

 Select a job in the Project panel, and choose Jobs > Preview with 
Current Template

4 Studio displays the template connected to the job in the Document window. 
It also displays the Job Preview window.

5 The top of the Job Preview window displays the database table for the profile 
data source. Each column represents a field in the database, and each row is 
one record.

6 To preview a particular record, click the row for the record. Studio ingests the 
variable contents for the selected record and displays the results in the 
Document window.

Profile Data 
Source Table

Status Messages 
for the Data Ingest
 338 Creating Jobs



Chapter 13
 If Studio encounters any problems ingesting the data, it displays an error 
message in the lower part of the Job Preview window.

 You can choose to show or hide suppressed elements while you are 
previewing. See “Previewing Suppressed Elements” below.

7 To preview additional records, click other rows. You can also use the arrow 
keys on your keyboard to scroll up and down through the records.

8 When you have finished previewing records, close the Job Preview window.

 Previewing Suppressed Elements
While previewing a job, you can choose whether you want to show elements you 
have suppressed in the template using the suppress printing property.

Showing or hiding suppressed elements has no effect on how these elements 
appear in the final output. When you create the job, you can choose whether or 
not to include suppressed elements in the final output. See “Adding a New Job” 
on page 285.

 To view or hide suppressed elements

1 Preview a job, either a job with a data source or a transactional job.

2 Choose Jobs > Show Suppressed Elements. If a check mark appears beside 
this menu item, the preview includes elements with the Suppress Printing 
property set to Yes.

3 If there is no check mark beside the menu item, the preview does not include 
elements with the Suppress Printing property set to Yes.
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Creating and Previewing Transactional Jobs
A transactional job is a job that uses the application driving the submission, such 
as a Web page, to collect profile data instead of a database or ODBC connection. 
Typically, transactional jobs create one record at a time, as when a customer uses 
a form on a Web page to submit a single request for information.

Before you create a transactional job, you should set up a database with test data 
to use while you are developing the project. Use the fields in the test database to 
create the variables for the project. Get the project up and running with the test 
data before you attempt to create transactional jobs.

Develop the Web page or the application for the job submission. Use the same 
variable names as the ones you created with the test database. You can use 
Pageflex WebForm Wizard to make an Active Server Page (ASP) or ASP.NET page 
as a starting point, and then edit the HTML file it creates to match the look and 
feel of your Web site. See the Pageflex Server Guide for details.

When you are ready to make a transactional submission, follow the steps below 
to create the transactional job.

 To create a transactional job

1 Click Add Job on the Project panel to create a new job. Studio displays the 
Job Setup dialog box.

2 Enter a Job Name.

3 Set the Data Source to (none). This causes all profile variables (including 
constant variables) to have no values. This is because the Web Form or other 
application that submits the job provides the variable values.

4 Select a template to use in the template list. The list displays all the 
templates you have added to the project.

5 Choose an output format.

 To have the job create a PDF file, select Portable Document Format 
(PDF) in the format list.

 To have the job create a bitmap, select Bitmap in the format list.

6 Click OK to save the job.
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 To preview a transactional job

1 Select a job with a Data Source of (none).

2 Open the Job Preview window by performing one of the actions below.

 On the Job Setup dialog box, click Preview

 Select a job in the Project panel, and choose Jobs > Preview

 Select a job in the Project panel, and choose the Preview Job icon  in 
the Job toolbar

Or to preview the job using the template currently selected in the document 
area, perform one of the actions below.

 Select a job in the Project panel, and choose the Preview Job with current 
template icon  in the Job toolbar

 Select a job in the Project panel, and choose Jobs > Preview with 
Current Template

Studio displays the Job Preview window for a transactional job. The top part 
of the window lists the variables in the project and the values you want to 
use for the preview.
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3 To change the variables in the preview list, click Variables Setup. 

4 Do any of the following until you have selected the variables you want to 
include in the list. 

 Select the check box next to a variable you want to include.

 Clear the check box for a variable you want to exclude.

 Click Select All, Select None, or Select Profile to change more than 
one variable at a time. 

5 Click OK when you are finished. Studio returns to the Job Preview window. 

6 Type values for each of the variables in the top part of the Job Preview 
window. For variables that require a file name instead of a text value, click 
the button in the value column to choose a file from the project folder. 

Remember the following:

 Any variable you leave blank has an empty value for the preview. 

 You can click Clear All at any time to reset the values of all the variables. 

 Profile variables use the new values you assign to them. 

 The value that you assign to a content variable overrides its calculated 
value from a rule, script, library query, or plug-in. 

 Make sure that any variables you leave empty are allowed to be empty. If 
you leave variables empty that are not allowed to be empty, Studio 
displays a warning message when you attempt to create the preview. 

 You can choose to show or hide suppressed elements while you are 
previewing.
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7 Click Preview to see the template using the values you have assigned. 

If Studio encounters any problems, it displays error messages in the lower 
part of the Job Preview window.
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Generating Output

You can submit jobs to Studio and Pageflex Server to generate EPS, 
PDF, and PostScript output, as well as any other output formats you 
have licensed to use. This chapter describes how to generate output 
using these two methods.

You can also submit jobs to .EDIT and Storefront to generate output. 
See the guides for these applications for details.
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Introduction
You can create jobs that produce output in any output format listed on the 
Output tab (see “Adding a New Job” on page 285 for details), but you cannot 
generate output in formats you have not licensed to use.

By default, you can generate output in PostScript, Encapsulated PostScript (EPS), 
or Adobe Portable Document (PDF) formats. All other output types require that 
you purchase the appropriate licensing to generate.
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Generating Output with Studio
Follow the steps in Chapter 13, “Creating Jobs” on page 283 to create a 
PostScript, EPS, or PDF job then follow the steps below to generate output using 
Studio.

 To generate output with Studio

1 Click Generate Output on the Job Setup page or highlight a job and click 

the Generate Output icon  on the Project Panel toolbar to display the 

Generate Output dialog box.

2 Select “Studio” in the Submit to box.

3 Click OK to generate the output, Cancel to abort, or Help to open the 
application help. You can also perform the following actions:

 Select the Create extended debugging log check box to create a log file 
with extended debugging information, or clear this box for normal 
logging.

 Click Output Setup to set up the output folders. Studio displays the 
Output Setup dialog box.
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Output Setup
Click Output Setup on the Generate Output dialog box to access the Output 
Setup dialog box.

You can choose your output and logging folders using the text boxes on this 
dialog. You can set the output and logging folders at any time. You do not need to 
set them for each submission. Once you have set output and logging folders, 
Studio will continue to use them until you change them. The output folders and 
SMTP settings are described below.

Standard Output Folders

 Temporary Output—for temporary files used to create final output. After 
Studio generates final output, it deletes the files it placed in this folder. This 
should be a local folder, not a shared network folder.
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 Final Output—for final output files. For each job, Studio creates a folder 
inside the Final Output folder using a unique transaction ID for the folder 
name. 

If the Final Output folder is on the same physical system as the Temporary 
Output folder, then they can be one and the same. This results in a 
performance advantage as the output files would not need to be moved after 
being generated, nor would the Temporary Output folder need to be purged.

HTML Output Folders

 HTML Output—for final output of HTML jobs. This folder follows the same 
rules as the Final Output folder described above, but must correlate to a Web 
server virtual folder.

 HTML Output URL—the absolute URL for the HTML Output folder.

For example: http://www.yourcompany.com/SampleHTML

Logging

 Job Log Folder—for saving job logs. The log file name is the same as the 
transaction ID, with a file extension of “.xmj” for standard logs and “.log” for 
extended logs.

SMTP Server Settings for E-Mail

 SMTP Server—the SMTP server to use for e-mail output.

 Use SMTP Authentication—Click Yes to use SMTP authentication, or No 
to not use it.

 User Name—the user name to use for SMTP authentication.

 Password—the password for the user name above.

 Use SSL—choose Yes to use Secure Sockets Layer protocol, or No to 
not use it.
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Output Status
After you have run the job, Studio displays the output status window, which 
displays a log of the job status.

You can perform the following actions:

 While the job is running, you can click Stop Output to stop it.

 After the job has run, click Close to close the window.

 Click Save Report to save the output status log.

 Click Open Folder to open the folder containing the output file or files.
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Generating Output with Pageflex Server
Follow the steps in Chapter 13, “Creating Jobs” on page 283 to create a job then 
follow the steps below to generate output using Pageflex Server. Note that if you 
do not own Pageflex Server, you will not be able to make a successful submission 
to it! If you do own it, be sure that Pageflex Server is running before sending 
submissions to the server.

 To generate output with Pageflex Server

1 Click Generate Output on the Job Setup page or highlight a job and click 

the Generate Output icon  on the Project Panel toolbar to display the 

Generate Output dialog box.

2 Select “Pageflex Server” in the Submit to box.

3 Perform any of the actions below to set the Pageflex Server Submission 
Settings.

 Server Name. If you are using Server on the same machine as Studio, 
choose (local). Otherwise, type the machine name. The machine name is 
the name you see in the Network Neighborhood window. 
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 Port. Enter the number of the port that Pageflex Server is set to monitor. 
You can find the port number in Pageflex Server on the Setup dialog box 
under Port.

4 For the Submission level, you can choose how far you want Pageflex Server 
to go towards producing the final output. Choose one of the following.

 Production. Use this option when you are ready to submit the job for 
final output. Pageflex Server performs all data checks, composes each 
document, and runs any post processes you have specified.

 Preflight, Data Check. This is the first level of preflight that Pageflex 
Server can perform. Pageflex Server reports any problems it encounters 
with opening the data source and interpreting the variable definitions. It 
checks if the variables are valid but stops before composing the page or 
running any post processes. 

 Preflight, Compose. Pageflex Server checks the project data and 
composes each page. It stops before it creates the final output and before 
it runs any post processes.

5 Click OK to generate the output, Cancel to abort, or Help to open the 
application help.

If Pageflex Server accepts the job, Studio displays a response from Pageflex 
Server. If Pageflex Server is unable to accept the job, it returns a message 
explaining the problem. However, if Pageflex Server encounters an error after it 
accepts the job submission, it does not return any error messages to Studio. 

Transaction ID
Pageflex assigns each job a unique transaction ID. Each transaction ID begins 
with a letter followed by a 7-digit number. The number increments by one for 
each new job.

A0000042
Prefix Number

(increases by 1 for each job)
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For example, if the Prefix Letter is A and the Starting Number is 30, Studio 
creates the following folders for the first three job using their transaction IDs for 
the folder names.

See “Final Output Folder” on page 354 for details on how transaction IDs are 
used to identify output.

 A0000030
 A0000031
 A0000032
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Final Output Folder
When Studio finishes running a job, it saves the final output in the Final Output 
folder you specified on the Output Setup dialog box. For each job, Studio creates 
a folder using the transaction ID as the folder name. Inside this folder, Studio 
saves each document using the transaction ID followed by the record number for 
the file name.

For example:

Managing Hi-Res and Lo-Res Image Files
You can use two Images folders to swap between hi-res and lo-res image files to 
make your template load faster during the design phase. 

To do this, set up two Images folders, one named “Images”, and the other named 
“hi-res Images” or “low-res Images”. Place the hi-res or lo-res images that you 
want to use in the Images folder, and place the other images in the other folder. 
Be sure to use the same names for the hi-res and lo-res versions of the images.

While working with Pageflex Studio to create the project, use the lo-res images. 
When you are ready to generate output, put the hi-res images into the Images 
folder.

 Final Output Folder

 A0000042
 A0000042_00001.ps

 A0000042_00002.ps

 A0000042_00003.ps
 A0000042_00004.ps

 A0000043
 A0000043_00001_1.jpg
 A0000043_00001_2.jpg
 A0000043_00001_3.jpg

Folder name is the transaction ID

File name is the transaction ID 
followed by the record number 
from the profile data source

Bitmap output adds an extra 
character to designate the 
page number output.
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Managing Logs
Studio creates a log file for every job it runs and saves it in the Job Log Folder 
specified in the Output Setup dialog box. The amount of information in the log 
depends on whether you chose to create extended debugging logs or not by 
selecting or clearing the check box on the Generate Output dialog.

 Standard Logs. If you did not select the Create extended debugging logs 
check box, Studio reports the basic information about the job, such as the 
time it was run, the Transaction ID, document number, and the status. 
Studio saves standard logs with the “.xmj” extension.

 Extended Debugging Logs. If you did select this box, in addition to the 
information in a standard log, Studio lists all the variables included in each 
record. It also records additional information about your project that may be 
useful if you are seeking technical support. Studio saves extended logs with 
the “.log” extension.

Deleting Old Log Files
You should regularly delete old log files by deleting the files in the Job Log 
Folder. You may also want to create a script that runs unattended to delete log 
files older than a specified date.
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HTML Output

This chapter explains how to use Studio as a variable tagging tool to 
create customized HTML output for use as personalized Web microsites 
or HTML e-mail blasts that can be sent immediately.
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What is HTML Output?
HTML output is a way of applying new variable definitions to HTML files and 
repurposing existing variable definitions for HTML files for use as personalized 
Web microsites or HTML-formatted e-mail messages.

Studio operates as a variable tagging tool, allowing you to add variables to 
previously created HTML files and send HTML jobs to an HTML output driver. 
This driver generates Web microsites or HTML-formatted e-mail messages from 
HTML templates with custom images or text. You can set the driver to send e-
mail messages directly to customers, or you can post output as Web microsites 
for personalized access by clients.

This chapter describes the process for creating HTML output. The steps below 
give a brief overview of the steps to take to create HTML output. The rest of this 
chapter goes over each of these steps in detail.

 Overview of steps to create HTML output

1 Create a project and variables in Studio or open an existing project to use to 
repurpose variables in an HTML document, for example, for use in a 
marketing campaign.

2 Create an HTML template using an HTML editor. We recommend that you 
save your HTML template and associated images and files in the WebPages 
project folder. Save the HTML file in UTF-8 format and add a meta tag 
designating the UTF-8 charset for use in the file. For Example:

<HTML>
<HEAD>
<META http-equiv=Content-Type content="text/html; charset=utf-8">
</HEAD>
<BODY>This is an HTML encoded emdash — 

and this is an HTL encoded ndash – 
</BODY>

</HTML>

3 Open your HTML template in Studio and tag it with variables.

4 Create a job for HTML output. Choose to output files for a personalized 
website or send out personalized HTML-formatted e-mail messages.

5 Preview your HTML job in Studio.

6 Once you are satisfied, submit the job to the driver to generate output.
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Setting Up Your Project
You do not need to create a new project to take advantage of HTML output 
capabilities. You can use an existing project that is already set up with print 
templates (XDT and TSL files), jobs, and variables, and apply those same 
variables to HTML files. In this way, you can reuse content from your print 
marketing campaigns in your HTML campaigns. 

Project Folders
The contents of your folders are limited to or expanded by the following 
capabilities:

 Area Templates. HTML Output templates cannot take advantage of area 
template variables, so any area templates in this folder will not be available.

 Images. The Images subfolder of your main project folder continues to be 
the repository for your image variable content.

 Scripts. You can continue to use scripts for variables, for example, you may 
want a script to create an HMTL fragment:

Function getLink(BaseURL, UserID)
  url = BaseURL & UserID
  getLink = "<a href=' " & url & "'>Click here for details</a>"
End Function

 Text. You can continue to place all text variables in this folder, as well as the 
two HTML variables described in “Creating Variables for HTML Elements” 
on page 354.

 WebPages. You should build your HTML files in this folder. This folder 
contains sub folders for image handling.

 Images. The primary function of this folder is to serve as a repository for 
images that you do not want the HTML driver to automatically generate 
for display on the Web. The driver checks for files with the same name as 
files in your Images folder and does not automatically generate them if 
they exist.

 Autogen. This folder contains image variable content the HTML driver 
automatically generates for your HTML output.
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Project Panel
The Project panel displays the HTML-specific variables, jobs, and templates with 
different icons to distinguish them from the others.

Variables Tab

Jobs Tab

Formatted HTML Variable

Formatted HTML Paragraph Variable

HTML Output Job
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Files Tab

Studio displays HTML Templates stored in your WebPages folder in the 
Templates view of the files tab, so all of your templates, print and HTML, are 
accessible from the same area.

Once you have opened or created the project you want to use to create HTML 
output, you can create your HTML template using an HTML editor.

HTML Template
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Create an HTML Template
An HTML template is an HTML file with variables applied so that an HTML job 
can be run to create multiple instances of a personalized Web page or HTML-
formatted e-mail message. Studio cannot create HTML files, instead, the program 
functions as a variable tagging tool to convert pre-created HTML files into HTML 
templates. You must create the HTML file using an HTML editor and load it into 
Studio for tagging with variables.

To create an HTML template, first use an HTML editor to create an HTML file 
and save this file to the WebPages folder of your main project folder in UTF-8 
format. Open this file in Studio. Once you have tagged and saved this HTML file, 
Studio makes changes to the HTML source so that it can be recognized as an 
HTML template.

Studio should not be used as a substitute for your HTML editor. Although you 
can make small text edits in your HTML using Studio, you should use your 
HTML editor for everything else. If you find that you need to make changes to 
your HTML, close the template in Studio, open it in your HTML editor, make the 
changes, save the template, and open it again in Studio for tagging and 
previewing.

Using Placeholder Text For Variables
Any text in your template that you decide to replace with a variable will be 
overwritten by the variable name. Do not spend too much time crafting this 
variable placeholder text, as once you apply a variable to it, Studio replaces the 
text with the variable name.

Viewing HTML Source
You can view the source of your HTML file at any time. To do so, right-click 
anywhere on the HTML template in the document window and choose View 
HTML Source. You cannot edit the source in this window, but you can copy, 
paste, or find code within it. To do so, right-click in the window and choose the 
appropriate action.
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Using CSS
You can reference external CSS files in HTML output files generated for Web 
pages. However, if you are using CSS in HTML output files intended for e-mail 
distribution, you should include the CSS information inline with the HTML 
template. If you include CSS inline, the line cannot start with a period. Insert 
spaces or tabs before the period, as shown in the example below.

Example

<STYLE>
  .body {font-family: Verdana; font-size: 11px;}
  .legaltext {font-family: Verdana; font-size: 10px;}
  .title {font-family: Verdana; font-size: 15px; font-weight: bold}
</STYLE>

You can use images within CSS used for HTML output that will exist on Web 
pages, but do not include images within styles that will be used for e-mail, as 
Studio cannot include CSS-embedded images when it generates the e-mail.
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Creating Variables for HTML Elements
In addition to repurposing your plain text, formatted text, formatted paragraph, 
and image variable content from your print template to HTML templates, you can 
create new variables for these types of content, as well as the following HTML-
specific variables:

 Formatted HTML variables for inline HTML content with no paragraph 
breaks, such as HTML links. These variables can contain line breaks.

 Formatted HTML paragraph variables for block-level HTML content such 
as paragraphs, headers, horizontal rules, and tables.

HTML templates do not support area template or document variables and print 
documents cannot use HTML-specific variables. Create HTML variables using 
the same methods to create other variables, as described in the “Adding or 
Editing Variables” section on page 261.

Formatted HTML 
A formatted HTML variable is a section of HTML that belongs within a paragraph 
but does not form a paragraph by itself. Formatted HTML may contain inline 
HTML elements, such as bold or italic text and line breaks, but may not contain 
any block-level HTML elements, such as paragraphs, headings, and horizontal 
rules. Formatted HTML can include other inline and text variables, but not block-
level or paragraph variables.

Create formatted HTML content in a text editor and save it to the Text folder in 
your Project folder. Save formatted HTML with the extension “.hft”. The 
following sample is an example of formatted HTML content:

<a href="http://www.example.com">U Rent-A-Car</a><br>
<font color="blue">Serving over 200 cities nationwide!</font>
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Character Entities

When the following characters are used in formatted HTML for human-readable 
text, they must be in the character entity format listed below.

For example:

<P>The dog said &quot;Woof&quot;</P>

Formatted HTML Paragraph 
Formatted HTML paragraphs contain at least one whole paragraph. They contain 
block-level HTML elements, such as headings, horizontal rules, and paragraphs. 
They can also contain inline HTML elements, such as bold or italics. Formatted 
HTML paragraphs can include other inline, text, block-level, and paragraph 
variables.

Create a formatted HTML paragraph in a text editor and save it to the Text folder 
in your Project folder. Save formatted HTML with the extension “.hfp”. The 
following sample is an example of a formatted HTML paragraph:

<P>Tanzania’s vibrant culture offers a wonderful blend of <b>music</b>,
<i>dance</i>, and <u>food</u>.</P>
<P>During your stay you will learn about authentic African
customs, history, musical instruments, masquerades, and legends.</P>
<P>Contact <a href="http://www.example.com">My Compass Travel</a> to
schedule your trip to Tanzania!</P>

A formatted HTML paragraph is an HTML fragment. The same rules regarding 
character entities that apply to formatted HTML must be observed when creating 
formatted HTML paragraphs.

Text Variables
You can apply text variables (.txt) to HTML templates. Studio enters this plain 
text in the output of the HTML template.

Glyph Entity Description

< &lt; Less than

> &gt; Greater than

& &amp; Ampersand

" &quot; Double quote
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Formatted Text Variables
Formatted Text variables may be used in HTML templates. The HTML output 
driver strips all formatting from variable content when it is used in an HTML 
output job. It inserts formatted text variables inline within a <SPAN> element. 
Formatted text variables may include other text variables.

Formatted Paragraph Variables
Formatted paragraph variables may be used in HTML templates. The HTML 
output driver strips all formatting from variable content when it is used in an 
HTML output job. It inserts formatted paragraphs as block-level HTML within a 
<DIV> element. It replaces new paragraph markers with <P> HTML elements. 
Formatted paragraph variables may include other text or paragraph variables.

Image Variables
You can apply image variable content to HTML templates in the same way that 
you apply them to print templates. There are three ways you can associate images 
with your templates:

 Autogen. You can leave images in your Project\Images folder and the HTML 
driver will automatically generate image variable content in GIF (.gif) or 
JPEG (.jpg) format for HTML output, then save the generated image output 
in the Autogen folder.

 Images. You can convert images yourself and place them in your 
Project\WebPages\Images folder. If you decide to do this, save your image 
with the same root name as the original image in the Project\Images folder.

 Absolute URL Reference. You can save your images to a central place on 
your network and refer to them in your templates using absolute URLs. We 
recommend this method if you want to save space in your output folder, or if 
you want to be able to change the images in the future.
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The following diagram shows the relationship between the two Images folders 
and the Autogen folder:

 The HTML output driver resolves image variable content in the following order:

1 The driver first looks in the WebPages\Images folder for a JPEG or GIF image 
file with the same root name as the image in the Project\Images folder. If an 
image exists, it is used and no image processing occurs.

2 If there is no comparable image in the WebPages\Images folder, the driver 
looks in the Images folder for the variable content.

3 The driver looks in the WebPages\Images\Autogen folder for an 
automatically-generated version of the image. If it is newer than both the 
image found in step 2 and the last modified date and time for the job, the 
driver uses the automatically-generated image.

4 If no image exists in the Autogen folder, the driver converts the image in the 
Images folder to a JPEG or GIF image, as specified in the job properties, and 
places the converted image in the WebPages\Images\Autogen folder for use.

To bypass image conversion and save space, you can serve images from a remote 
server, using absolute URLs in your image variable references. For example, you 
can place the complete URLs in your database to be imported as links. 
Alternatively, you can use a script to prepend an absolute URL to image names.

 main project folder
 Area Templates
 Document Actions
 Images
 Scripts
 Text
 WebPages

 Images
 Autogen

Place variable image 
content in this folder.

HTML driver automatically 
generates Web-optimized versions 
of variable image content.

Place variable image content here to 
override HTML image autogeneration.
HTML Output  357



Pageflex Persona Cross Media Suite User Guide
Tagging Your HTML Template
When you apply variables to HTML elements, Studio tags the source of the 
HTML template with <div>, <span>, and <img> tags. Studio resolves variables that 
are embedded within other variables, unless they are embedded within area 
template or document variables, which HTML templates do not support.

Studio provides a user interface so that you can tag your HTML template with 
variables in much the same way that you apply variables to your print templates. 
However, there are some differences in how Studio displays variables in the 
document window and saves them to the HTML template code.

Note: Studio replaces the text in your HTML template with the variable name, 
so do not invest too much energy creating placeholder text for your template 
before loading it into Studio.

The image below shows a sample template after variables have been applied:

The highlighted text and images above are the areas where the user has applied 
variables have been applied to the template. Studio honors any default image 
content in the HTML file, even when tagged to be variable. It will not provide any 
placeholder text. However, if the current text selection is a sliver, Studio will 
insert the variable name as placeholder text. It does not provide any default 
images.
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 To tag your HTML template

1 Select a variable from the Variables tab.

2 Select an image or placeholder text.

3 Click the Apply Variable  icon on the Variables tool bar.

Note: For text-based variables, you can place the cursor where you want 
the variable value to be inserted, and apply the variable to place it there.

Remove variables in the same way as described in “Adding or Editing Variables” 
section on page 261. When you remove variables, your placeholder text will not 
return. Instead, the variable name will become plain text in your template.

When you tag your HTML template, Studio adds the variable name to a PFVar 
attribute in a <span>, <div>, or <img> tag, which it saves to the source of your 
HTML template so that it can resolve variable content when rendering output. 
Studio uses the Microsoft HTML Engine (MSHTML) to rewrite the HTML and 
tags when you save HTML files. This may alter the HTML DTD, for example, 
such as changing a properly constructed XHTML1 document into an HTML4 
document. If you do not want your HTML to be rewritten in this way, you should 
manually tag your HTML as shown below.

Note: When running a job, Pageflex Server generates the HTML using 
MSHTML, for example, for e-mails, microsites, and other HTML jobs. In this 
case, the final HTML output will be rewritten in MSHTML's only available 
format.

Formatted HTML
For formatted HTML (.hft) variables, Studio inserts variable names in the PFVar 
attribute of <span> tags. The following examples show the HTML source before 
and after variable ingest.

Before Ingest

<SPAN PFVar="PersonalURL">PersonalURL</SPAN>

After Ingest

<SPAN><A class=link 
  href="http://www.example.com/Samples/TravelAd.asp?id=1002">
  Click here for details of your trip</A></SPAN>
HTML Output  359



Pageflex Persona Cross Media Suite User Guide
Formatted HTML paragraphs
For formatted HTML paragraph (.hfp) variables, Studio inserts variable names in 
the PFVar attribute of <div> tags. The following examples show the HTML source 
before and after variable ingest.

Before Ingest

<DIV PFVar="VisitorsInfo">VisitorsInfo</DIV>

After Ingest

<DIV><H1>Culture of Tanzania</H1>
<HR>
<P>Tanzania’s vibrant culture offers a wonderful blend of 
   music, dance, and food.</P>
<P>During your stay you will learn about authentic African customs,
   history, musical instruments, masquerades, and legends.</P>
<P>The program entertains, but educates as well.</P>
<HR></DIV>

Images
For image variables, Studio inserts variable names in the PFVar attribute of <img> 
tags. The following examples show the HTML source before and after variable 
ingest.

Before Ingest

<IMG src="Images/hotel_icon.gif" PFVar="HotelPic">

After Ingest

<IMG src="Images/Autogen/fancy_hotel_icon.gif">

Note: The example shows an image from the WebPages\Images\Autogen 
folder, but it could have been from the WebPages\Images folder if you decided to 
place the image there rather than have the HMTL driver automatically-generate 
the image, or it could have been the absolute URL of the network location of the 
image.
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Text
For text (.txt) variables, Studio and Pageflex Server insert variable names in the 
PFVar attribute of <span> tags. The following examples show the HTML source 
before and after variable ingest.

Before Ingest

<SPAN PFVar="FirstName">FirstName</SPAN>, you can spend<BR>
<SPAN PFVar="Duration">Duration</SPAN> in 
<SPAN PFVar="Destination">Destination</SPAN> for just $
<SPAN PFVar="Price">Price</SPAN>!

After Ingest

<SPAN>Bob</SPAN>, you can spend<BR>
<SPAN>5 days</SPAN> in 
<SPAN>Caracas</SPAN> for just 
<SPAN>1200</SPAN>!

Formatted Text
For formatted text (.xft) variables, Studio inserts variable names in the PFVar 
attribute of <span> tags. This is similar to how Studio handles formatted HTML, 
except all text styles, such as bold or italics, are stripped from the content.

Formatted Paragraphs
For formatted paragraph (.xfp) variables, Studio inserts variable names in the 
PFVar attribute of <div> tags. This is similar to how Studio handles formatted 
HTML paragraphs, except all text styles, such as bold or italics, are stripped from 
the content. However, Studio preserves paragraph breaks.
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Creating an HTML Output Job
HTML Output jobs operate in the same way as print jobs, with some additional 
options. The HTML output driver treats HTML job output slightly different from 
other job output. For example, the HTML driver places HTML output in a 
different folder from print output—the HTML Output folder you specified on the 
Output Options or Server Setup dialog. When creating output, the driver 
appends the transaction ID for the job to both the HTML Output folder and the 
HTML Output URL to form the actual directory and corresponding URL.

To create HTML output, create a job in the same way as described in Chapter 13, 
“Creating Jobs,” on page 283, except choose an HTML Template to access the 
HTML or HTML e-mail output formats. 

HTML format generates output that can be served as a Web page. HTML Email 
generates multi-part e-mails with a primary HTML body and alternative text-only 
body. The remainder of this section will go over the options that appear if you 
choose HTML format. The next section goes over the HTML e-mail format. 

The following options are available when you choose HTML format.

 Destination. This field becomes read-only text. When the HTML driver 
creates output, it copies the contents of the WebPages folder, including all 
referenced images and templates into the Default HMTL Output Folder, set 
in Server. This control is for display purposes only, therefore it is always 
disabled.

The following options are available for image formats:

 Bitmap Format. Choose between JPEG (*.jpg) or CompuServe GIF (*.gif) as 
the format for images to be converted. The HTML driver does not convert 
images that have been referenced in absolute URLs.

 Quality/Compression. Choose to optimize image quality or size. This 
option is only available for the JPEG format.

 Downsample images over [a specified] dpi. Select this check box and 
enter the dots per inch (DPI) value over which the HTML driver will 
downsample images. This is optional. When selected, images over the 
specified DPI threshold are downsampled to the specified DPI. Images at or 
below the threshold are not upsampled.
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Generate output the same way you would with print jobs. See Chapter 14, 
“Generating Output,” on page 345 for details. The post process steps are also the 
same as with print jobs. See “Adding Post Processes” on page 313 for details.

Previewing HTML Output
Preview your HTML Output on screen as with your other templates. The screen 
shot below shows a sample:

Studio opens in browse mode, enabling links and image conversion. Click the 
rows to see a live preview of each HTML microsite or e-mail message. If you click 
a link, it opens the associated page in a new window of your default Web 
browser.
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Creating an E-mail Output Job
Create a job in the same way as with an HTML Output job. The Output tab for 
HTML e-mail jobs is the same as that for HTML jobs. Select an HTML template, 
choose HTML Email format, and fill in the options in the Input and Output tabs, 
and click the Output tab. The Properties button enables you to set HTML e-mail 
output properties.

Note: Before you can send e-mail output, you must set up a local or remote 
SMTP server. Enter the SMTP Server Settings for E-mail on the Output Setup 
screen (page 348).
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Output Properties
Press Properties to display HTML E-mail Output Properties.
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E-mail

You have a number of e-mail header options to choose from. You can use 
variables from your template, by clicking on the drop-down box to choose from a 
list, or typing in a static value for the e-mail subject, recipient, sender, reply to 
address, carbon copy (CC) and blind carbon copy (BCC) boxes. The recipient and 
sender boxes are required for job submission. All other boxes may be blank.

Options

 Embed images in e-mails. Select this check box if you want to embed 
images in e-mails. Some e-mail reader programs block images served from 
the internet. Select this option to send images within your e-mail output. 
Embedding increases the size of each e-mail but does not require a Web 
server to serve the images when the e-mail is opened.

Not all images are embedded when you select this option, only <img> tags. 
Other areas, such as a background image, are not embedded.

 Purge output directories after e-mail is sent. Select this check box to 
delete all of the output files after the e-mail has been sent. You may not want 
to keep a record of every e-mail you send. If you choose this option, all 
output files will be deleted after being sent.

SMTP Server

You can choose whether to use the default SMTP server to send HTML e-mail 
messages or a custom SMTP server.

 Choose Use default SMTP Server settings to use the default Microsoft 
SMTP Service to send HTML e-mails.

 Choose Use the following SMTP Server settings to enter a different SMTP 
server and enter the information below.

 SMTP Server. Enter the name of the SMTP server to use.

 Port Number. Enter the port number to use. The default is 25.

 Use SSL. Select this check box to use Secure Sockets Layer (SSL), if the 
mail server supports it.

 Use SMTP Authentication. Select this check box if the mail server 
supports authentication, then enter the User Name and Password for 
authentication.

Click OK when you are done setting HTML e-mail output properties, or Cancel 
to exit without saving changes.
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Serving Images from the Internet
Images used in HTML e-mails can be embedded in the e-mail, or they can be 
referenced with an absolute URL. Not embedding is the default. The following is 
strongly recommended when not embedding images in HTML-formatted e-mail 
messages:

1 Create a website that will be used to serve the images.

2 Prepare all images that will be used by the e-mail blast.

3 Copy the images to the image source website.

4 Use the absolute URL of this website for all image references in the HTML 
template. For example: 

http://www.example.com/yourimages/bigimage.jpg

Listed below are some suggestions for how you can do this:

 Use an absolute URL in the database column corresponding to the image 
source. For example:
http://www.example.com/yourimages/bigimage.jpg

 Store the image file name in the database, and use a script or constant to 
prepend the image URL to the image file name.

Testing E-mail Output
Create some e-mail accounts on your network to test e-mail output. Set HTML 
e-mail out jobs to use these addresses to receive your e-mails.
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Conversion Tools

You can design your templates using Adobe® InDesign® or 
QuarkXPress™ and import them into Studio using template conversion 
plug-in and extension utilities for the appropriate application. This 
chapter describes these tools in detail.
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Using the Pageflex Plug-in for Adobe InDesign
The Pageflex DesignOut Plug-in for Adobe InDesign exports documents from 
InDesign into the Pageflex document format. A document exported by the plug-
in, when viewed with a Pageflex application, closely resembles the original 
InDesign document. The plug-in preserves text, text composition, images, 
graphics, and layout positions as accurately as possible while converting 
InDesign properties to corresponding Pageflex properties.

Each export creates an XDT file containing the document content and layout 
information in XML format, and a TSL file containing the document models and 
styles. Exported documents can be opened by current Pageflex applications.

Note: Not all Adobe InDesign features have equivalent features and settings in 
Pageflex products. Your exported Pageflex templates may not exactly match the 
original Adobe InDesign documents. Always review exported templates and be 
prepared to make edits and adjustments if needed.

Latest Update
You can download the latest plug-in from the Pageflex Support website:
http://www.pageflex.com/support. New and updated builds of the plug-in are 
periodically posted at this site.

Installing
Extract the plug-in, “PFExport.pln” and follow the steps below to install it.

 To install the plug-in

1 Exit Adobe InDesign if the application is running.

2 Copy “PFExport.pln” into the Plug-Ins folder inside the Adobe InDesign 
application folder (the “\Plug-Ins\Filters” folder in Adobe InDesign CS).

3 Restart InDesign.

4 Choose Configure Plug-in from the Help menu on Windows or the 
InDesign menu on Mac OS. Look for “PFEXPORT.PLN” in the All Plug-ins 
list. 

5 Enter the location of the plug-in.
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Exporting InDesign Documents
The plug-in exports InDesign documents in their current state, whether saved or 
not.

 To export document templates

1 Make a document active in InDesign and choose Export from the File menu. 
This opens an Export dialog box.

2 Enter a name for the exported document. The file extension “.xdt” will be 
automatically applied by the plug-in if you do not type it yourself.

3 In the dialog box, choose Pageflex Template from the Save As Type menu.

4 Click Save. The document is saved as an XDT file with an associated TSL file 
in the Pageflex format.

Opening an Exported Template in Studio
To open a Pageflex template with Studio, choose Open in the File menu and 
browse to the template. 

Carefully examine the exported document and make any corrections necessary 
due to conversion inaccuracies.

Notes on Supported and Unsupported Features
While the plug-in attempts to export all properties as accurately as possible, you 
may see some unavoidable differences in areas such as text composition or color 
management. See the readme that comes with this plug-in for the latest updates.
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Using the QuarkXPress XTension
The Pageflex QuarkXPress XTension exports documents from QuarkXPress into 
the Pageflex document format. An exported document, when viewed with a 
Pageflex application, closely resembles the original QuarkXPress document. The 
extension preserves text, text composition, images, graphics, and layout 
positions as accurately as possible while converting QuarkXPress properties to 
corresponding Pageflex properties.

Each export creates an XDT file containing the document content and layout 
information in XML format, and a TSL file containing the document models and 
styles. Exported documents can be opened by current Pageflex applications.

Note: Not all QuarkXPress features have equivalent features and settings in 
Pageflex products. Your exported Pageflex templates may not exactly match the 
original QuarkXPress documents. Always review exported templates and be 
prepared to make edits and adjustments if needed.

Latest Update
You can download the latest XTension from the Pageflex Support website:

http://www.pageflex.com/support

New and updated builds of the XTension are periodically posted at this site.

Installing or Uninstalling
Follow the instructions below to install or uninstall the plug-in.

 To install the QuarkXPress plug-in

1 Exit QuarkXPress if the application is running.

2 Decompress the software archive.

3 Copy the “PFExport.xnt” file into the “XTension” folder within your 
QuarkXPress application folder. 

4 Launch QuarkXPress to use the Pageflex XT.
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 To uninstall the plug-in

To uninstall Pageflex XT, remove it from the XTension folder. 

Exporting a Document as a Pageflex Template
Follow the steps below to export a document template.

 To export a document template

1 Choose Export Pageflex Template in the Utilities menu.

2 Choose a filename and location for the exported template and click OK. Your 
document is saved as an XDT file with a supporting TSL file. 

The plug-in creates a log file (with the extension “.log”), providing 
timestamps, filenames and other export details, and any errors encountered 
during the export process.

Opening an Exported Template in Studio
Converted files can be opened the same way as Studio-generated files. In Studio, 
choose Open from the File menu and browse to the template that you want to 
open. Highlight it and click Open.

Notes on Supported and Unsupported Features
While the plug-in attempts to export all properties as accurately as possible, you 
may see some unavoidable differences in some areas. See the ReadMe that comes 
with this plug-in for the latest updates.

Latest Versions
To download the latest version of Pageflex XT, go to the Pageflex Support 
website, listed below, and look for the Free Stuff at the bottom of the page:

http://www.pageflex.com/support/
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Librarian

You can use Pageflex Librarian to manage your data assets and create 
complex rules for variable insertion. This chapter describes the Librarian 
application.
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Introduction
Pageflex Librarian lets you create a library for the content files for your variable 
publishing project. Librarian uses the same file folder hierarchy that all Pageflex 
projects use. Image files are in the Images folder; text files are in the Text folder. 
A library can contain the following types of content files:

 Plain text files

 Image files

 Formatted content files (formatted text, formatted paragraphs, and 
area templates)

In the library for a project, you define a set of categories. For each content file, 
you can assign a term under each category. The categories and terms you assign 
should help you identify the content file or its purpose in the project. 

In Pageflex Studio, you use the categories and terms to create a library query as 
part of the definition of a variable. A library query is a command to search the 
library for a content file that matches the categories and terms you specify. When 
you assign the terms and categories to the content of the library, you want to 
make sure each content file has a unique combination of categories and terms to 
identify it.

Using a Library Query
In your variable publishing project, you can use a library query to define a 
variable. The library query can retrieve content files based on the values you 
entered in the categories. A library query can have one or more statements joined 
together with “And” or “Or.” Each statement has four parts.

 Library Category. Library categories contain the words used to classify each 
library item. You can also use the filename of the content file. 

 Operator. The operator is the “verb” for the statement. It defines the 
relationship between the library category and the profile variable or literal 
text that follows. 

Library Category 
or Filename

Operator Profile Variable 
or Literal Text

Connector
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 Profile Variable or Literal Text. In this box, you can select a profile variable 
to use, or you can type literal text to use to create a relationship to the library 
category. 

 Connector. You can connect multiple statements using the expressions 
“And” or “Or.” 

In the following example, the library query retrieves the content based on the 
parameters of the query. Pet Type, Pet Breed, and Pet Color are categories in 
the library. 

Filename: lab_retriever.tif
Pet Type: dog
Pet Breed: labrador retriever
Pet Color: black

Filename: gold_retriever.tif
Pet Type: dog
Pet Breed: golden retriever
Pet Color: gold

Filename: poodle.tif
Pet Type: dog
Pet Breed: french poodle
Pet Color: white

Filename: ger_shepherd.tif
Pet Type: dog
Pet Breed: german shepherd
Pet Color: tan

Library Query

Pet Shop Library

Library Category
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Understanding the Librarian Environment
The Librarian application window displays the library information.

 File List. The file list shows all the content files in the library. The icon in 
front of each content file indicates what kind of file it is. 

 Plain Text  Image

 Formatted Text  Formatted Paragraphs

 Area Templates

 Category Names. A library can include up to 10 category names to classify 
the library content files. Each category has its own column following the 
columns for Filename and Kind. 

Click a column head to sort files by the column values.

 Content Preview Panel. The content file appears in the Preview panel. Drag 
the menu bar to detach this panel. You can resize the Preview panel to 
display larger or smaller previews as needed. 

 Image files appear as image previews. 

 Plain text files appear as text. Formatted text and formatted paragraphs 
appear as text including the formatting codes. 

 Area templates do not display a preview.

 Categories Panel. In this detachable window, classify files by assigning 
values to categories. Select a file to display its values in this panel.

File List Category Names Content Preview Panel

Categories 
Panel
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Working with Libraries
To use a library with a project, you must create the library in the main project 
folder. If you have not created the project folder yet, Librarian creates the project 
folders when it creates the new library. You can create more than one library in 
the same project folder.

Store the content files according to the folder name:

 Text—stores all plain text, formatted text, and formatted paragraph files.

 Images—stores all image files (EPS, TIFF, JPEG, GIF and PDF).

 Area Templates—stores all area template files.

Studio creates the following folders, but librarian does not manager them. Do not 
store any library content in these folders as you will not be able to access it.

 Scripts—stores scripts used in your variable publishing project.

 WebPages—stores HTML content.

 To create a new library

1 Choose File > New or click the New button on the toolbar .

 Main Project Folder
 Area Templates
 Document Actions
 Images
 Scripts
 Text
 WebPages
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2 Type the name of the library in the Library Name box.

3 In the Project Folder box, type the path to the project folder.

-or- 

Click on the folder button  to select a folder.

Note: If you enter a project folder that does not exist, Librarian creates the 
main project folder and the content folders inside it.

4 Click the Add Existing Content box if you want to add any existing content 
already stored in the project folders to the new library. If the project folders 
are empty, this option has no effect.

5 Click OK to create the new library. 

Librarian automatically saves all changes to the library immediately.

 To open an existing library

1 Choose File > Open, or click the Open button on the toolbar 

2 Navigate and select the library file (*.pfl) you want to open.

3 Click Open. Librarian displays a list of all files in the library.
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Setting Up Categories
All new libraries begin with 10 categories using default names. 

When you create a library query in your variable publishing application, use the 
category names to define the query parameters. You can change the category 
names at any time, and the variable publishing application updates the library 
queries to use the new category names.

To help with categorizing content files, you can add a list of default values for a 
category. When you classify content files, you use a default value from the list or 
type new value.

 To set up a category

1 Choose Content > Categories Setup. Librarian displays the Categories 
Setup dialog box.

2 You can specify the number of categories that Librarian displays for each file 
in the library by selecting a number in the Number of categories to use 
box. The maximum is 10. 

Category label Default Value box

List of 
default 
values
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If you reduce the number of categories, Librarian deletes categories starting 
from the last one in the list. Any values you have assigned to that category 
are deleted when you delete the category.

3 To change a category label, type the new label in the box beside the category 
number. 

4 You can add default values to use for any category. When you classify the 
library contents in the categories editor, you can select default values from a 
list rather than typing them every time. Add the most commonly used values 
to the list. 

 Select a category by clicking inside its label. The category name appears 
in the heading to the Default Values section.

 In the Default Values box on the right side of the dialog box, type a 
default value.

 Click Add. Librarian adds the default value to the list.

 Repeat these steps to add additional values. To remove a value, select it 
and click Delete.

5 When finished editing category names, click OK.

Librarian automatically saves all changes to the library immediately.

 To edit the default values

1 On the Categories Setup dialog box, click an entry in the Default Values list. 
the entry appears in the Default Values box. 

2 Edit the value.

3 Click Add. Studio changes the default value in the list. 
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Adding and Removing Files
You can add Text, Image, Formatted content, or Area Template content files to 
the library at any time. Librarian requires that all content files be stored in the 
folders inside the main project folder. When you add a new content file, one of 
the following occurs:

 If a content file already exists in the correct project folder, Librarian makes a 
new library entry and leaves the content file where it is.

 If the content file exists outside the project folders, Librarian creates the new 
library entry and copies the content to the correct project folder for the kind 
of content it is.

 To add a file to the library

1 Choose Content > Add, or click the Add Content button on the toolbar . 
Librarian displays the Add Content dialog box.

2 Locate the content file you want to add. To add more than one file from the 
same folder, hold down the CTRL key and click each content file. Hold down 
the SHIFT key to select a range of files. 

3 Click Open. Librarian adds the selected files to the library.

Librarian automatically saves all changes to the library immediately.
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 To remove a file from the library

You can remove a file from a library at any time. When you remove a file, 
Librarian only removes its entry in the library; the actual file content remains in 
the project folder.

1 Select the library entry in the file list. To select multiple files, hold down the 
CTRL key, and click each file, or hold down the SHIFT key to select a range. 

2 Choose Content > Remove, or click the Remove Content button  on 
the toolbar.

Librarian removes the selected entries from the library. The content source 
files remain in the project folder.

 To preview a file

1 Click a content file in the file list.

2 The content file appears in the Preview window. 

 Image files appear as image previews. 

 Plain text files appear as text.

 Formatted text and formatted paragraphs appear with formatting codes.

 Area templates appear as with a generic area template icon.

3 The bar below the Preview window provides additional information. 

 For text (including formatted text and formatted paragraphs), it indicates 
the type of text and the number of characters.

 For an image, it displays the height and width.

 For an area template, it displays the type (area template).

Additional information

Detach the window by 
dragging the title bar. 

Resize the window by 
dragging any edge.
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Classifying Library Content
Classifying library content is the process of giving values to categories for each 
content file in the library. You do not have to fill in a value for every category. A 
library query can find empty values.

 To classify a content file

1 Click a content file in the file list.

2 In the Categories editor, type a value next to the category name. If the 
category has default values, you can select one from the list.

3 Press the ENTER key to enter the value, or press the TAB key to move to the 
next category.

The new values for the file appear in the category columns in the file list. 
Librarian saves all changes to the library immediately and automatically. 

 To classify more than one file at a time

1 Select multiple files by holding down the CTRL key and clicking each file or by 
holding down the SHIFT key and selecting a range of files.

The Categories editor displays the values for each category that are the same 
for all the selected files. If the selected files have mixed values for a category, 
the category appears empty.

2 Type a value in any category. If the category has default values set up, you can 
select a value from the list.

3 Press the ENTER key. 

Studio updates the category value for all the selected content files. If the 
selected files have different values in the category, Studio makes them all the 
same.
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Packager

If you need to package a Pageflex project for archive or to move it onto 
another machine, you can use the Pageflex Packager utility. This 
chapter describes how to use Packager.
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Introduction
Pageflex Packager is a utility that collects and saves the entire Pageflex project 
tree into a folder or zip file (a package), so that projects can be archived or 
transferred to other computers. Packager also unpacks and saves the contents of 
a package file so that it can be modified by Pageflex applications. Linked images, 
fonts, and Web pages are copied and saved into the package, as well as the 
contents of the project folder.

Packager maintains the entire project tree structure including any custom sub-
folders created by the user when creating a package. Packager also creates any 
project folders in the package that may not have existed in the source project 
tree.

When a package is unpacked, the underlying project folder tree of the source 
project is recreated, including any project element and font files needed to make 
the package complete.

Packager lists the name and location of the project folder in the Window title.

Status Bar
Located at the bottom of the dialog box, this displays the action being currently 
taken by the Packager utility, or the size of project folders (this is a virtual 
representation of the size of your project folder, as some elements such as fonts 
or images may be linked to your project from other folders).

Using Packager Folders
Before opening and editing a project folder that has been packaged, you must 
install the fonts in the Project Fonts folder on the system the package now 
resides on. You must also install the ODBC connections in the new location.
 388 Packager



Chapter 17
Creating Packages
Follow the steps below to create packages.

 To create a new package from an existing project

1 Choose the New package command on the File menu, or click the New 
Package icon .

2 Browse for the project folder that contains the project you would like to 
package.

3 Highlight this folder and click OK to collect the project elements. The status 
bar displays “Collecting Project Elements.”

4 If any project elements could not be found, Packager displays the Missing 
Contents dialog.

If no elements were missing, Packager displays the project folders in the 
Collected Contents window. Click on a folder in the collected contents 
window to display the folder’s contents in the opposite pane.

5 Save your package.

 To save a project to a folder

1 Choose the Save to Folder command on the File menu, or click the Save to 
Folder icon.

2 Browse to the location where you would like to save your project folder.

3 Click New Folder if you would like to create a new folder in which to save 
your project folder. Rename this folder, if necessary.

Note: This folder will be the parent folder of your project folder. For 
example, if you chose to save your project folder to “C:\Pageflex\Projects”, 
your project files would be located in 
“C:\Pageflex\Projects\YourProjectFolder”.

4 Click OK to save your package to this location, or Cancel to abort.
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 To save a project as an archive or zip file

1 Choose the Save as Archive command on the File menu, or click the Save 
as Archive icon.

2 Browse to the location where you would like to save your archive file.

3 Choose a Package Compression level:

 No compression. Packager performs no compression action.

 Medium compression. Packager performs some compression actions. 
This option is faster than maximum compression.

 Maximum compression. Packager performs the most compression. This 
option is the slowest archive option.

4 Choose a location to save your file and click Save to save your file to this 
location, or Cancel to abort.
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Finding Missing Contents
Packager displays the Missing Contents dialog if the referenced file no longer 
exists, was moved, or exists on a network location that wasn't available when 
Packager created the package. Packager displays the Missing Fonts dialoge if the 
machine running Packager does not have the referenced fonts installed. 
Therefore, it is recommended that you run Packager on the machine on which 
your project files are located to insure that you are getting the correct files and/or 
fonts.

Packager creates a “PackagerErrors.log” file that lists the missing contents, if the 
package is missing anything.

Missing Files
Click Locate Files to bring up a browser window to re-associate the files.

You don’t need to re-associate missing contents in order to create a package, but 
if you don’t re-associate the contents, the missing contents will not be included 
in your package.

Missing Fonts
Fonts must be installed on the computer running Packager. This could cause a 
discrepancy if you have different fonts with the same name installed on both the 
machine running Packager and the machine with the project files. Packager will 
use the fonts installed on the machine running the Packager utility. 

If you get this dialog, install the fonts if they were not previously installed, and 
click Re-collect Fonts to add them to the package.

If you see missing fonts when running Packager to create packages across a 
network, it is recommended that you run Packager on the machine that the 
project folder is located on, as presumably all the fonts needed by the project will 
be installed this machine.
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Opening Packages
Follow the steps below to unpack and save an existing package.

 To unpack and save an existing package

1 Choose the Open package command on the File menu, or click the Open 
Package icon.

2 Browse for the package you would like to open.

3 Highlight the package you would like to open and click Open to open it. 
Packager displays the project folder in the Archived Contents window.

4 Highlight folders in the Archived Contents window to display the contents 
of these folders in the right pane.

After opening a package you may want to save it as a project folder so that you 
can use it.
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Glossary
 Archive Contents—The display panel in the content area that displays the 

archive folders in one pane, and the archive folder contents in the other.

 Content Area—The main panel in Packager that displays project folders and 
project folder contents.

 Collected Contents pane—The display panel in the content area that 
displays the project folders in one pane, and the project folder contents in the 
other.

 Menu bar—The window area that displays the menu options.

 Missing contents—Project elements referenced in the project template or 
data source that could not be found in the project folder or referenced 
folders.

 Package—The collected contents of a Pageflex project, including referenced 
images, fonts, and Web pages.

 Pageflex project—A marketing-on-demand solution that allows you to 
assemble content into unique documents, each customized for a particular 
use, or personalized for a particular individual.

 Project folder—The folder that contains the elements necessary for a 
Pageflex project. Does not need to include referenced images, fonts, or Web 
pages.

 Status Bar—The window area located at the bottom of the dialog box that 
displays the size of project folders and packages, or the action being currently 
taken by the Packager utility.

 Tool bar—The window area that displays icons corresponding to file menu 
options.

 Window Title—The window area that displays the name and location of 
project folders and archive files.
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Index 1
A
absolute leading 139
Access database 242 to 244
access database 245
Across from left 303
Add Point tool 31
adding a data source 245 to 254
adding columns 61
adding images 66 to 68
adding jobs 285 to 292
adding variables 263 to 264
Adobe Acrobat PDF format 66, 315 to ??, 

320 to 329
Advanced Copy Fit Rule 171
advanced record selection 288
Advanced Rules (copy fit) 166
Align To (line) 76
alignment 139
Alignment on page 320
All Records 287
allow 119
allow breaks 136
alternate panels 122
Anchor 109
anchor flex 109 to 110, 178
anchor point 110, 182, 183

select 110
Anchor X 109
Anchor Y 109
Angle property 98
angles

creating 76
application menu bar 25
Apply latest composition rules 45
Apply Mpower 2.x/Persona 1.x composition 

rules 45
Apply Variable 369
apply variable with variables list 264
applying

character properties 128 to 136
variables 263 to 264

applying editing constraints 119
applying selection constraints 119
Area template

convert 78
area template

add existing element 72
add new element 72
Bézier shape 73
container tools 32
containers 72 to 73
create 68, 72
creating 72
definition 158
polygon 72
ungroup 86
using 163 to 165

Area Template Bézier Tool 73
area template Bézier tool 32
Area Template Box 72
area template box tool 32
Area Template Oval Tool 72
area template oval tool 32
area template polygon tool 32
area template properties 163
area template tools 32
area template variables 257
Arguments 310
ASCII image format 319
asset management database 236
Autochain 113
autochain

chaining 209
reordering pages 211
unchain 207
unchaining 210

Autochain Master 208
autochain masters 204
autochain on overflow 206
Autochain property 30
autochain text container

create with existing master 205
create with new master page 204

autochain text containers 204
autogen folder 359, 366, 367, 370
auto-hide condition 187
Automatic Page 208
automatic pages 208
Avoid Me property 87 to 89, 102

B
balance columns 61 to 62
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balancing columns 62
Based On (style) 149
Based On (styles) 150
baseline shift 135
batch data records 289
batch file 284, 312, 314
batch post process 313
Bézier

area template 73
bézier curve

add 77
Bézier shape

convert 78
creating 65

Bézier text path
convert 78

Binary image format 319
Bitmap Format 330, 372
Bitmap format 315, 330 to 331
bitmap size 330
blank

job media 334
Bleed option 291
bleeds 284
border

centered 75
color 75, 100
define 74
for elements 99
for pages 54
inside edge 75
invisible 39
line style 76
placement 75
style 75, 100
thickness 75, 100
tint 75, 100
weight 75

border and line styles 73 to 76
Border Color 54
Border Style 54, 74
Border Thickness 54
Border Tint 54
Bottom Edges 80
box 59
Bring Forward 79
Bring to Front 79
Bumpers 85 to 86, 87, 101 to 102, 

184 to 185

C
campaign HTML form variables 258
Campaign URL variable 258
case 135
CCITT Group 4 image compression 324
Center 81
Center on page 319
Chain tool 33, 62, 63
chaining text containers 62 to 64
changing case 135
character entities 365
character properties

applying 128 to 136
Chinese character settings 152 to 154
font color 130
font name 129
font size 129
horizontal scale 129
hyphenation 130 to 132
Japanese character settings 154 to 156
kerning pairs 134
language 130
subscript 134
superscript 134
underline 129
word spacing 132

character spacing
Kana 155
Kanji 155

checking spelling 175
child element 178
Child style 148
Chinese character settings 152 to 154
Chinese/Roman Boundary Space 153
Class 310
Classifying Files in Librarian 395
Clipping Offset 104
clipping path 66, 103
CMYK 90, 92

color matching 36
color profile 330
process colors 90 to 93

color 125
borders 75, 100
defining 90 to 93
delete 93
editing 92
fill 99
lines 96
matching 36, 330
profiles 36, 330
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rules 146
text 130
variable highlights 36

Color and Border properties 99
Color Bitmap Image Compression 324
color model 92
Colors

view 42
column

balancing 61 to 62
breaks 61 to 62
guides 35, 54
text boxes 61 to 62, 102

Column Balance 107
column balance behavior 62
column break 62
column guides 35
columns 61
Columns property 102
comma-separated value

See CSV 245
composition method for line breaks 139
composition rules 45
compression for bitmaps 330
compression of images 324
Compuserve GIF 330
concave corners 75
Condense Japanese Punctuation 156
Condense Punctuation 153
Configuration 118
configuration file 125
configuration property 111
Constant 311
constant variable

create 266
define 266

constant variables 259, 266
constraints 118

designing 121
using variables 120

constraints property 111
content 19
content data source 19, 236
Content Options 289
content personalization 19 to 20
content source plug-ins 260
content variable 236

define with a rule 267, 268, 269, 270
content variables 259
Control applets 117
Control points 76

convert
angle to Bézier control point 77

Convert PostScript to PDF 315
Convert to Area template 78
Convert to Bézier shape 78
Convert to Bézier text path 78
Convert to Text Container 78
copy fit

font size 166
horizontal scale 167
leading 167
space after 168
space before 167
tracking 168
view 169

Copy Fit Down To property 141
copy fit rule 109

advanced 171
simple 170

copy-fit rules 166 to 172
copying master pages 196
Corner 76
Corner Radius border style 75
corners

concave 75
rounded 75

creating
area templates 72 to 73, 163 to 164
elements 58 to 76
formatted paragraphs 161
formatted text 159
line breaks 137
lines 73, 96
native PDF output 320 to 329
shapes 64 to 66
templates 43 to 45
text containers 58 to 60

CreoScitex VPS 315
Crop 106
Crop Content 106
crop marks, print marks, registration 

marks 291
cropping an image 68
CSS 363
CSV 245
curve

adjust 77
curves

creating 76
custom 308
custom document actions 308
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customizing shortcut keys 37
Cut and Stack (Multi Record) 293
cut and stack multiple record imposition 

style 298

D
Dash Size 76
Dashed 75
dashed lines 76
data ingestion 20
data merge sequence 302
Data Record 289
data records

batch 289
Data Source 286
data source

add 245
change 251
create new 252, 253
manually add profile data source 265
remove 251

Data Source Name 244, 253
data sources

adding 245 to 254
content data source 19, 236
data source wizard 252 to 254
database file 247
editing 250 to 251
login 250
ODBC 246
passwords 250
profile data source 19

database
access 245
CSV 245
Excel 245
files 247
formats 242 to 244

database file
using with project 247

databases
and projects 242

default document actions 308
Default HMTL Output Folder 372
default input slot 336
default job media 334
Default Output Folder 330
Default Output folder 288
Define Colors 90
Define Styles 147, 150
defining

colors 90 to 93
copy-fit rules 170 to 172
profile data source variables 265
styles 147 to 151

deleting
pages 51
styles 150

deleting log files 355
deleting master pages 197
DesignOut Plug-in 380
DesignOut plug-in

installing 380
Destination 288
dictionary 175
do not embed fonts 327
document

content 19
form 19
instance 315

Document Actions 284, 307, 308
document actions 308

adding 309
compilation errors 311
copying 309
default 308
duplicating 309
moving 310
removing 309

document applet 117
document area 24
document instance 24
Document Instance properties 317
Document Page 208
document page list 29
document template 24
document variables 214, 257
document window 26
Dotted 75
dotted lines 76
Down from top 303
downloading fonts 319
Downsample images 372
downsampling images 323
drag and drop variable 263
Drop Cap 141
drop caps 141
duplicating master pages 196

E
.EDIT

tab 30, 94, 111, 117, 118
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.EDIT Names
view 42

Edit the current data source 250
editing

colors 92
data sources 250 to 251
styles 149

editing constraints 119
element

align 80, 81
angle 82
arrange stacking order 79
child 178
layer 79
lock 87
name 124
parent 178
resize 82, 83
resize in proportion 83
rotate 81, 82
selecting with layout tab 79
stacking order 79
unlock 87

element column 28
element name 124
elements

definition 58
grouping 83 to 86
parent-child relationship 178
printing suppressed 290
properties 94 to 110
ungrouping 86
view or hide suppressed 339

e-mail header options 376
e-mail output

testing 377
embed all fonts 327
Embed images in e-mails 376
embedded images in e-mail output 377
Encapsulated PostScript 315
End points 76
EPS 315
EPS images 66, 68
EvaluateVariables 308, 309
Excel 245
Excel spreadsheet 243
exporting

area templates 163 to 164
formatted paragraphs 161
formatted text 159

exporting area templates 163

exporting document from QuarkXPress 383
exporting documents from InDesign 381
extended debugging logs 355

F
file system as data source 236
Files Tab 235
files toolbar 26
Fill Color property 99
Fill Tint property 99
filler page

advanced (example) 222
editing 224
viewing 223

filler page rule
advanced 220, 221
simple 220

filler pages 219
Final Output Folder 288
Final Output folder 354
find and replace 173
find missing contents 401
Find Next 173, 174
finding text 173 to 174
first line indent 144
Fit Height property 70, 96
Fit Image 69, 95
Fit paragraphs on single lines 172
Fit Width property 69, 95
Fixed Group 83
fixed group

create 84
fixed groups 83
fixed shape tools 32
fixed shapes 64 to 66
flex 118, 119

anchor points 182
behavior 178 to 183
combining behaviors 181
definition 19
height 178 to 182
properties 107 to 110
set boundaries 184
using with variables 187
width 178 to 182

Flex Behavior 107, 108
Flex Height 107
flex height

minimize 179, 180
Flex Height property 107
Flex tab 30
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Flex Width 108, 178
flex width

maximize 180
minimize 179

Flex Width property 108
font

color 130
name 129
size 129
style 129
substitution 46

font handling in PDFs 327
Font Size (copy fit) 166
Font size down to 170
Fonts

view 42
fonts 125

missing 47
permanent replacements 46
temporary replacements 46

force justify 139
forcing a column break 62
form 19
Form tab 30
form variables 258
Format 286
formatted HTML (.hft) variables 369
formatted HTML paragraph 365
formatted HTML paragraph (.hfp) 

variables 370
Formatted HTML Paragraph Variable 360
formatted HTML paragraph variables 258
Formatted HTML Variable 360
formatted HTML variable 364
formatted HTML variables 258
formatted paragraph variables 257

and HTML output 371
formatted paragraphs 158, 161 to 162
formatted text 158, 159 to 160
formatted text variables 256

and HTML output 371
formatting

remove style 151
Free Edit 116
freehand line

create 74
Freehand Pen Tool 65
Freehand Pen tool 31
function name 273
functions

adding parameters 273

G
Gap 76
Gaps between Columns 305
Gaps between Rows 305
generating output 347 to 352
generic CMYK 36, 330
generic CMYK color matching 36
GIF 330
GIF images 66
group 118, 119

create 84
ungroup 86

group in area template 68, 72
groups 83

grouping elements 83 to 86
ungrouping 86

guides 33 to 35, 38, 55
column 35
positioning 34
remove 55

Guides in Back 34, 38
Guides in Front 34, 38
Gutter 61
Gutter Size 61
Gutter Size property 102

H
hand tool 33
hanging indents 144
Height 97
.hfp 370
.hft 369
hidden characters 39

view 141
hide elements 187
Hide Overlays 39
highlight color 39
hi-res images 354
Horizontal Alignment 85, 105
Horizontal Group 84, 86
horizontal group

alignment 105
creating 86

horizontal groups 83
horizontal guides 55
Horizontal Scale 305

copy fit 167
horizontal scale 96
Horizontal scale down to 171
horizontal scaling 129
Horizontally Center 80
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HTML
view source 362

HTML e-mail output job 374
HTML image content 367
HTML Output 358

setting up project 359
steps to create 358

HTML output
creating job 372
tagging template 368
use CSS 363

HTML Template 361
HTML template

create 362
tagging 369

hyphenation 130 to 132
Hyphenation Level 131
hyphens 176

I
if...then statements 267 to 270
image

insert PDF 71
image compression 324

CCITT Group 4 324
JPEG 324
ZIP 324

image container tools 32
image downsampling 323
Image Fit property 69
Image Format 290
Image property 95
Image Scaling 178
image tool 32
image variables 257

and HTML output 370
Images

view 42
images 125, 354

adding 66 to 68
and HTML output 367
cropping 68
embedded in e-mail output 377
EPS 66
GIF 66
import from Mac OS 68
in HTML e-mail output 376
include 290
inline 67
JPEG 66
missing 47, 48

omit 289
output options 289
PDF 66
scaling 69 to 70, 96
TIFF 66

import styles 45
imposition

cut and stack multi record 298
setup problems 306
single page 294
step and repeat multi record 297
step and repeat single record 295

imposition setup specified doesn’t fit on 
sheet 306

Imposition Style 293
In Table 287
Include Bleed Area 291
Include Crop Marks 291
Include custom information 292
Include general page information 292
include images 289, 290
Incompatible PPD Format 336
indent

first line 144
left side 144
right side 145

indents 138, 144
InDesign

exporting documents 381
Indigo JLYT 315
Info tab 30

Kind 112
Name 112

ingesting data 20
inline images 67
input slot

default 336
map to job media 336

InputSlot 319, 332, 335
Insert Content 60
Insert Image File 67
insert text 60
inserting

area templates 164
formatted paragraphs 60, 162
formatted text 60, 160
inline shapes 65
pages 51
plain text 60

invisible borders 39
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J
Japanese Character Settings 155, 157
Japanese character settings 154 to 156
JLYT 315
job

creating HTML output job 372
definition 284
HTML e-mail output 374
preview 337, 338
primary settings 285

job media
assign to pages 334
blank space 334
create names 333
default 334
empty space 334
map to PPD input slot 336

Job Name 286
Job Preview window 338
jobs

adding 285 to 292
image options 289
post process 312 to 314
preflighting 352
previewing 337 to 339, 341 to 343
primary key 249
submitting 347 to 352
transactional jobs 340 to 343
Variable Content View 337

Jobs Tab 235
jobs toolbar 26
Jobs using a data source 337
Jobs with no data source (transactional 

jobs) 337
JPEG 315, 330
JPEG image compression 324
JPEG images 66
JScript 270, 278 to 279

K
Kana character spacing 155
Kanji character spacing 155
Keep Lines Together 140
Keep Lines Together property 140
Keep With Next 140
kerning 134
kerning pairs 134
keyboard shortcuts 37

creating 37
properties panel 30

removing 38
Kind ((nfo tab) 112
Kind property 30
Kinsoku settings 157

L
Landscape (left) 304
Landscape (right) 304
Landscape orientation 43
language 130

default 44
layout tab 27

select element 79
Leaders 143
leading 139

absolute 139
minimum 139

Leading (copy fit) 167
Left 98
Left Edges 80
Left Indent 146
left side indent 144
Left/Right Margins 305
left/right master pages 44, 190
Left/Right Masters 191
letter spacing 133
Librarian 386

adding files 393
classifying files 395
previewing files 394
removing files 394

library categories 391
Library Query 260, 274 to 275, 387
Library query 260
library query 386, 391
ligatures 135
line

border 76
breaks 136, 137, 140
create 74
create freehand 74
defining 73 to 76
property 96

Line tool 32
linking text containers 62 to 64
locking elements 87
logs 355
lo-res images 354
Low resolution (if available 290
lowercase 135
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M
Mac OS 68
machine data source 246
magnify view shortcut 37
main document window 26
main project folder 232
Make Packager Zip 241
Make Same Height 83
Make Same Size 83
Make Same Width 83
managing logs 355
mapping variables 249
Margins 75

definition 184
elements 101
pages 44, 54

margins
left/right 305
top/bottom 305

Margins (for elements) 87
marks 284
Marks and Bleeds 284, 291
marks and bleeds don’t fit in gaps 306
marks and bleeds don’t fit in margins 306
Master Element 30, 112
master item

detach from master page 202
master items 201
Master Page 30
master page

change name 194
revert 202

master page list 29
master pages 189

applying 196
creating 193
deleting 197
duplicating 196
editing 194
insert pages 195
page layout 190
selection 44

Match Case 173, 174
Match Whole Word 173, 174
Max Consecutive Lines 131
Maximize 107, 108, 110, 180
Maximum 108, 109
maximum height 96
Maximum Pages per Sheet 306
maximum width 96
measurement 33

measurement units 94, 97, 142
menu bar 25
MergeData 308, 309
Method 310
Microsoft Access Database

using with projects 243
Microsoft Access database 242 to 244, 245
Microsoft Excel 245
Microsoft Excel spreadsheet 243
Min Chars After Break 132
Min Chars Before Break 132
Min Lines After Break property 140
Minimize 107, 108, 179
Minimum 108, 109
missing contents

find 401
missing files 401
missing fonts 46, 401
missing images 47
Multi-line (high) 139
Multi-line (low) 139
multi-line composition 139

N
Name (Info tab) 112
Name property 30
Names 125
naming elements 124
native PDF renderer 315 to ??, 320 to 329
Nested group 86
(No Options) 303
no style 151
No_Master master page 193
Non-breaking hyphen 176
non-breaking hyphen 176
Non-breaking space 176
non-breaking space 176
Number and Gutter Size 54
Number of Page Column 306
Number of Page Columns 305
Number of Page Rows 305, 306
Number property 102
numbering

section 199

O
ODBC 252, 337
ODBC data source

set up 244
ODBC Data Sources 246
Offset 146
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omit images 289
One Sided 305
Online Design and Editing Sessions 116
Open Prepress Interface

See OPI
Open/Shut tab 26
OPI
OPI Server 354
Optimized PostScript 315
orientation

page 304
Output 284, 288, 335
output 347 to 352
output formats 315

Bitmap format 315, 330 to 331
document instance 315
native PDF 315 to ??

output options
bleed 291

oval 59
Oval tool 64
overflow 58
Overprint 44, 103, 130, 146, 319
override HTML image autogeneration 367
Override Overprint Settings. 321

P
package project 241
Packager 398

create new 399
glossary 403
save project to archive 400
save project to folder 399
unpack 402

page 284, 293
panning tool 33
PDF 71

Page and Sheet 284
Page and Sheet option 293
page breaks

inserting 211
Page Content Format 290
Page Information Area 292
page layout 190
page margins 44
page numbering

automatic 198
Page Options 304
page orientation 43, 304
page properties 54 to 55
page relative scale to fit 96

page relative scaling 70
page selection tools 25, 27
Page Size 302
Pageflex Librarian 236, 260, 274
Pageflex project 232
Pageflex project file 235
Pageflex Server 351
Pageflex Storefront 116
PageflexAction 308
PageflexActions 308, 309
pages

converting dynamic to static 212
delete 51, 52
duplicating 53
editing variable pages 216, 217
filler 219
inserting variable pages 214, 215, 216
moving 52, 53
previewing variable pages 218
variable 213

Pages tab 192
pages tab 27, 29
PageSize 300, 319
pan page 33
panel button 122
panelButton 122
Paper Tray 290, 332, 335, 336
paper tray 319

assigning 332
empty space 334
specifying 319

Paper Tray Assignments 290
paper tray assignments 332

add 332
paper tray assignments not available 335
paragraph

formatted HTML 365
paragraph line

breaks 136
paragraph properties 136 to 157

alignment 139
apply 137
character defaults 137
Chinese character settings 152 to 154
composition 139
Copy Fit Down To 141
Drop Caps 141
indents 144
Japanese character settings 154 to 156
Keep Lines Together 140
leading 139
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line breaks 140
Min Lines After Break 140
rules 145 to 146
Space Before and Space After 140
tabs 142 to 144

paragraph rules 145 to 146
create 145

paragraph spacing 140
paragraph styles 147 to 151
parameters list 273
parent element 178
Parent style 148
parent-child relationship 178
pasteboard 25
PDF 301, 315 to ??

change source page 71
font handling 327

PDF image
insert 71

PDF images 66
PDF output 315 to ??, 320 to 329
Pen Tool 31, 65, 78
Pen tool 31
pen tool 77
permanent font replacements 46
personalization 19
Personalized Print Markup Language 316
.pf 235
PFExport.pln 380
PFGetValue 271, 273, 278, 279, 280, 281
placed PDF 66
placeholder text 362
placement

border 75
plain text variables 256
Plus sign 147
point

add 78
add to line 78
move 77

Point Conversion Tool 77
Point Conversion tool 31
Point X 99
Point Y 99
Polygon 64
polygon 59
Polygon dialog box 73
Polygon tool 64
polygon tool 32
polygons 64

area template 72

freeform 65
text 59

Portable Document Format 315 to ??, 
320 to 329

portable document format 66
Portrait (down) 304
Portrait (up) 304
Portrait orientation 43
Position property 98
post process 312 to 314

adding 312, 313
arguments 314
batch file 312, 313
executable 314
setup 313

Post Processes 284
PostScript 315, 316, 318
PostScript format

optimized 315
PostScript Printer Description

See PPD
PPD 300, 318

add 319
change sheet size 301

PPD settings 319
PPML PostScript 316
PPML VDX 316
preferences 33, 36, 37, 39, 94, 97, 142
Prefix Letter 353
preflight 352
prevent 119
preview

with suppressed elements 339
previewing

variable pages 218
previewing colors 36
previewing jobs 337 to 339, 341 to 343
primary job settings 285
primary key 249
Print Style 305
print suppressed elements 290
print suppression 103, 339, 342
printing pages and pages ranges 288
Process Color 91
process color 90
Process colors 90
profile data source 19, 235, 237, 242, 337

manually add 265
setting up 243

Profile Data Source Table 259
profile data source variables 265
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profile personalization 19
profile variables 259
profile variables in scripts 271
project 19, 232

create 238
open 239
package 241
save 240

project file 24, 235
project folder 232
project folders 232
Project Fonts folder 232
Project panel 38
project panel 26
projects

variables 263 to 264
properties

anchor flex 109 to 110
Bumpers 85 to 86, 101 to 102, 184 to 185
character 128 to 136
Color and Border 99
Document Instance 317
element properties 94 to 110
Fill Color 99
Fill Tint 99
Fit Height 70, 96
Fit Width 69, 95
flex 107 to 110
Flex Height 107
Flex Width 108
Gutter Size 102
Image 95
Margins property 101
Number 102
page properties 54 to 55
paragraph 136 to 157
Position 98
Size 97
Special 102 to 105
Xerox VIPP 317

Properties panel 30, 38
properties panel 25, 30
Purge output directories after e-mail is 

sent 376

Q
QFactor 324
QFactor slider 324
Quality/Compression 372
QuarkXPress

exporting document 383

QuarkXPress XTension 382
installing 382

query 260

R
radius 59
Range 288
Re-collect Fonts 401
Record Selection 284, 286
record selection

advanced 288
simple 287

Record Selection tool bar 38
Rectangle tool 64
rectangle tool 32
red box on text container 58
Reduce leading and paragraph space 171
reduce view shortcut 37
Remove Point tool 31
removing

pages 51
styles 151
variables 264

removing master pages 197
Replace All 174
replace text 174
replacing text 173 to 174
Reset Defaults 325
reverting templates 49
RGB 90, 92

process colors 90 to 93
Right Edges 80
Right Indent 146
right side indent 145
Roman Language 153, 156
Roman Line Breaks 153, 156
Roman/Japanese Boundary Space 155
rotating elements 98
rotation tool 33
rounded corners 75
Rule Above 146
Rule Above Paragraph 145
Rule Below 146
Rule Below Paragraph 145
ruler origin 34

change 34
Ruler Units 36
ruler units 97
rulers 33 to 35, 38

display 34
rules 145 to 146, 260, 267 to 270
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Runaround 103
runaround 87 to 89

create 88
Runaround property 88

S
saving templates 49
Scale to Fit 70
scale to fit 96
Scale to Fit (Page Relative) 70
scaling images 69 to 70, 95
scripts 260, 270 to 281

adding functions 273
adding parameters for functions 273
returning system variables 273
using profile variables 271

section mark 200
section numbering 199
selection 124
Selection and Editing 111, 118
selection constraints 119
Selection handles 201
selection handles 206
Selection tool 31, 63, 67, 77, 78
Send Backward 79
Send to Back 79
sessions 116
Set Arguments 310
setAttribute 124
setting shortcuts 37
setting tabs 142 to 144
setting up an Access database 242 to 244
setting up an Excel database 243
shape tools 32
shapes 64 to 66
sheet 284, 293
Sheet Options 305
Sheet Size 300
sheet size

change with PPD 301
custom 301
specifying 300, 319
units 301

shortcut keys 37
shortcuts

customizing 37
removing 38

Show Border 74
sides 59
Simple Copy Fit Rule 170
simple record selection 287

Simple Rules (copy fit) 166
Single Page 293, 300
single page imposition style 294
Single Page Masters 190, 191
Single-line 139
single-line composition 139
size

bitmap 330
Size and Position 111, 118, 119
Size property 97
slider 324
Small caps 135
small caps 135
smart quotes 37
Snap to Guides 38
soft line break 137
Solid 75
Sort By 287
Source Page 71
source page

PDF 71
space

job media 334
Space After (copy fit) 168
Space Before (copy fit) 167
Space Before and Space After 140
spaces 176
Special 102 to 105
special characters 176
specifying the transaction ID number 353
spell check 175
spelling dictionary 175
spelling suggestions 175
Spot Color 91
spot color 90
Spot colors 90
SQL query 288
SQL Statement 288
stacking order 79

adjust 79
standard logs 355
Standard toolbar 38
standard toolbar 25, 27
starting number for the transaction ID 353
Step and Repeat (Multi Record) 293
Step and Repeat (Single Record) 293
step and repeat multiple record imposition 

style 297
step and repeat single record imposition 

style 295
Storefront 116
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Stretch to Fit 70, 96
Structure panel 38
structure panel 25, 27
style

based on 149, 150
border 75
define 74
lines 97
no formatting 151

style name conflicts 216
style sheet file (.tsl) 42
Styles

view 42
styles 125, 147 to 151

deleting 150
editing 149
import styles 45
removing 151

Styles box 148
submitting jobs 347 to 352
subscript 134
subset and embed all fonts 327
Subset of Records 287
Substitute Font 46
substitute font 44
superscript 134
Suppress Printing 103, 339, 342
suppressed elements

preview 339
view or hide 339

suppression
print 290

_sys_JobName 273
_sys_ProjectPathName 273
System Data Source 253
system variables 273, 312

T
tab

leader 144
tab leaders 143
table of contents

alternate text 229
creating 226, 227
editing 227, 228
overriding 229
viewing 228, 229

table of contents (TOC) 226
Tabs 142
tabs 138, 142 to 144

set 143

Tabs/Indents 138
tagging HTML template 369
tagging template for HTML output 368
Template 286
template 19, 24

tagging for HTML output 368
template file (.xdt) 42
Template Info 42
template info 125
template setup

change 50
templates 43 to 45

opening 46
saving 49

temporary font replacements 46
Text

boxes 59
ovals 59
polygons 59

text
alignment 139
baseline shift 135
color 130
composition 139
drop caps 141
find and replace 173
hyphenation 130 to 132
insert 60
kerning 134
leading 139
letter spacing 133
ligatures 135
line breaks 136, 140
replace 174
special characters 176
spell check 175
subscript 134
superscript 134
word spacing 132

text Bézier tool 32
text box 59
text box tool 32
text case 135
Text Container

convert 78
text container

create with Chain tool 63
create with Text Container Bézier tool 59
creation 59
unchain 63

Text Container Bézier tool
418



Index
create text container 59
Text Container tool 59
text container tools 32
text containers 58 to 60

chaining 62 to 64
Text Oval tool 59
text oval tool 32
text overflow 58
text path 60
Text Path tool 31
Text Polygon tool 59
text polygon tool 32
text runarounds 87 to 89
Text tool 31, 60
text variables

and HTML output 371
Thickness 146
thickness

border 75
lines 97

TIFF 315, 330
TIFF images 66
Tint

for rules 146
for text 130

tint
border 75
fill 99
lines 97

TOC Override Text 30, 112
tool

add point 78
pen 77

Toolbar 38
toolbar 25, 27
Toolbox 38
toolbox 25, 31 to 33
Top 98
Top Edges 80
Top/Bottom Margins 305
Tracking 135
Tracking (copy fit) 168
Tracking down to 171
transaction ID 353

Mpower Server 352
transactional job 24, 237, 337

creating 340 to 343
previewing 341 to 343

transactional jobs 235, 337
transactional mode 340 to 343
tray selection 290, 319, 332, 335, 336

.tsl 42
Two Sided — Normal Turn 305
Two Sided — Tumble 305
Two-column text box 61
typeface 129

U
UIClass 111
uiClass 122
unchain autochain text container 207
unchaining autochain text containers 210
unchaining text containers 63
underline 129
ungroup 86

area template 86
ungrouping 86
Uniformly reduce text in all containers 

assigned this rule 172
units

changing 301
sheet size 301

unlocking elements 87
Uppercase

all 136
uppercase 135
URL variable 258
Use baselines for fixed leading 45
User Data Source 253
using clipping paths 103
using constraints 118
using editing constraints 119
using element margins and 

bumpers 184 to 185
using selection constraints 119

V
Value Type 310
Variable 311
variable

add 261, 262
add with drag and drop 263
apply with variables list 264
Campaign URL 258
create with content source plug-

in 275 to 277
duplicate 262
edit 263
formatted HTML 364
remove all 264

variable column 28
Variable Content View 337
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variable highlight color 36
variable highlights 39
variable pages 213

editing 216, 217
inserting 214, 215, 216
previewing 218

Variables
view 42

variables 118, 125, 263 to 264
adding 263 to 264
area template 257
area templates 158 to 159, 163 to 165
as constraints 120
campaign HTML form 258
constant 259
constants 266
content source plug-ins 260
content variables 259
document 214, 257
formatted HTML 258
formatted HTML paragraph 258
formatted paragraph 257
formatted paragraphs 158 to 159, 

161 to 162
formatted text 158 to 159, 159 to 160, 

256
image 257
JScript 278 to 279
Library Query 274 to 275
Library query 260
mapping 249
plain text 256
profile variables 259
removing 264
rules 260, 267 to 270
scripts 260, 270 to 281
source files 260
VBScript 280 to 281

Variables list 264
Variables Mapping 249
Variables Tab 234
variables toolbar 26
VBScript 270, 280 to 281
VDX 316
Vertical Alignment 85, 86, 104
Vertical Group 84

vertical group
alignment 105
create 84
creating 84

vertical groups 83
vertical guides 55
Vertical Placement of Text Lines 45
Vertical Scale 305
vertical scale 96
Vertically Center 81
view 100% shortcut 37
view fit page shortcut 37
view hidden characters 141
view percent 37
view structure 28
VIPP 316
VPS 315

W
Web submissions 237, 337, 340 to 343
WebForm 330
WebPages folder 232
Web-to-print 116, 232
weight

border 75
Width 97
wizard, for new data sources 252 to 254
word spacing 132

X
X1 99
X2 99
.xdt 42
Xerox VIPP 316
Xerox VIPP properties 317

Y
Y1 99
Y2 99

Z
ZIP image compression 324
Zoom percent 33, 38
Zoom Scope 37
Zoom tool 33
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